Sales Ally



          
          
          
          
          [image: image218.png]Apply Sales Plan

Entored By: [won ]
Stanley Adams
Stant Dote:  [{072377957 |

Plan:

Contact:

onth

Gatheting Assets - Top 100
Growth - Weekly Contact

Prospecting 101

Prospecting 102

Seminar Planning

=





          
          
[image: image2.wmf]
User Manual

V6


[image: image3.png]r Jfor Sales « Marketing « Customers
Scherrer Resources, Inc.

INFORMATION TECHNOLOGY SOLUTIONS





120 Arrandale Blvd, Exton, PA 19341, Sales: 484-875-1710, Fax: 484-875-1704 Support: 484-875-1705 Contacts:  www.SalesAlly.com, Sales@SalesAlly.com, Support@SalesAlly.com
NOTICE

The software is provided under a license agreement and is protected by copyright.  It is unlawful to copy any of this proprietary software through the use of magnetic tape, disk, or any other medium for any purpose other than the user's personal use for the life of the copyright.  Information provided in this document is subject to change without notice.  Sales Ally is a trademark of Scherrer Resources, Inc.

Copyright ( 1985, 2011 Scherrer Resources, Inc.

SOFTWARE LICENSE AGREEMENT
Use of this software indicates your acceptance of these terms and conditions.


1.
LICENSE  You have the non-exclusive right to use the enclosed program.  The single-user program can only be used on one computer at a time to manage the specific business pertaining directly to you, the licensee.  You may not distribute the program to anyone else.  The local area network (LAN) version of the program may only be used on one LAN at a time, provided that you have a licensed copy of the software for each computer that can access the software on the LAN.  You may not modify the program without prior written consent from Scherrer Resources, Inc.

2.
PROPRIETARY RIGHTS  You agree to take all necessary steps to ensure that any person under your control or in your service does not violate the provisions of this license.

3.
BACKUP  You may make copies of the program solely for backup purposes.  You must reproduce the copyright notice on each copy.

4.
COPYRIGHT  The program and its documentation are copyrighted.  All unauthorized software copies are in violation of this agreement.  Duplication of the written documentation is not permitted.

5.
TERM  This license shall remain in effect until you terminate it by returning the software, documentation, and all copies thereof to Scherrer Resources, Inc.  This license shall be automatically terminated upon the failure of Licensee to comply with all the terms of this License Agreement.

6.
WARRANTY  This program is provided without warranty as to contents.  However, should the distribution diskettes or CD’s be defective, Scherrer Resources, Inc. will replace it within one full year from the date of purchase.  Scherrer Resources, Inc. does not warrant, guarantee or make any representation regarding the use of, or results incurred through the use of this software.

7.
DISCLAIMER  Scherrer Resources, Inc. will in no way be liable for indirect, incidental, or consequential damages, including loss of income, use, or information as a result of using this software.  Nor shall the liability of Scherrer Resources, Inc. exceed the amount paid for the software.

8.
GOVERNING LAWS  This License Agreement shall be governed by the laws of the Commonwealth of Pennsylvania.

9.
ACKNOWLEDGMENT  You acknowledge that you have read this agreement, understand it, and agree to be bound by its terms and conditions.
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PART 1    INTRODUCTION

CHAPTER 1    OVERVIEW

This Sales Ally user manual is divided into three parts. Part 1 contains an introduction and user’s guide to Sales Ally. Part 2 contains a feature-by-feature reference section, and Part 3 contains supporting appendices.

This chapter contains an explanation of the essential features required to get up and running with Sales Ally.  We will first describe where to find help in Sales Ally, how to read this manual, how to install and setup Sales Ally and finally give you a quick tour of its features.  Please note that we have included a special chapter for those of you who are converting from a previous release of Sales Ally.  Chapter 3 is a quick start manual describing how to perform your regular Sales Ally processes in the Windows environment.  Chapter 4 is a special reference section for those who are new to Windows.  It describes the Windows interface and how to work the program.  

Part 2 is a complete reference manual for Sales Ally, listing each feature in the order it is found in the Main menu.  It groups similar features and functions together.  In some cases, it might be easier to use the index to find a particular topic.  The reference section is labeled by the command name assigned to the feature, but the index contains many logical synonyms.

The Appendices located in Part 3 contain technical details, common questions and answers, and some information on the advanced features of Sales Ally.  

1.1  Product Support

The first source of product support is the Sales Ally Help Menu. While using Sales Ally, press F1 to obtain help on the current active window.  Most of your questions can be immediately answered somewhere in the Help Menu, in this manual or on the www.SalesAlly.com web site. Within this manual, you can locate information on a particular function either by locating the menu choice in the reference section, or by looking in the comprehensive index.

Telephone Support

Product support is available by telephone from 9:00 AM to 5:00 PM Eastern time Monday through Friday (except national holidays) at 484-875-1705.  Telephone support is free for the first 30 days after the original purchase of the software and is available for a fee thereafter with the Support Plus Pack, Platinum Support Pack or a per incident support fee. Free fax support is always available on a 48-hour turn around basis at 484-875-1704.  

Support Plus Pack and Platinum Support Pack XE "Support Plus Pack" 
The Sales Ally Client Services Department offers two premium support subscription services for its customers.  First, the Support Plus Pack provides you with instant access to toll-free telephone help, e-mail and fax access, and also a newsletter with tips for using Sales Ally to its fullest potential. Second, the higher featured Platinum Support Pack provides you with toll free support hotline, e-mail and fax support, the Sales Ally newsletter and free bi-annual upgrades or updates to the software. The telephone hotline is your instant pipeline to a qualified support engineer every time you pick up the phone. This newsletter has tips and techniques on how to make the most efficient use of Sales Ally.  It will highlight the powerful (and often overlooked) features of the program.
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Figure 1 -  www.SalesAlly.com Software Support From the Main Menu
Telephone Hotline support, coupled with the e-support found on the Internet accessed at the www.SalesAlly.com web site, will provide you with an opportunity to make the most of your software purchase and to virtually eliminate costly down time.  For more information on the Sales Ally Support Plus Pack or the Platinum Support Pack please call the client services department at 484-875-1705 or fax us at 484-875-1704 or for faster service e-mail your requests to Support@SalesAlly.com to the attention of the Client Services Department.

1.2  Typographical Conventions

You will interact with Sales Ally by typing on your keyboard and by clicking with your mouse.  There are two sorts of keyboard entries: one is to type text (e.g., names, addresses and numbers and so on), the other is press specific keys (F3, Alt-F9, Enter, Shift, PgDn and so on).

If we want you to type text we shall write the request as follows;

....type the phone number in the phone field....

If we want you to type a specific word or text command, we will show the text to be typed in a mono spaced font as in: Type setup.

If we want you to use a specific keystroke we shall write it as follows:

....then press F3....or....then press Enter.

When we write press Alt-F3 we mean that you should hold down the Alt key and press the F3 key.

When we want you to use your mouse, we will instruct you to click or double click on a menu selection, icon, control button or other object.  By this we mean for you to move the mouse until the mouse pointer is located on top of the item to be clicked and then pressing and quickly releasing the left mouse button.  Double clicking simply means to repeat the click twice in rapid succession.  Occasionally you will be asked to drag an object.  Here, you must place the mouse pointer on top of the object, press and hold the left mouse button while simultaneously moving the pointer to the new location.  When you arrive at the new location, release the mouse button to insert the object.




When we want to emphasize a paragraph that applies to the network version of Sales Ally we print the following icon in the margin:

1.3  About Sales Ally

Sales Ally is a full-featured account rep. and advisor productivity system specifically designed for investment managers.  With Sales Ally, you can track clients and prospects in the pipeline; track their purchasing interests, purchases and sales; manage sales and accounts for changes in situations, create and send mail; track all contact with your clients including correspondence, telephone calls and meetings.  You can use it to create and track promotions, and maintain a record of your client’s instructions and preferences.  Sales Ally will also help you prioritize and manage your time.  It will help you to make sure that you do not miss key dates or appointments and help you manage your business instead of your business managing you.  Below, we have listed some of the major features of Sales Ally:


[image: image5.wmf]
Figure 2 - Sales Ally startup screen

Tip of the Day XE "Tip of the Day" 
As a training aid, every time you run Sales Ally, you will be presented with a “Tip of the Day”.  These tips will give you specific information related to the software.  The tips are designed to help you learn shortcuts to your software.  You can view all the tips at once by clicking the Next Tip button or you can read the tips as the are presented to you.  Once you have read all of the tips, you can turn them off by unchecking the Show tips at startup box.  You can always turn the Tip of the Day back on from the Help Menu.
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Figure 3 - Tip of the Day dialog

Sales Planner XE "Sales Planner"   

There is a multi-step Sales Plan manager incorporated into Sales Ally.  The Sales Planner is used to create sales and marketing campaigns for individual contacts or a group of contacts meeting specific criteria.  You can create multiple Sales Campaigns; each having multiple steps and store them for future use.  The Sales Planner is available in the Sales Ally Gold level and above.

[image: image7.png][View Sales Plans
Plan Nome

Clont Roviow -6 Month
Gathering Assets - Top 100
Hioh Growth - Weekly Contact

ai
Prospeciing 102
Seminas Flanning

rlele i





Figure 4 - Sales Planner, Plans

User Defined Fields  

There are forty-eight (48) fields for contact records that you can define and set up to store important information unique to your business.  These “User Defined” Fields are useful for prioritizing and selecting records to be included in reports, group mailings or campaign lists.  For simplicity we call them User Fields.
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Figure 5 - User Fields Page

Flags, Interests, Rating and Status  

There are four additional field types in which data specific to each record can be added and used later in the sort or selection process.  The Interest classification check boxes allow you to assign one or more of the 28 interest classifications to a contact. You can assign your own meaning to each interest check box.  Flags contain key search or identifying words for each contact record.  You can assign a Rating to each contact using, for example, a scale ranging from 1 to 9, with 1 being the hottest.  The Status field defines where they are in your pipeline; either as an unqualified lead, prospect, or current customer. The data you enter in these four field types as well as the User Defined Fields can be structured to apply to your specific business needs.  
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Figure 6 - Flags and Interests Page

Integrated word processor  

The Letter Writer is a full-featured word processor held within Sales Ally and it incorporates both form and custom letters as well as a spelling checker.  Having a word processor within Sales Ally negates the need for having alternative word processing software on your PC. With this powerful letter writer, you can mark individual contact records to receive a particular letter, and print these letters at the end of the day.  You can identify a group of contacts and print a batch of letters using the mail merge capability.

Reporting  

A very powerful feature of Sales Ally is its ability to search through the entire database to identify a group of records based on specific criteria.  The search criteria can be any field and is frequently zip code, date, address, user field data, flags, interests, and so on.  For example, you could select all your customers who are in the state of PA with a particular Zip code or within a range of Zip codes, all of whom have certain investment interests, assuming that you have recorded such data within the database.  The more clearly you define the text within the User Field, Flag, Interest and Rating fields the more sophisticated and useful a report you can create.  
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Figure 7 - Reports

Import & Export Data  

If you already have a file of potential customers on a diskette, you can import this file into a Sales Ally database.  Sales Ally recognizes several file formats and can import them directly into the program.  If necessary, the import utility will ask you exactly where you want the imported data placed in your Sales Ally database.  When importing from other Sales Ally databases, duplicate records can be identified and ignored.  Records can also be exported to disk for use on other computers or with other applications.

Auto Dialing  

Sales Ally has a fast, time saving feature to automatically dial the phone number within a contact record. You need to have a modem installed in order to use the auto-dialing feature in Sales Ally.  When you display a contact’s record, you can call the contact by clicking on the button next to the phone number you wish to dial.  If you would like to dial the work number of the contact, just click on Work.  When the Dialer dialog appears, pick up your handset, and click on Talk after the number is dialed.  All calls are tallied, displayed on the status bar at the bottom of the screen, and logged in a history file for future reference.  If you do not have a modem installed in you computer, you can track your call progress, calls and contacts made, by using the No Modem feature found in the dialer options.
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Figure 8 - Auto dialer

Notes

The Notes page attached to each record allows you to capture a mini transcript of a conversation or meeting.  Each note is stamped with the current date and time.  Notes are associated with a contact record and you can accumulate an unlimited quantity of note pages.  You can track your interaction with a client by reviewing the notes associated with that client’s record.  You can review all of the notes associated with a specific contact on a single page by pressing the Review button.
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Figure 9 - Quick Letter found in the Notes Page

As an additional time saving convenience, the Notes page allows you to create a Quick Letter and store it within the note pad.  For example, when completing a client conversation, you may wish to write a follow-up letter while your thoughts are still fresh in your mind.  The name and address is automatically presented in letter format for quick access. You can set up a variety of templates for your Quick Letters so that you only have to fill in the details.  Finally, you can check the spelling in your quick letter, by pressing the Spell button, print the letter as well as an envelope or mailing label without moving to another area of the program.  All of these commands can be found under the Contact, Print menu.

Scratch Pad and Sales Scripts

The Scratch Pad and Sales Script Tools are designed for accessing categorical information from anywhere within Sales Ally. The Scratch Pad allows you to record information which is not specific to any client such as your personal notes, FedEx numbers, or reference topics. The Sales Scripts contain standard or custom telemarketing scripts that improve efficiency and productivity for cold calling and mailing follow-up calls.

Calendar, Calculator and Stopwatch

By selecting Calendar from the Tools menu or typing Ctrl-E, you can call a pop-up date calendar.  This is very handy for quickly selecting the date of future return calls.  The Tools menu also has a Calculator (Ctrl-L).  The Stopwatch (Ctrl-T) will track time spent on an activity and even convert the time to dollars for billing or expense calculations.  
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Figure 10 - Stopwatch
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Figure 11 - Pop-up Calendar

Help System

A Help system is available throughout Sales Ally by simply selecting Help from the Main menu or pressing F1.  The Help system is a hypertext database of valuable reference information.  When you use F1 to activate the Help system, you will see specific information about the current window. 
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Figure 12 - Help Menu

1.4  Program Installation XE "Program :Installation" , Setup & Startup XE "Installation:Sales Ally" 
Microsoft Windows 95, 98, 2000, ME, XP, Vista, Windows 7, etc.

· When inserting the Sales Ally CD, the installation program should execute automatically.  If the installation program does not start, follow the steps below.

1. Select Start, located in the lower left hand corner of your screen.

2. Put distribution CD into your CD Drive. 

3. Choose Run from the file menu.

4. Type D:\SETUP in the run dialog box and click OK.

5. The installation program will ask you for licensing information and to specify the directory where you would like to install Sales Ally.  We suggest accepting the default directory, C:\SA6.  Click OK.

6. Follow the instructions as they appear on your screen. 

7. Now you have a new program group within your Program Manager titled Sales Ally 6.

8. Run Sales Ally by double clicking on the Sales Ally icon.  

9. For a first time installation, you will need to set up the Sales Ally Data source.

10. Click on the OK button in the New Data Source Setup screen when it appears.  This will setup your Sales Ally data source.

You are now ready to start using Sales Ally.

1.5  Using Sales Ally for Windows

Sales Ally uses Windows as its operating environment.  This allows the program to display multiple windows on the screen simultaneously and use all of the features of Windows.  This is called a Multiple Document Interface  XE "Multiple Document Interface" or MDI.  This section will describe the basic elements of Sales Ally and how to get around.  If you need a basic introduction to Windows, please refer to Chapter 4.
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Figure 13 - Display with several windows open: Multiple Document Images

Fundamentals

After starting Sales Ally, you see the main application window with a menu at the top and a status bar at the bottom.  You can also display an icon toolbar immediately below the menu as shown.  See User Preferences to learn how to create or modify a toolbar.  As you make selections from the menu, Sales Ally will display dialog boxes (windows requesting that you enter specific information) and view windows (windows that show text or data fields that you may or may not be able to alter).  Many of these view windows can be resized but most of the dialog boxes are fixed and cannot be resized.  Most view windows can be reduced to an icon, tiled or cascaded.  

Getting around

As with most Windows programs, the best way to get around in Sales Ally is to use your mouse.  You can use your mouse to select menu choices, activate specific windows, or click on options and control buttons.  Sales Ally also has Accelerator keys associated with many of the buttons or commands.  Any menu/button with an underlined letter, using your Alt- (letter) will activate the desired word.  For example, Alt-V will activate the View Menu.

The Menu System

The menu is the starting point for Sales Ally and displays general headings for you to choose.  When you click on one of these options (e.g., File, Edit, View), a pull down menu will list specific commands or features that you can select.
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Figure 14 - The View Menu

Most menu choices send you to a dialog box where you make specific choices or enter information.  Dialog boxes use a variety of input techniques including: 

· Input Fields  Boxes into which you can type numbers or text as appropriate.  Input fields may correspond to the fields of a record or may be used to request specific input for a dialog box.

· Check Boxes  One or more options that can be turned on or off by clicking on the associated box.  The option is on when the box is filled with an X.  Check boxes are not mutually exclusive. Within the Interest page, the boxes are yes and no check boxes.  If your contact is interested the box will be checked.

· Radio Buttons  Like check boxes, radio buttons offer multiple-choice options which can be toggled on and off.  Unlike check boxes, however, radio buttons are mutually exclusive.  Selecting one option automatically turns off all other options.

· Scroll Boxes  Scroll boxes present a list of options which may exceed the height of the display box.  The scroll bar along the right edge of the box allows you to scroll the list of options to display the hidden choices.   You make a selection from the scroll box by clicking on one or more of the options within the window.

The Toolbar

In addition to the menu options, Sales Ally offers quick access technology in an optional toolbar. The Sales Ally toolbar also has “Tool Tips” associated with each button.  When you move your mouse across the button, a dialog will drop down to inform you what task the button will complete.  When you click on one of the buttons on the toolbar, Sales Ally immediately executes the associated command.  Using the Edit, User Preferences, Toolbar menu option, you can select from among the many predefined buttons and associated commands.  Your selections are displayed in a toolbar located under the main menu. 
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Figure 15 - The Sales Ally Toolbar with Tool Tips

Accelerator keys XE "Accelerator keys" 
Some of the most frequently used menu choices have specific accelerator keys associated with them.  This allows you to quickly invoke the option by pressing the key combination rather than selecting a command from a menu.  For example, you can call up Find Contact and Add Contact typing Ctrl-F or add a contact by typing Ctrl-D.  Accelerator keys are displayed on the menus next to the associated commands.

Using Help

Sales Ally has an extensive context-sensitive help system.  You can call for help at any time by either clicking on the Help menu option, or by pressing F1.  If you press F1, Sales Ally will usually display a specific help topic appropriate for the current window.  If you select Help on the Main menu, you can go to the table of contents, search through a list of topics, read instructions on how to use the Help system, or look up a topic in the Financial Terms Glossary.

Different views 

As described above, Sales Ally can display multiple views or several windows at the same time.  If you are displaying one contact’s data and wish to refer to another contact, you do not need to close the current contact window.  Instead, simply Find the second contact and Sales Ally will display the second contact in a separate window.  You can move from one window to the other simply by clicking on the window you wish to activate.  Alternatively, you could use the open windows list on the Window menu to select a window by name.
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Figure 16 - Multiple Contact Screens

Contact Records

Adding Contacts

This is the time to gather together all those dog-eared business cards, small bits of paper, memo notes and your office Rolodex.  Select View, Add Contact, and then enter the desired information.

Notes 

The note pad in each contact record allows you to capture a mini-transcript of each conversation or meeting.  Every note is date and time stamped.  You can accumulate an unlimited number of notes.

User Fields, Flags and Interests

There are forty-eight (48) fields for each contact record that you can set up to further identify a particular record with information unique to your business.  These User Defined Fields are useful when sorting and gathering records into groups XE "Groups"  for a particular action.  You can also assign your own meanings to as many as 28 Interest check boxes.  Flags contain key search or identifying words for database sorting.

The number of contact records Sales Ally can store is limited only by the available space on your hard disk.

Lists

A very powerful feature of Sales Ally is its ability to search through the entire database to identify a group of records based on specific criteria.  The search criteria can make use of the fields in the contact record.  These lists can be used to print reports, print merged letters, print labels, place phone calls, etc.  Each list and the criteria used to generate the list are stored for future use.  After you make changes to your contact database, you can refresh a list using the original criteria by simply pressing the Refresh button in the Group List XE "Group List"  dialog.

For example, you might create a Group list where you specify that the list contain all contacts with a specific status, such as “prospect”.  You can use this list to go directly to each contact and make a phone call or mail merge a letter. You could also print a report or send letters to only the selected contacts that are on your list, excluding those that might not meet your criteria perfectly.

Maintenance

The Maintenance feature, which is found under the File, Database Operations menu can be used to re-index and pack database tables for more efficient operation of Sales Ally.  If you run into any problems with your database in Sales Ally, you should run this maintenance program.  This should clean up any bad information that might be found in your Sales Ally data files brought about by potential damage to your hard drive through power surges or other sources.

1.6  Backing Up Your Data

We strongly advise you to backup your data files on a regular basis. 

[image: image20.png]



Sales Ally does not provide an internal backup or restore program.  We suggest using a backup and restore program XE "Backup and restore program"  provided to you by your operating system.  Should you have any questions or problems with your backup or restore program, please contact your product user manual, consult your products help system, or call your products technical support number that can be found in your manual.

While the chances are small that your computer will fail and lose data records, you must prepare yourself for the worst possible scenario.  To protect yourself and your business, we recommend that you conduct disk backup procedures at the end of every working day.
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Keep several sets of backup disks so that you do not rely on one set.  At the very least, employ two backup sets to use on alternate days.  Some users have a different backup set for every day of the week.
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You should never backup a damaged database onto diskettes containing your last good database.  You might destroy your only means of recovery.

The Maintenance function found under File Database Operations can rebuild damaged indexes, but sometimes data files are beyond repair.  Although re-indexing solves many problems, you should not rely upon this Maintenance feature as your only line of defense against data loss.

In this section we will explain only which files to back up XE "Files to back up" . We make a simple point that you should at least backup all files with .MDB (main data base) file name extensions found within the Sales Ally directory every day.  This AllyWin.MDB file is the Sales Ally contact data files.  This will save your most important data files.  Your Sales Ally letters are all the files with *.BAL file name extensions.

1.7  Network Issues

The networkxe "Network" version of Sales Ally is a multi-user system.  It requires users to login when running the program and allows multiple users of Sales Ally to access a database simultaneously.  When installing a Sales Ally Network, follow the installation instructions for networks.  The Sales Ally program should be installed onto each workstation, pointing the data source to the network drive/directory. 

User ID, Privilege Levels, & Record Ownership

After you start Sales Ally, you will be required to identify yourself to the program by selecting your User ID from a list shown on the screen.  We distribute Sales Ally software with one permanently established User ID called MGR (for Manager) that enables all features and functions.  We assume the first person to run Sales Ally after installation to be the manager of the system.  If yours is a single-user system, MGR is the only User ID allowed; you are the manager as well as the sole operator of the program.  The Network version of Sales Ally allows the manager to create or change User IDs in the User ID dialog accessed from the Edit menu.




In the Network version of Sales Ally the manager must create a different User ID code for each person using the system.  Be sure that only one person uses a given ID at a time.  Before assigning User ID codes, you should understand how the Privilege Level associated with each User ID determines how Sales Ally will work for that individual.

Every User IDxe "User ID" code has an associated Privilege Level, list of Account rep. Numbers, a user's name, and an optional password.  Each Privilege Levelxe "Privilege Level" comprises a set of rights that determine the scope of a user's ability to perform operations in Sales Ally.  The associated Account rep. Numbers limit the user’s access to contact records having one of the Account rep. Numbers in the Owner field or to records with a blank Owner field.

[image: image23.png]



Conflicts can arise if two or more people login under the same User ID at the same time.

Privilege Levels

Sales Ally allows the manager to control many of the operations a user can perform such as which fields the user can change in a contact record.  The manager can prevent a user from changing User ID information, User Field definitions, scheduled activities, etc.  A combination of rights to do certain things in Sales Ally is contained in a Privilege Level.  Sales Ally is shipped with one Privilege Level, Level 3, which has all rights permanently enabled, but the manager can create other Privilege Levels with any combination of rights.  The manager then assigns one of these Privilege Levels to each user.  Choose the Configure button in the User ID dialog to go to the Account rep. Numbers dialog.  Then choose Edit Levels to create or edit Privilege Levels.  To select multiple rights, hold down the Ctrl key while you click on each right.  You can also select a group of adjacent rights by holding down the Ctrl key and dragging the mouse across the rights.




Level 3xe "Level 3" users have access to all records and all operations, which include setting passwords, deleting data sources, and importing or exporting records.  It is a suitable mode of operation when only one person uses the program.  In network applications, it is the recommended mode for the manager and deputy managers.

Account rep. Numbers

The manager can assign to each user one or more Account rep. Numbers, which is usually the number assigned by a firm to that account rep.  When one of the Account rep. Numbers matches the entry in the Owner field XE "Owner Field" of a contact record, the user may access the contact.  Incidentally, a user can access any contact record having a blank Owner field, since it is considered free and available.

Choose the Configure button in the User ID dialog to go to the Account rep. Numbers dialog.  Use the Add Account rep. button to add an Account rep. Number to the list.  Select (highlight) the appropriate Account rep. Number or Account rep. Numbers for the user.  To select multiple Account rep. Numbers, hold down the Ctrl key while you click on each Account rep. Number.  You can also select a group of adjacent Account rep. Numbers by holding down the Ctrl key and dragging the mouse across the Account rep. Numbers.  To select all Account rep. Numbers in the list (even if the list grows), check the box marked ‘All Account rep. Numbers’.

Access to Info

System administrators can allow users access to Lists, Activities, History, and Marked Letters associated with other users.  If you do not want the user to see this type of information belonging to others, make sure All Users is not checked and no items are selected in the Users list box.  To permit the user access to others' information, explicitly select their user ids in the Users list box or check All Users.  If you do not check All Users, you can select at least five users.
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Figure 17 - User Configuration dialog
Passwords & User Names

Anyone with the right to edit User IDs can assign a password to a User ID.  If you have checked the box marked ‘Enable passwords’ in User Preferences, each user having a password XE "Password"  will have to enter his/her correct password to log into the Sales Ally system.  In the User ID dialog, click on the Edit User button to change the password for a selected User ID.

Passwords can be any length and composed from any of the keyboard symbols.  However, there is no difference between lower case and upper case letters of the alphabet.  For example, H is the same as h.

Each User ID also has an associated User Namexe "User Name", which can be referenced with one of the merge codes in the Letter Writer.

User Configuration Data Files

Sales Ally obtains the special setup characteristics for a user by reading a file called SAWIN6.INI.  The SAWIN6.INI file contains information concerning the data sources, toolbar, default directories, stopwatch configuration, calculator, last report printed, etc.  On a network, this SAWIN6.INI file is located on the workstation in the directory in which the application has been installed.  Each user has a private scratch pad.  




Activities, marked notes, and marked letters are assigned to specific User ID’s, thus keeping one person’s actions separate from others.  If more than one person shares a User ID code, conflicts will arise in these areas.  Furthermore, if two users simultaneously operate Sales Ally using the same User ID, more serious conflicts will occur.  Warning: We strongly advise each person to use a different User ID.
Advice for Network Managers

You should take responsibility for backing up XE "Backing up"  the database on a daily basis.  Since we store records, notes, transactions and histories for all users in corresponding data files, backing up all files with the .MDB extension XE "Files with the DBF, MDX, DBT extension"  will backup the database for everyone.  Similarly, you should backup the letters (files with SAL extensions), sales scripts (files with SAS extensions), and Quick Letter templates (files with SAQ extensions).

CHAPTER 2    Upgrading

2.1  New Features

This chapter is aimed at users who are migrating from previous versions of Sales Ally, and you can use this chapter to get up and running quickly with Sales Ally v6. Also, within the software itself you can learn all that is new in version 6 under Help, Contents, What’s new in version 6.0.
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Figure 18 - Help Menu for learning new Sales Ally v6 features

The Help system provides reference information on all Sales Ally tasks.  You can jump from one Help topic to a related Help topic quickly and easily.  When you’re using Sales Ally, Help is just one keystroke away, F1.  Use it often to learn about Sales Ally.

To get help on a specific window, press F1.  To see other topics click on Search and then:

1. Type the first few letters of the topic you want to search for.  As you type, Help displays new keywords in the list box.

2. Double-click a keyword related to your subject (or select a keyword and press Enter.  Help displays the relevant topics for that keyword.

3. Double-click your topic (or select the topic you want and press Enter).

[image: image26.png]Help Topics: Sales Ally Help [2]x]

i [ |

1 Type the first few letters of the word you're looking for.
o

2 Cick the indes enlty you want, and then clck Displey

Clcutor
Caenda

Callnerval

ol

Check em

Cormon Fles

Coiact Heny

Cortact Window ]





Figure 19 - Help Search dialog 

Executive Overview of New Features

1) Overall we added over 200 new features for ease of use and expanded data capture

2) Expanded Standard Level Features to include Net connectivity, e-mail, and dozens more fields

3) Expanded Features to include Palm Pilot data connectivity and fulfillment processing

4) Now offering Web Sales Ally Outsourced or in-house installation at www.WebAlly.com

5) Added www.SalesAlly.com portal site for quick access to securities industry information and Sales Ally software information.

Read more detail about these new version 6 features below:

Standard Level Feature Enhancements

This section describes the detailed features added to the “Standard Level” of Sales Ally.

· User Fields- Tripled the number of User Defined Fields from 16 to 48, thus providing expanded search and sort functionality for marketing and client management functions.

· Added e-Mail Field and URL Data Fields- Created fields to track a customers’ e-mail address and the URL XE "URL"  (universal resource locator) of their web site for quick access to customers for correspondence.

· Addresses Management- Tracks more than one address per customer XE "Customer"  and tracks the date they change residence from one address to another (such as summer seasonal address, or business and home addresses, etc.).

· Quick Web Connect- to launch your browser from within Sales Ally and access our help site and the popular www.SalesAlly.com portal for productivity advice, tools and the web window to Wall Street.
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Figure 20 - Internet Access from Main Menu; A Quick connect to SalesAlly.com
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Figure 21 - User Definable Fields- Expanded up to 48 fields on 3 quick-access pages

· Additional Phone Number Fields- Added unlimited fields for adding more phone numbers such as beeper, cellular, multiple home and office numbers, and fax and telex numbers.
· Household Relationships- For tracking other contacts within the economic household such as associates, brother, brother-in-law, business partner, estate, father, father-in-law, grandparent, nephew, niece, omnibus, sister, sister-in-law & their address, background, income, education and retirement.

· Track Important Life Events XE "Life Events" - Field for key events such as: address switch, anniversary, auto purchase, birthday, child birth, distribution, divorce, job change, mortgage payoff, promotion, real estate buy, recognition award, religious occasion, retirement, salary increase, sports event, wedding, etc.

· Contact Screen enlarged- Widened the contact screen format to enable storage of more data and information and added functionality.

· Notes Categorization XE "Notes Categorization" - Added ability to organize the notes based on their content in categories such as: contact, compliance, personal, investment, operation, and others in order to improve understanding.

· Notes Access Control XE "Notes Access Control" - Added ability to set control of access to notes such as private, semi-private, public access.

· Notes Expiration XE "Notes Expiration"  and Printing Dates- Allows the user to set a date that a note and action expires or is printed.

· Help File Expansion- Help file expanded to describe new functionality including search and glossary functions including descriptions of new version features. 

· Auto Install CD XE "Auto Install CD" - Created fast and automatic installation routine to install Sales Ally on a hard drive from a CD drive without added commands.
Higher Level Feature Improvements

This section describes the detailed features added to Sales Ally.

· Sending e-mails XE "Sending e-mails" - Sales Ally now allows you to send e-mail using your installed e-mail software and retain the contents of the e-mail message within the contacts notes.
· Fulfillment Exporting- Created fulfillment house export function which enables a custom programmed connection to your mailing fulfillment house.
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Figure 22 - New Fields for e-mail, contacts, important dates & addresses

· Palm Pilot Interface XE "Palm Pilot Interface" - Created ability to load Sales Ally information into the popular Palm Pilot product to enable users to review contact information on their portable Palm device. Interface connectivity specifications are found in the appendix.
· 
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Figure 23 - Notes Page Expanded- New fields to categorize notes; send and store e-mail
Enterprise Functionality for Corporate-wide Installations

The shrink wrapped Sales Ally utilizes Access database files. However, as a custom installation Scherrer Resources, Inc. can offer Sales Ally with SQL databases and also offers Web Ally CRM for expanded, enterprise-wide installations. This increased robustness makes it easier to install enterprise Software as a Service, On Demand, multiple-user versions of Sales Ally as Web Ally CRM with MS-SQL, databases.
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Our browser-based Web Ally CRM can be hosted on our server or yours for corporate installations. You can outsource Sales Ally with our browser-based version of Sales Ally as a corporate option for multiple user installations using the powerful browser access method. See www.ScherrerResources.com and www.WebAlly.com.
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Fulfillment Export and Import- If you use a fulfillment house or do bulk mailing, and want to manage a sophisticated multi-step marketing campaign, consider this newly engineered feature for configuration to your firm mailings.
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Figure 24 - Fulfillment House Export Functionality


Timed Data Utilities- Timed triggers to kick off data loading and indexing and Auto Shutdown- Automated application shutdown the application for data protection.

www.SalesAlly.com Web Site Portal

 
You will find a wealth of information at your fingertips at the expanded www.SalesAlly.com portal including sales and marketing education and training support.
2.2  Converting data and settings
Sales Ally has a convenient upgrade system that performs two key functions: 1st it helps you import your data from previous versions, and 2nd it helps to migrate your settings and configuration information into the new version 6. You can import your data from Sales Ally 3, 4, or 5 to Sales Ally version 6.  The import and conversion process will copy over all User ID information, Class definitions, User Field definitions, scratch pads, letters, quick letters and user information and will import securities, contacts, notes, and postings.

When you insert the CD into your CD drive it will run automatically and present questions on the screen regarding your ideal configuration. Upon answering these questions the data migration process will upgrade you from previous versions to the current version 6 of Sales Ally.

To import contact, notes, and activities information, follow these directions:

1. Under the File menu select Database Operations.  From the popup menu select Import.

2. Select Sales Ally v4, or v5 Data and press Start.

3. You will be asked to specify the directory for your Sales Ally data files XE "Data files" .  If your data is in a different directory, other than C:\SA4 or C:\SA5, please specify the correct directory.

4. Press OK.
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Figure 25 - Converting and Importing Contacts from earlier versions of Sales Ally 

Data Storage

The file in which ALL contact data is included is ALLYWIN.MDB. (For reference, IN PRIOR VERSIONS, the database information was stored in data files XE "Data files"  with file name extensions *.DBF, *.MDX, and *.DBT).  This single file now retains your contact databases, including notes, activities, securities, interests, user fields and postings.

Sales Ally allows you to create and use several separate Sales Ally data sources or databases.  For example, you might have one Sales Ally data source for active clients and prospects, another for less important prospects, and another for corporate data or lead information.

ChaPTER 3    USING Sales Ally 

In this chapter, we will discuss the ways that Sales Ally makes your workday more efficient.  Sales Ally is a powerful productivity tool that allows you to organize your schedule, keep in contact with your clients, track your progress, manage wealth and create powerful sales reports.  We have built many features into Sales Ally to manage a wide range of your activities.

3.1  Add your contacts to the Sales Ally Database

The first thing that you will want to do with Sales Ally is to add your contacts to the database.  

There are two ways to add your leads, prospects, and clients to Sales Ally:

Select View, Add Contact, and type your contact information into the contact record window.  After you click on Add to save the record, you can add notes, transactions, or schedule the new contact for an activity.

Select View, Quick Add Contact, which differs mainly in that it proceeds directly to the next Add Contact screen after you click on Add to save the record.  Quick Add can also drop default data into some of the contact fields.  To set up the default data, go to User Preferences and click on Quick Add.  The Quick Add method is faster for adding a group of contacts but does not allow you to add notes, transactions, or activities while adding basic contact data.
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Figure 26 - Add Contact Screen

3.2  Schedule your contacts for Activities

Activities are defined in Sales Ally as the things you will do with a client or prospect.  Activities is the umbrella term under which sub-terms fall; such as calls, actions or meetings. As you add new contacts to your database, you might want to schedule an activity such as a Call, Action or Meeting activity for each record.  You could also apply a pre-defined multi-step Sales Plan to a contact.  

A Call activity is set up as a date in the future that you would like to telephone a contact.  You can schedule an Action for any reason that you want to be reminded of in the future.  For example, you could create an Action to remind yourself to review a sale or send a dividend check.  You can also schedule a meeting with a client.  While viewing a contact record, you are able to schedule an event by clicking on View, and then on Schedule Activity.  While in the schedule dialog box, enter the proposed time and date for the activity and a description of what needs to be done or discussed.

1. To add a Call, Action, or Meeting Activity for a contact you need to have the contact’s record on your screen.

2. Pull up the Schedule Activity XE "Schedule Activity"  dialog, which is accessed through the View menu. Alternatively, you can access the Activity Scheduling dialog through the Agenda button on the Contact’s record.




3. The ‘Action For’ field will automatically be set to your User ID so that this activity will appear only in your Activities Calendar.  If you select a different User ID, the activity will appear in that person’s Activities Calendar who is in your work group.  Similarly the ‘Entered By’ field will automatically default to your User ID and will register who entered the activity.  

4. Description XE "Activity:Description"  - Enter a short description in the Description box of what you want to accomplish.

5. The name of the contact will appear automatically in the Contact field.

6. Select the Type of activity XE "Activity:Type"  - Call or Action.  You can even create a new activity type by manually entering an appropriate name such as Meeting.  Remove the information in the Type field and enter your desired information.

7. Date and Time - Sales Ally automatically enters tomorrow’s date and the current time.  You may change the date and time.  If you double click on a date field or the time field and choose your selection from a popup calendar, or time.  You can also click on the light bulb icon for more information on entering the date and time.

8. Duration  XE "Activity:Duration" - To schedule a block of time for an activity, enter the length of time in minutes.  Duration is useful only when you have specified a time for the activity.  The Daily and Weekly Calendar will show the same activity more than once if the Duration is greater than the Activities Calendar resolution.  The Activities Calendar resolution can be changed in User Preferences.  

9. Check your other activities for a conflict XE "Activity:Conflict"  - If you mark this option, the scheduler looks for conflicts with your other activities when adding or updating an activity.  When a Duration is entered, the conflict analyzer looks for overlapping time blocks.  If your activity does not have a duration, the conflict analyzer only reports when you have another activity scheduled on the same day at the same time.

10. Alarm XE "Activity:Alarm"  - If you want the Alert system XE "Alert:Schedule Activity"  to notify you when this activity comes due, check the ‘Activate alarm...’ box.  If you want to be notified in advance of the event, enter the number of minutes prior to the event time in the ‘Alarm Lead’ time box.
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Figure 27 - Schedule Call or Action Dialog
When you schedule an activity while a contact window is active, the Contact field shows the name of the contact associated with the activity.  If you schedule an activity when a contact window does not have focus, the Contact field will show “REMINDER” (and you cannot change this field).  Such an activity is not associated with any contact and is called a Reminder Activity XE "Reminder Activity" . 

Now that you have created several scheduled activities, you can view your schedule through the Activities Calendar.

Sales Planner XE "Sales Planner"   

There is a Sales Planner incorporated into Sales Ally.  The Sales Planner is used to create sales and marketing campaigns for individual contacts or a group of contacts meeting specific criteria; such as Rating = Hot. You can create multiple Sales Campaigns and store them for future use.  The Sales Planner is available in the Sales Ally Gold level and above. We suggest you create your own 12 step sales plan as follows: 4 annual sale reviews on a quarterly basis, plus 8 telephone calls to check in with your best customers often.
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Figure 28 - Sales Planner, Plans

3.3  Working with your Activities calendar

When you have entered activities into your database, you can view your schedule through the Activities Calendar.  The Activities Calendar displays the activities you have scheduled or someone has assigned to you.  You can display your schedule in Daily, Weekly, Monthly, or Summary views.  Select the corresponding radio button at the bottom of the window to change the selected view.

When you open the Activities Calendar from the View menu, you will see all of your activities for every contact.  Daily, Weekly, Monthly, and Summary views allow you to see the activities in a variety of formats.  Activity For is used to see activities assigned to a different user in your work group.  Use the Summary view to see all activities in chronological order.  To see completed activities, click on the History check box.

Daily View XE "Activities Calendar:Daily View" 
When first opened, the Calendar shows today's activities with a resolution of 30 minutes in a format resembling a daily appointment calendar.  You can change the view resolution of your Activities Calendar from 30 minutes to another value. (See User Preferences)  If several activities are scheduled for the same time slot, you will see only one activity. However, Sales Ally will display a number in parentheses equaling the amount of activities scheduled for that time.  By clicking on the time slot, a window will appear where you can view all of the activities scheduled for that time slot.  You can view activities that do not have an associated time in the No Time field.  To examine a different day, select the Calendar Icon located at the bottom of the Activity Calendar window, double click on a different day, and the selected day will be presented.  You can quickly print your Activities Calendar by pressing the Printer Icon located at the bottom of the Activities Calendar window.
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Figure 29 - Activities Calendar shown in Daily View format

Weekly View XE "Activities Calendar:Weekly View" 
Click on the Weekly button to see your activities for the current week, Monday through Friday.  This is an expanded daily view showing 5 days at a time.  If several activities are scheduled for the same time slot, you will see only one activity.  However, Sales Ally shows the number of activities for the time slot in parentheses. You can view activities that do not have an associated time in the No Time field. To examine a different day, select the Calendar Icon located at the bottom of the Activity Calendar window, double click on a different day, and the selected day will be presented.  You can quickly print your Activities Calendar by pressing the Printer Icon located at the bottom of the Activities Calendar window.
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Figure 30 - Activities Calendar shown in Weekly View format

Monthly View XE "Activities Calendar:Monthly View" 
Click on the Monthly button to see the number of activities scheduled for each day of the current month.  The red number in the lower right hand corner of the date shows the number of activities scheduled for that day.  Each day is a button and the current day is active (button depressed).  Space limitations prevent showing more than the number of events for each day.  If you double click on a different day on the Monthly view, you will go back to the Daily view to see the actual activities for the selected day.  Use the controls below the calendar to move to a different month or year. Also to examine a different day, select the Calendar Icon located at the bottom of the Activity Calendar window, double click on a different day, and the selected day will be presented.  You can quickly print your Activities Calendar by pressing the Printer Icon located at the bottom of the Activities Calendar window.
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Figure 31 - Activities Calendar shown in Monthly View format

Summary View XE "Activities Calendar:Summary View" 
An overall summary listing of Activities is shown under this view.  Click on the Summary button to see all of your activities listed in chronological order.  If you highlight an activity and go to one of the other views, you will see the same activity in a different context.  If you double click on an activity you will display that contact’s record.  As an added convenience, you can also get a summary of Historical information by clicking the History check box on the screen.  To move to a specific day, select the Calendar Icon located at the bottom of the Activity Calendar window, double click on a different day, and the selected day will be presented.  You can quickly print your Activities Calendar by pressing the Printer Icon located at the bottom of the Activities Calendar window.
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Figure 32 - Activates Calendar shown in Summary View format

Buttons and Controls

Add

Use this button to schedule a new activity.

Edit and Delete

These buttons are active only when you select (highlight) an activity on the Calendar.  You can edit or delete the selected activity.

Sweep XE "Sweep" 
You can re-schedule one or more activities from the Activities Calendar or Contact's Agenda.  When you click on Sweep while viewing the Daily, Monthly, or Summary list of activities the currently selected date is assumed.
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Figure 33 - Sweep dialog

1. Verify or change the time range for the activities you wish to re-schedule.

2. Verify or change the new activity date.  Tomorrow is the default value.  See Date and Time Shortcuts.  

3. Click on OK to change the schedule date for the selected activities. 

Accomplish

Click on Accomplish to copy the selected activity to the history file and delete it from your list of current activities.

Show Type

When no items or all items in this list box are selected, the Calendar displays all activity types: CALL, ACTION, MEETING, and other types you may have created with the scheduler.  To see only Calls, select CALL in the list box.  Similarly, to see only Actions, select ACTION in the list box.

History

Check this box to see accomplished activities or click this box again to see pending activities.

User




To see activities assigned to a different user, select a User ID from this scroll box.  You will only see those users that your configuration setting will allow you to see.

Zoom

Press the Zoom button to see the full contact record for the selected activity.  Or, double click on an activity to display the contact record.

Reschedule

To reschedule XE "Reschedule"  an appointment, simply highlight and drag the event from one date/time cell to another.  You can do this by moving your mouse pointer to the date/time cell that you want to move, press and hold your left mouse button down.  While still holding your mouse button, drag the mouse pointer into the new date/time cell and "drop" your event into its new slot by releasing the mouse button.

3.4  Campaign lists

There are numerous occasions when you would like to make a list of all contacts that have a special significance in order to carry out a business activity.  We call these lists Campaign Lists, and when you create one, you can use it over and over again. For example, you might want to create lists for the following purposes:

· Make a phone call to a special group of people who are holding a specific product.

· Produce a report of everyone living in a certain zip code.

· Follow up a mailing to a special group with a phone call.

You can produce a campaign list with specified characteristics.  Once you have created such a list, you can save it and reuse it whenever you wish.  You can work through the list as time permits and come back to the same place on the list by crossing off the entries as you go. You can categories these campaigns in groups such as calling type campaigns, action type campaigns, big group campaigns and maturing investment campaigns and Sales Ally makes it easy to segregate and organize them under these headings.

To generate a telephone calling campaign Calls list, choose View from the menu, select Campaigns and Call Lists, click the New List button, and give a descriptive name to the list you are about to create and press the OK button.  You can use one of the pre-defined list templates or create your own.

List Templates XE "List Templates" 
When creating a campaign list, you can choose from a pre-defined list.  By selecting one of these list templates, Sales Ally will create the search and sort criteria for you.  You can change the search and sort criteria before creating your list by pressing the Edit Filter button.
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Figure 34 - List Templates

Edit List

You will now come to the Edit List XE "Edit List"  dialog.  Because we provide extraordinary flexibility in choosing selection and sort criteria for lists, this dialog seems a little complex when you first encounter it.  However, you build all expressions using plain English phrases.  You define Search Properties to select contact records and Sort Properties to establish how to order these records.  Then, when you Close the dialog, Sales Ally creates the list and presents you with a number of contacts that meet your specific criteria.
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Figure 35 - List Creator

Search Properties

Click on the Add Filter button to bring up the Search Logic XE "Search Logic"  window.  You will build a logic expression utilizing one or more database fields to construct the filter for selecting contact records.  You can use the fields in one or two of the following files: contacts, activities, histories, or postings
.  For example, suppose you want to build a Call list for everyone having a scheduled CALL activity dated March 13, 2009 or before.  You will select contacts based solely on activities information.

1.
Select Activities - Type from the Field combo box,

2.
Select Equal to: (=) from the Operator combo box, 

3.
Enter CALL in the Value field,

4.
and click OK.

On returning to Edit List dialog the Search Properties Criteria displays:


"Activities - Type Equal to: (=) CALL".

Once again click on the Add button adjacent to the Search Properties list box to bring up the Search Logic window.

5.
Select AND in the Continue Previous Statement With group,

6.
Select Activities - Activity Date from the Field combo box,

7.
Select Less than or equal to: (<=) from the Operator combo box,

8.
Enter 3/13/2019 in the Value field,

9.
and click OK.

On returning to Edit List dialog the Search Properties Criteria displays:


"Activities - Type Equal to: (=) CALL"

"AND Activities - Activity Date Less than or equal to: (<=) 3/13/2019"

Notice that the first clause is connected to the second clause with AND, meaning that both clauses must be true in order to select a contact.

Please Note:  A Short Cut for creating calls list:

1. Select Activities - Activity Date from the Field combo box,

2. Select Is Past Date or Today; (<=Today) from the Operator combo box,

3. Press the Refresh button every day. 

The operator will automatically take today’s date from your computer clock and place it into the Date criteria.

Network Users




If you are running Sales Ally on a network, you will want to create a Calls list containing only your calls.  You must therefore additionally select activities assigned to you.  Once again click on the Add Filter button to bring up the Search Logic window.

10.
Select AND in the Continue Previous Statement With group,

11.
Select Activities - Activity For User from the Field combo box,

12.
Select Equal to: (=) from the Operator combo box,

13.
Enter your User ID (assume XYZ for this example) in the Value field,

14.
and click OK.

On returning to Edit List dialog the Search Properties Criteria displays:


"Activities - Type Equal to: (=) CALL"


"AND Activities - Activity Date Less than or equal to: (<=) 3/13/19"


"AND Activities - Activity For User Equal to: (=) XYZ" .

Sort Properties

You have finished building the select statement, and now you must create a sort statement.  Press the Add Key to bring up the Search Logic window.  You now build a logic expression utilizing contact and activity fields to construct the sort statement.  For example, suppose you want to sort the Calls list mentioned above by Last Name.  Simply select Contacts - Last Name from the Field combo box and click OK.

On returning to the Edit List dialog the Sort Properties Criteria displays:


"Contacts - Last Name"

If you construct a sort statement with several clauses, the clauses will always be ANDed.

Working with a List

Once you have created a Calls List you can scroll through the list and make your phone calls.  To see the full contact record for a member of the list select a list entry and click the Zoom button.  If you have a modem, you can click on Work and the computer will dial the work phone number for you.  You can take notes, make changes, and call up the Schedule Activity dialog to schedule the next call.  Using the right and left arrows on the contact screen, you can scroll through your list.

The Actions list and Groups list function exactly the same and we have provided these categories only for your convenience.  
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Figure 36 - Calls List Dialog

The View List dialog has other buttons besides Zoom to a contact.  You can use a List to generate reports (or mailing labels) or print letters with the mail merge feature.
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Figure 37 - List Viewer

3.5  Alerts

The Alert system XE "Alerts:Using"  will keep you on schedule while you are running Sales Ally, even if Sales Ally is minimized and you are working with another Windows application.  The Alert system is Sales Ally's alarm clock, and it will notify you when a scheduled activity comes due.  When the alarm goes off, the Alert dialog pops up and displays the current event along with any other events that may require your attention.

You can do one of the following:

· Click the Zoom button to go directly to the appropriate contact window in Sales Ally.

· Click the Snooze button to delay 10 minutes before issuing the same alarm again. You can change the Snooze delay by clicking on the up/down arrows next to the Snooze button.

· Click the Edit button to change the scheduled activity.

· Click the Delete button to remove the alarm event.  This does not erase the scheduled activity, only the alarm associated with this activity.

· Click the Close button to leave the dialog and continue using Sales Ally.
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Figure 38 - Alert Alarm Dialog

When you click the Zoom button or double click on a contacts name, the Alert system will take you to the contact record for this activity.  The Zoom button will not be active for Reminder events, which are not associated with a contact.  For example, Thomas Adams is scheduled for a call at 4:00 PM.  When it comes time to give Thomas a call, Sales Ally will display an alarm message.  By clicking the Zoom button, you can move directly to the contact record for Thomas Adams.  You can snooze an alarm, which means putting the message off for another 10 or desired Snooze minutes.

If you find the alarms annoying, do not select the Activate alarm option when you schedule an activity or increase the Cycle Minutes setting in User Preferences.

3.6  Send your contacts the information they requested

Marking Note




After a phone conversation or meeting where a customer requests additional information, you will want to create and mark a note to insure that you send the correct information.  After creating a note in the customer's record, click on the Mark button.  The note will automatically be marked for your user ID, MGR if you are a single user.  In a network installation, the Mark button will bring up a Mark dialog and you will notice that your User ID is displayed.  Click OK to mark the note for your list of marked notes.  You can also select another User ID to mark the note and assign it to another user’s list.  To unmark a note, simply click the Unmark button.

You can print your marked notes on labels at the end of the day by selecting Marked Notes from the Mail menu.  The Marked Notes feature will print the customer's name and address on one label, and the note itself on the adjoining label.

	Mr. & Mrs. John Jones

1234 Town & Country Road

Apartment 15b

Philadelphia, PA 98765-1234
	Send information on PXG Growth Fund.  Include business card and prospectus.




Figure 39 - Marked Note Report Printed on Mailing Labels

At the end of the day, the label containing the note can be used to keep track of what the customer is expecting to receive.  For your convenience, the label that displays the customer's name and address can be placed on the envelope for mailing.

1. The first thing that you will want to do when a customer requests specific information is to type the information into the Notes section of the contact record.  Mark the note by pressing the Mark button.

2. At the end of the day, select the Marked Notes option from the Mail menu and print the marked notes on labels.

3. Finally, use the printed notes and labels to prepare mailings of the requested items. 
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Figure 40 - Marked Note Screen

3.7  Keep track of your progress

It is important to know how well you are calling.  The Tallies Report, located under View, Reports, provides you with an instant view of your progress on a weekly, monthly and yearly basis.  Sales Ally will report and graph how many calls you have made and how often a call resulted in a contact.  Also, in network situations, the manager can evaluate another user's call progress by viewing their tallies information.  This is a powerful and useful tool for managers to track the calling activity of their employees.

The Tallies Report gives you the opportunity to set goals and track your progress towards them.  For example, you might give yourself a goal to contact 50 people a day.  Periodically, you can check your tallies.  If your tallies report shows that you have exceeded your goal, then adjust your goal higher. If you are having difficulty reaching 50 contacts a day, readjust your goal to a more realistic level.

History of Accomplished Activities

You can also view your history of Calls via the Activities Calendar.  Choose Activities Calendar from the View menu, select Summary view, check the History box, and select CALL in the Show Type list box.  You can view the same information using the history report under Standard reports.
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Figure 41 - History Summary Showing Accomplished Activities

A more detailed history report would be the Weekly History Report XE "Standard Reports:Weekly History Report" .  This report will show you the number of activities you scheduled and the number of activities you accomplished for each Activity Type, Call, Action, Meeting, etc.  The graphical report will process the activity information on the previous week Sunday through Saturday. This report includes Goals that you setup in User Preferences, User Info section. Below is an example of the Weekly History report for the Activities Type, Call.

CALL

Number of Events

	
	Sun
	Mon
	Tue
	Wed
	Thu
	Fri
	Sat
	Total
	Goal

	Scheduled
	10
	27
	29
	15
	25
	42
	0
	148
	100

	Accomplished
	15
	39
	41
	24
	33
	45
	0
	197
	100

	
	
	
	
	
	
	
	
	
	





Figure 42 - Weekly History XE "Reports:Weekly History"  Report

3.8  Send your contacts marketing letters

The Sales Ally word processor, also known as the Letter Writer, is designed to perform a multitude of writing tasks.  You can compose new letters, amend old ones, and send individual or group mailings and merge contact record information to produce personalized letters.

Let’s say that you are running a campaign to gain a higher level of investment from your clients.  You want to target clients who have a net worth of over $250,000 and an interest in high growth funds. Decide that you will begin the campaign by sending a letter detailing certain high yield funds. Using the Letter Writer you can create an attractive marketing letter and generate a personalized mailing to each of your clients that have been marked with an interest in high growth funds and a user field indicating a net worth of $250,000 or greater. 

1. To create the group mailing, you must first create your letter.  You can use the integrated word processor by selecting Letter Writer from the Mail menu.  

2. Instead of entering an impersonal appellation such as:



“Dear Client,” or “Dear Prospect,”

Use the built in merge codes to allow you to personalize your letter.  For example you could enter “Dear ” followed by merge codes for the Salutation and Last Name or Nick Name.

Once you have created and saved your letter, you are ready to create your mailing list.  Select Mail, Group Letter, New List and enter the criteria into the Edit List dialog. 

3. The letter will be merged with the names and addresses from your mailing list and sent directly to the printer.  Letters will not be printed for any contact records that have the No Mail option checked unless you select the Ignore No Mail option in User Preferences.

3.9  Sales and Marketing Management with Sales Ally

Sales Ally contains many sales and marketing support features to help guide account reps. to sales opportunities.  As a busy account rep., you can often find yourself reacting to a crisis, rather than taking proactive actions for your client XE "Client" s.  There are many features of Sales Ally that were designed to help you to be a good watch-dog (always reviewing the status of products and people) and, in short, being an excellent account manager.

Specialized Sales Support Functions

Under the View menu you will find many scheduling and list generating features to aid your sales campaign efforts.  The pull-down menu depicted below describes each of these functions.  As you can see, in addition to the normal Activities Calendar that you use on a daily basis to conduct your business, there are four types of “attack” lists XE "Attack Lists"  under Campaigns that you can use to support proactive marketing campaigns.
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Figure 43 - Pull Down Menu showing sales and account management campaigns
Attack Lists

There are four categories of lists XE "Lists"  you can create for your sales and account management campaigns.  For example, you may want to create a list of all people in a Zip code range to call upon, or possibly a group of people XE "Group Of People"  whose products need replacement.  First you should identify the type of Activity you wish to pursue, such as Calling, Action, or Group list.  Select one of these list categories, create the list, and then attack it!

Four Groupings of Contacts from your Database for Targeted Campaigns

· Call Lists - a list, or many lists, of contacts that you can approach to sell or market new products or services using the telephone as the main tool.

· Action Lists - a list, or many lists, of contacts for whom you have a certain action in mind.  For example, you might create a list of your clients who own a certain product that you wish them to sell.

· Group Lists - a list, or many lists, that you can create comprising groups of clients who might share particular characteristics, such as an interest in a new product offering.

Shown in the figure below is the Attack List calling list created by selecting contacts from the database using selection and sorting criteria.
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Figure 44 - Sample Calls Campaign List

Click on View List to see the resulting list of contacts. You can then click on a contact and press the Zoom button (or double click on a contact) to display the Address page for the contact.  From here you can dial the phone number and take notes in the usual manner.
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Figure 45 - List of people you have selected to call in your marketing campaign
3.10  Coordinate your office into a Workgroup




A network version of Sales Ally allows many people to use the database simultaneously.  This insures that every person in your office has access to the constantly changing contact information.  Such a system avoids confusion and facilitates accurate information exchange between the members of your staff.  The network version features password protection, restricted user access and shared resources.  Additional users can be added to your network by contacting your Sales Ally sales representative at 484-875-1710.

CHAPTER 4    WINDOWS features

This chapter is designed to give those of you who have never used Microsoft Windows a brief introduction to its features and controls.  Microsoft Windows is a powerful, graphics-based operating environment for your personal computer.  Its function is to act as an interface between the underlying operating system, and you, the end user.  Many programs, including Sales Ally, have been specifically written to use the Windows interface and its graphical features and controls.  Sales Ally is designed to run on Windows 95, 98, 2000, ME, XP, Vista, Windows 7  and beyond.

Microsoft Windows, like the Apple Macintosh is an icon driven system.  Instead of requiring you to remember and type clumsy text-based commands, Windows presents all your command options as menu choices or picture icons representing programs or groups of files.  To execute a command or start a program, you simply point to it and click your mouse.  Windows does all the hard work.

A second feature of Windows is that it is Event Driven.  This means that it will switch from whatever it is currently doing to a new task you select with your mouse.  More importantly, by using the event driven model, Windows allows you to start virtually any process at any time.  Processes or controls that are incompatible with a current operation are simply not available - shown as grayed out in Windows.  Sales Ally is a robust Windows application, and unlike more simplistic software, is a MDI (Multiple Document Interface) application.  The MDI model allows you to have more than one task in progress at a time.  This means that you can open one or more contact windows in Sales Ally while displaying a sales script or sales report without removing the contact window from the screen.  This is in contrast to the Single Document Interface (SDI) model utilized in less robust or less sophisticated Windows applications.  With the Sales Ally MDI design, you can switch between the windows by clicking on one or the other to make it the active window.  You can even start one specific process several times.  For example, you could use the Find Contact command in Sales Ally to display one contact’s record and then use it again to find a second contact.  The two contact displays will appear in two distinct windows, allowing you to compare their entries or move data from one window to another window using drag and drop, or other windows editing tools such as cut, copy and paste.  

One of the key features of Microsoft Windows and Scherrer’s Sales Ally is the consistency of the menus and command controls.  The icon used to close an application always appears at the top left corner of the applications main window and always closes the current application.  The same concept applies to all Windows programs.  Thus, once you have learned a control or function in one Windows application, you have learned it for all.

4.1  The Windows Display

The Windows display is made up of Menus, Icons, Groups of Icons, Control Buttons and, of course, Windows.  The main Windows screen comprising the entire display surface is called the Desktop.  

The Program Manager is used to display icons representing other programs and the Main Menu.  It also controls how other programs interact and allows you to switch between them.  The Program Manager is identified by its name in the Title Bar of its primary window.  When you close the Program Manager, you close Windows and any program running within Windows.  Within the Program Manager’s main window, there are several smaller windows containing groups of program icons as well as several individual icons representing other program groups not currently displayed.  The Program Manager’s main window, Group windows and group Icons, demonstrate the three possible states for a window:

1. The Program Manager’s window is Maximized - expanded to utilize the full desktop.

2. The group Icons are Minimized - reduced to a single icon.

3. The Group Windows are Resizable - you can expand or contract them to any desired size or shape and place them anywhere within the Program Manager’s main window, their parent window.  
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Figure 46 - Windows display

4.2  Mouse

In Windows, you will use a mouse or another pointing device (i.e., track ball, joystick, or a light-pen) to communicate with your computer system.  The mouse controls a screen pointer that usually takes the form of a hollow arrow (().  If you do not have a mouse or any other pointing device, it is still possible to use Windows through the keyboard.  However, because Windows has been designed to work as efficiently as possible with a mouse, some keyboard commands are awkward and inconvenient to use.  In order to get the most out of Microsoft Windows, a mouse, or another pointing device is essential.  Using the mouse involves positioning the pointer (() on the screen and signaling an action by pressing the left or right mouse button.  You can Click, Double Click or Drag & Drop with your mouse.

Click:  Position the mouse pointer over the desired area of the screen and press, then immediately release, the button.

Double-click:  Position the mouse pointer over the desired area of the screen and quickly press and release the button twice.
Drag & Drop:  Position the mouse pointer and press the button without releasing it.  Then move the mouse pointer to a new location before releasing the button.  Upon release of the button, whatever is being dragged will be moved to the new location.

4.3  Resizing Windows

As described, Windows allows you to display windows in one of three states - Maximized, Minimized or Resizable.

Maximizing a Window
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You can resize a window to its maximum size, either determined by the work area of window’s parent window or the desktop depending on the type of window, by clicking on the Up Arrow located at the top right of the window.  If a window is of fixed size, the sizing arrows are not displayed.  

Minimizing a Window
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To prevent the windows screen from becoming cluttered with open windows, you can temporarily minimize a window.  By minimizing windows, you keep the screen display more organized without having to terminate active applications.  An appropriate icon represents the program or window. To minimize a window click the Down Arrow located in the upper right corner of the window.

Resizing a Window
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When a window is Maximized, you can reduce it to a Resizable window by clicking on the Double Headed Arrow

Tile and Cascade

The Tile and Cascade options on the Window menu allow you to systematically resize all active windows. The Cascade option on the Window menu will arrange all open windows in an overlapping stack from top to bottom, left to right. The order of precedence is determined by the order you last accessed the windows, with the most recently accessed displayed on top.  Each window is displayed in a standard size, overlapping the other windows as much as necessary.  The Cascade option is most useful for displaying a single window among a group of active windows at the same time, while allowing you to switch from one window to another simply by clicking on an overlapping edge.
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Figure 47 - Cascaded View

The Tile option on the Window menu will arrange all open windows in equally sized rectangles set side by side.   When the tile option needs to reduce the display area of a window to fit, it will crop the window and display scroll bars to allow you to move the image in the resulting window.  The tile option places the most recently activated window in the top left position and then arranges the rest down and to the right in the reverse order of activation.  The Tile option is most useful for displaying multiple windows simultaneously.  If you want to compare two contact records, the Tile option can display them side-by-side.

Closing Windows
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To close a window and the program it contains, make sure that it is the active window by clicking anywhere within the window and then, click on the control menu box, which is represented by a horizontal dash in the upper left hand corner of the window.  This will bring up a control menu.  From the control menu choose Close.  Alternatively, you could select Exit from the File menu or press the Alt-F4 shortcut key combination.

Scroll Bar

Some windows may also have a scroll bar.  A scroll bar is used when a window is not large enough to display all of its contents at once.  The bar will appear along the right side and/or the bottom edge of the window.
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Figure 48 - Scroll Bar

The scroll bar consists of a shaded bar containing a small square called the Thumb, which you can move by clicking on the scrolling arrows located at each end.  The scroll bar represents the window’s entire contents, while the Thumb represents the section currently visible in the window relative to the total display.  To make large jumps, you can click on the bar just inside the arrow icon or drag the Thumb to the desired position.  

Icons

Windows provide graphical pictures called icons.  These icons represent programs as in the figures.


Error! Not a valid link. 

Figure 49 - Program Icons
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Figure 50 - Group Icons

The icons are designed to show a graphical image of the program it represents.  Most of the icons include a written caption underneath to help you identify its function.  If the caption is highlighted, the item is said to be Selected.  You select the icons by clicking on them with the mouse pointer.  You can also select an icon with a group by pressing the Tab or Shift-Tab keys.  You can shift to another group by pressing Ctrl-Tab.  

Starting a program

You can start a program or maximize a group by selecting its icon and pressing Enter or by double clicking on the icon.

4.4  Menu

All general Windows commands and options are listed on the Main Menu.  Windows is said to be menu driven because you can select its options from menus rather than typing the commands with a keyboard.
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Figure 51 - Windows Drop Down Menu Example

When you click on one of the main menu options, e.g., File, you will see a drop down list of additional options associated with the selected menu headings.  To select the feature you want, click the mouse button when the pointer is on the option name.  A shortcut key is also available for some of the options.  Shortcut (accelerator) keys, when available, are always listed to the right of the features it represents.  Pressing these shortcut keys is the same as making the menu selection.

4.5  Running Multiple Applications

One of the principal advantages of using Windows is the ease in which it allows you to run several applications at once.  You can switch between programs without exiting from one application and loading another.  
Switching between active programs

When you are running multiple applications, there are a couple different ways you can switch between the programs.  You can use either the mouse or the keyboard to accomplish this task.  If several applications are running within Windows, and the applications are visible on the screen, you can use your mouse to click on the window of the application you would like to work on.  This makes the application Active.  

If the desired application’s window is not visible on the screen (it is covered by the current active application’s window), you can use the keyboard to switch to the desired application.  To do this, press Alt-Esc.  This will bring each of the active programs to the front one at a time.  
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Figure 52 - Active Programs in Windows 

You may also press the Alt-Tab.  The name of the next application will be displayed in a dialog box in the middle of the screen.  Hold down the Alt key and continue pressing the Tab key until the desired application name is shown.  When the name of the application desired appears, release both keys and you will switch to the application of your choice.  This is often faster than Alt-Esc, as it does not need to redraw the screen for each application before you make your selection.

Exiting an Application

When running multiple applications, you can exit a single application by selecting Exit from the File menu, double clicking on the Control icon at the top left of the program’s window or pressing Alt-F4 when the application is active.  If you select any of these options while the Program Manager is the active application, it will shut down all active applications and close Windows.  When you are running multiple applications, or when an application displays multiple windows, it is often easy to become confused as to which control button or menu applies to which window or application.  It takes some practice to resolve this confusion.  Just be careful that you are pointing to the correct icon or menu choice before you click on it.

PART 2    REFERENCE

CHAPTER 5    FILE MENU
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Figure 53 - File Menu

The File menu contains four fundamental operations: 1) Database selection and manipulation, 2) basic settings for ODBC and TAPI, 3) Print operations and 4) program Exit.  The database options allow you to create and select among existing Sales Ally databases.  It also allows you to import and export data from and to other programs.  The Global Change function allows you to change information over an entire group of contacts, or the entire database. The Download option specifically imports security prices into Sales Ally or security transactions to the Sales Ally posting book.  

TAPI Settings (Telephony Application Program Interface) allow you to set up the telephony software for automatic dialing.  You must, of course, have a compatible modem installed in your computer.

The Print Setup option gives you the ability to choose the print device, port connection and output options you want to use with the Sales Ally Letter Writer.  You can preview a letter on the screen with the Print Preview option or print it directly to a local or network printer by selecting the Print option.  The Reports function has a separate and distinct Print Setup, Print, and Print Preview controls. Page Setup allows you to setup the page layout within your letter writer.  This item is only active when you are using the Sales Ally Letter Writer.

The Exit option closes down Sales Ally.

5.1  New Data Sourcexe "New Data Source"

xe "Create: Data Source"
The New Data Source option allows you to create a new Sales Ally data source; essentially a new database.  A data source consists of many individual tables or files but appears to the user as one single database.  In this section, we will explain how Sales Ally creates data sources and how it manages these databases.  While most software programs are extremely limited in the number, type and configuration of its data files, Sales Ally is designed to be extremely flexible and powerful.  Unfortunately, power and flexibility come with one significant price, a certain amount of complexity.  You need to invest a few minutes of your time to understand how Sales Ally creates and maintains its data files in order for you to fully utilize its features. If you are a single user (not on a network), we provide default setup values to save you time.  You will, however, benefit from an understanding of the Sales Ally data structure.

Data Structurexe "Data Structure"

xe "Common Files"

xe "Files:Common"

xe "Files:Unique"

xe "Unique Files"
In Sales Ally, a data source is defined as a collection of files that constitute a database.  The main file is ALLYWIN.MDB. For our larger national account customers, we have designed Sales Ally to utilize their own native databases through ODBC technology.  

Some filesxe "Files:Unique" are uniquexe "Unique:Files" to a specific Sales Ally data source and some are commonxe "Files:Common"

xe "Common:Files" to all Sales Ally data sources.  For example, contact data for each data source is stored in a separate file whereas scheduled activities for all data sources are stored in a common file.  This allows you to see all activities for the day regardless of which data source the contacts reside in.  The single user and default network data source configuration is as follows:

Activity
Common

Alert
Common

Book
Common

Account rep. Numbers
Common

Lists
Common

Marked Letters
Common

Notes
Unique

People
Unique

History
Common

Remembered Responses
Common

Securities
Common

Tallies
Common

User Fields
Common

The logic for this structure is really quite simple. Those files containing data that is unique to an individual users data source is specified as unique.  Those files that contain data that can be beneficially shared between users or data sources are defined as common.  For example, the people file containing your personal prospects should be unique otherwise all contacts would be in the same data source.  On the other hand, the list of account rep. numbers (rep ID’s) is not likely to differ between users of Sales Ally or between clients or prospects - clearly a candidate for a shared file.  Other files are similarly allocated.  Whenever you mark a letter it is stored in a common file so that you can print marked letters for all data sources in one efficient operation.  Notes are unique since they apply to individual contacts - already defined as unique.

Selecting a Default File Locationxe "Default File Location"
The second step is to select a default file location by specifying a Default Data Path, which you setup via Edit User Preferences as discussed in the Edit chapter.  Sales Ally uses the default Data Path as the location for creating new data sources unless you specify a different location at the time of creation.  When Sales Ally is shipped, the Default Data Path is initially set to the same directory you used to install the program (for example C:\SA6).  However, you can change it to whatever location best suits your situation.  If you are an advanced single user, you may wish to place all the data files on your computer in subdirectories, branching from a single directory called C:\DATA.  Thus you might set your Sales Ally data directory to be C:\DATA\SAWIN.  This would allow you to easily backup all of your frequently changing data files by backing up the C:\DATA subdirectory and all its subsidiary directories without needing to back up all your program files that change less frequently.  In this case, you would set your Sales Ally Default Data Path to C:\DATA\SAWIN.  
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Figure 54 - User Preferences dialog

Creating a New Data Sourcexe "Creating a New Data Source"
When you select New Data Sourcexe "Data Source:Sales Ally", the Create New Data Source dialog appears. The dialog box contains a listing of all previously defined data sources and the input fields for creating a new one.  The scroll box showing existing data sources is inactive and displayed for information purposes only.  The Scroll box at the top right allows you to select the ODBC data source to be used for the new Sales Ally data source.  If you are a single user, the only available option is Local Data.  However, if you are a network user with more than one data source defined, you should select the data source most appropriate for the new data source you are creating.  Your system administrator can provide guidance as to the correct data source selection.  
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Figure 55 - New Data Source Dialog

Enter a text description of the new Sales Ally data source in the input box located at the top left.  The text description has no required format but should be short and descriptive.  The middle right box is used to enter a unique file namexe "File: Names".  The file or table name you enter will be used unaltered as the name of the contact file.  To maintain order, Sales Ally will automatically append an extension appropriate for the ODBC data source selected, USUALLY A MS-ACCESS FILE TYPE.  Sales Ally will add a one-letter prefix to the name you entered to create the name for each unique file comprising the total data source.  For example, Sales Ally will add the prefix ‘N’ to the beginning of the file name you entered in order to make a name for the Notes file.  This process of adding a single letter prefix to the name you specify and the operating system limit of eight characters for a file name structures the file name length to seven characters.  A name longer than seven characters will not be accepted.  Since you will be able to identify the new data source by its descriptive name, the file name can be quite terse so long as it is unique. 

If you want to place the data source files in a directory other than that defined in User Preferences, you can include a drive and path as part of the file name definition.  Sales Ally will use the specified drive and path as the location for the new data source.  For example, if you type C:\DATA\TEST, the contact data file TEST and other related files will be created in the C:\DATA directory. Once you have entered the required file name (with optional path) and text description, and selected the ODBC Data Source Type, click on OK to create the data source.

5.2  Database Operationsxe "Database:Operations"
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Figure 56 - Database Operations Menu

The Database Operations option on the File menu controls file transfer and file manipulation. The first two options, Import and Export, allow you to move data into and out of Sales Ally.  Sales Ally can import and export data from a variety of file types. The Download option specifically imports security price files (a security master file) and investment trade and/or transactions into Sales Ally.  The Delete Data Source option allows you to remove a Sales Ally data source and all its unique associated data files from the system. It does not remove common data files (e.g., Activities or History) from the system unless you are deleting the last available data source.  Finally, the Maintenance option rebuilds dBASE indexes for a selected data source; a handy option used if your files become corrupted through damage to the hard disk drive.  

Importxe "Import"

xe "File:Import"
You can import data from several sources.  The ASCII Loader, which is available only in the Gold version and above of Sales Ally, accepts information in a standard ASCII (CSV) format (American Standard Code for Information Interchange).  The Sales Ally v4.x upgrade loader copies data from a BA4 database, while the Sales Ally v5.x loader copies data from another Sales Ally v5 database, and so on.  To bring data into Version 6 from version 5, select the appropriate Import utility from the dialog. The ODBC Generic Loader will accept data from a variety of database management systems.  Go to Database Operations on the File menu and select Import from the popup menu.
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Figure 57 - Import dialog

ASCII Import 

Sales Ally accepts data from an ASCII file in comma-delimited format.  The fields may be enclosed within double or single quotes and each record must be terminated with <CR><LF>.  The ASCII loader will accept contacts, notes, postings, and securities information.  When importing notes and postings, the ASCII loader will only accept 1 note and 1 posting per contact record transferred.  

xe "Import:ASCII"
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Figure 58 - Map ASCII fields to Sales Ally fields

1. Select ASCII Loader from the Import dialog and press Start.

2. Supply the filename of the ASCII file.

3. The Map Fields dialog presents (on the left) a list of sample fields taken from the first ASCII record.  The list box on the right shows the destination fields in Sales Ally.  You must map every field you wish to import by selecting a sample data field in the left hand list box and a destination field in the right hand list box.  Select "<Do not Map>" to unassign an incorrectly mapped field.
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Figure 59 - ASCII Options

4. If the incoming data is in upper case, we recommend that you check Convert to Mixed Case in the ASCII Options dialog.

5. To add default data to each contact, check Add default data.

6. Start transfer with record # and Number of records to transfer, enables you to transfer a specific number of records at a time.

[image: image72.png]Default Contact Data

oot N o]
fies = =

et E| = =
[ty

CMO Help.
Fa = 2| T Use Defauls for Add Contact
Comments:

[Met this person at a tax seminarl Ogrer

v

Salutaton: [fr_ & Status: [Fospect
Company: Rating [Fot

Cig [Phisdea st [P | Zp

11

oy 052 Sotce i | erzs |





Figure 60 - Add default data to each contact as it is transferred

We provide a special field, Full Name, which will accept a contact name in the format Mr. and Mrs. John J. Jones, Jr.  If you map an ASCII field to Full Name, we will attempt to identify the various components and load them into the appropriate name fields: Salutation, 2nd Salutation, First Name, Initial, Last Name, Suffix.  When loading into the Flags field, commas should separate your flags.

You can import one note and/or one activity and/or one posting along with each contact, but you cannot import notes, activities or postings separately.  The loader can only import a note, activity or posting if it knows the identity of the contact record. 

Sales Ally Version 5 or 6 or 7 Import

Sales Ally has convenient import utilities that can copy your data from previous Sales Ally version 5, 6, or 7 to Sales Ally V6 and beyond.  The import utility will bring over all User ID information, securities, contacts, notes, postings, Class definitions, User Field definitions, and scratch pads.  If you have lots of data, this can take a long time, so please make provision for this needed time.

1. Under the File menu select Database Operations.  From the popup menu select Import.

2. Select Sales Ally v5.x upgrade and click Start.

3. Make sure you specify the correct directory for your BA5 data files.

4. Click OK.

5. Go to User ID under the Edit menu, select Configure, and make sure the All Account rep. Numbers option is checked.

6. For Level0, Level1, or Level2 users, you will have to assign rights because we cannot convert the information in BA5.  While in the Configure dialog (step 5) select Edit Levels and assign rights as appropriate.

The import process checks the Sales Ally database for duplicates before loading any new information. Thus you can run this utility several times without fear of overwriting existing data or making duplicate entries.  You can stop the loader at any point and start again at a later time.

Sales Ally Import utility

You can import contacts, notes, activities, history, positions, and security information from another Sales Ally database.  The common files must be in the same disk directory as the contact and notes files.  You can import new contacts (and associated notes, etc.) and/or update existing contacts (and associated notes, etc.).  Similarly, you can import new securities and/or update existing securities.  Furthermore, you can import information that has been entered or changed as of a specified date.
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Figure 61 - Import dialog for ASCII Loading

1. Select the data source type for the import database. 

2. Select Import new contacts if you want to import contacts that do not exist in the target database.

3. Select Update existing contacts if you want to update contacts that already exist in the target database.

4. Select Import new securities if you want to import securities that do not exist in the target database.  

5. Select Update existing securities if you want to update securities that already exist in the target database.

6. Enter a date for Changes since.  BA will import only the data records that have been entered or last changed on this date or more recently.  To import all data records, erase the date.

7. Click OK.

8. In the next dialog select the contact file for the import database.

Update Rules

Every data record has an associated date and time when it was last edited.  It will be updated only if the last edit date/time of the import record is more recent than the last edit date/time of the target record.  

Furthermore, every contact data record has a last edited date for each group of fields.  The fields in each group are updated only if the last edit date is the same or more recent in the import record.  The field groups are:

NAME: All name fields and 2ndName, NickName, SS/TaxId.

ADDRESS: Company, Address, City, State, Zip, Country, Carrier Route.

PHONE: WorkPhone, WorkExt, HomePhone, AltPhone, AltExt, FaxPhone.

ACCT: OpenDate, Status, Owner, Secondary Rec, Account.

INFO: Birthday, Flags, Interests, Rating, SourceKind, Source, Comment, NoMail.

USERFIELD: User Fields.

LINK: Link information.
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You can minimize the time required to import data by entering the most recent possible date for Changes since and selecting only Import new....  Searching for records to update is slower than searching for new records only.

Exportxe "Export"

xe "File:Export"
Sales Ally allows you to export a selected data source (or portion thereof) via the Export menu option in either ASCIIxe "ASCII"

xe "Export:ASCII" or Sales Ally format.  You may export contacts (and/or related notes, postings, activities, etc.) and/or securities to another Sales Ally data source or external database.  If you export to an external database, you can transport the information to another computer. 
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Figure 62 - Export Dialog

If you have the Gold or above version of Sales Ally, you may export contact or security information to an ASCII file.  You choose the fields to export.  

1. Under Data Source select a Sales Ally data source to export from.

2. Under Export Type select the export format, either ASCII or Sales Ally.

3. In the Using group, check List to use a list of selected clients and/or check Last Edit date to export only those records which have been changed as of a certain date.  The List option has no relevance when exporting only Security information.  If you check List, also select a List Type.  If you check Last Edit date, also enter a Changes Since date.

4. In the Data group:  Check Contacts to export contact information.  Check Related Notes, Postings, etc. to export notes, posting book entries, activities, and history.  Check Securities to export security information (Symbol, Description, Price, etc.).  When performing an ASCII export, you cannot export related notes, etc., and we do not recommend exporting contacts and securities simultaneously.

5. Click on Start to proceed to other dialogs.

ASCII Export
ASCII Export writes the contact fields you choose to a text file.  When exporting security information, all fields are written to a text file.  Every field is enclosed in double quotes (" "), each field is separated from the next field with a comma (,), and each record is terminated with <CR><LF>.  After you click on Start, the Open ASCII File dialog allows you select a destination directory and enter a filename for the text file to be created.  If you choose an existing file, the export engine will delete the current contents of the file before writing to it.  Click on OK to continue.

When exporting contacts, the Contact Fields to Export dialog allows you to select the fields to write to the file.  To select multiple fields, hold down the Ctrl key and click on as many fields as you wish.  To select a group of adjacent fields, hold down the Ctrl key and left mouse button while you drag the mouse pointer over them.  You may select FULL NAME to create a single field with a composite name such as Mr. and Mrs. John J. Jones, Jr.  Click on OK to start exporting.  The order of the fields in the file is the same as the order of selections in the Contact Fields list box, top to bottom.
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Figure 63 - Choose Sales Ally fields to export in ASCII format

Sales Ally Export

You may export from one Sales Ally data source to another, or you may export to an unregistered data source that can be transported to another computer and merged with one of its Sales Ally data sources.  

You can copy data from one registered Sales Ally data source to another by selecting a target data source in the To Data Source list box. All other list boxes are disabled because the file name and directory information are already known to Sales Ally.  

When exporting data to diskette, exporting contacts, related notes and postings, the diskette will hold approximately 300 to 400 contact records.  When creating a list for exporting you can limit the number of contacts exported.

In order to move data from one computer to another, you should export to an unregistered data source as follows:  

1. Under To Data Source, select <Export>.

2. Enter a file name for the contact information such as "export", and select a Drive, Directory, and Data Source Type.  Be sure to select a directory where no other Sales Ally data files reside.

3. Click on OK to begin exporting. 

4. If you would like to delete the contact records after your export, check the box “Delete after export”. 

5. After completing the export, backup the files on diskettes.

6. Restore the files to an unused directory on the second computer.

7. On the second computer, use Sales Ally Import to merge the data with an existing registered data source.
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Figure 64 - Sales Ally export dialog
Docking Transferxe "Docking Transfer"
Use this feature to load data to your portable notebook computer that is temporarily “docked” at the network port. After you check the Docking Station option in User Preferences, you can download all of your data from the Main data source located on the network file server to your local computer.  This allows you take your laptop PC home and continue using Sales Ally.  Select Docking Transfer and Docking Download from the File Data Operations menu to copy your data from the file server to a dBase data source on your PC.  After you disconnect your PC from the network, you can work with the copy of the network data source which will now be located on your local hard drive.  You may subsequently use Docking Upload to pass additions and revisions back to the network data source when you come back into the office and connect to your network.

Sales Ally will asks you "Plugged into a docking station?" on start up after you have checked the Docking Station option and have downloaded a "snapshot" of your network data.  Your answer will determine the next course of action.

· Yes to use the Main data source on the network file server, or

· No to use the local copy of the Main data source.

Docking Downloadxe "Docking Download:Docking Transfer" 

The Docking Download transfers only the data in the Main data source that you have privileges to view.   You cannot download private Sales Ally data sources located on the file server; only the Main data source can be transferred using this Docking Download feature.
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Please Note:  When undocked, private data sources which reside on your PC will have only contact information and notes.  This is because postings, activities, histories, etc. are stored on the file server and are not downloaded.

Docking Uploadxe "Docking Upload:Docking Tranfer"
The Docking Upload feature allows you to upload all of your changes back to the network file server.  Otherwise, changes you make to the local copy of the Main data source will be lost when you next download from the server. 

Docking Upload passes changes to Contacts, Notes, Postings, Activities, Histories, Securities, Remembered Responses, Phone Tallies, Alerts, and new User Field information back to the main database located on the network file server.  
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Please Note:  Marked Letters and Lists are not uploaded and consequently will be overwritten whenever you perform a docking download.

Global Changesxe "Global Changes"
Use this feature to change information over the entire database. You can modify the Owner field (thus reassigning the account to another representative), Flags, or Interests held within a selected group of contacts, or the whole database.  Furthermore, you can add an Activity or History to a selected group of contacts.  Global Changes is found on the File menu under Database Operations.
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Figure 65 - Global Changes dialog

Selecting Contacts

Choose a Sales Ally data source and select the contacts you wish to affect by:

· Uncheck List and Owner to change all contacts in the data source.

· Check List and choose a List Type to use a list of contacts.

· Check Owner and enter an Owner to change only the contacts with the specified Owner.  If you are using a list, you will change only the contacts in the list having the specified Owner.

Select Item

Click the Owner, Flag or Interest button to enter the change you wish to make.  Or click the Activity or History button to add an Activity or History for each contact.  Click the Start button to make the changes.

Global Changesxe "Global Changes:Owners" for changing Owners

Select Change to put a new Owner in each contact record.  Select Replace to substitute a new Owner for a specified existing Owner.  The New value is inserted only when the Old value is found.  Select Delete to remove the Owner when the specified Old value is found.

Global Changes for changing Flagsxe "Global Changes:Flags"
Select Add to add a new Flag to each contact record.  Select Replace to substitute a new Flag for a specified existing Flag.  The New value is inserted only when the Old value is found.  Select Delete to remove the Flag you specify in the Old value edit box.

Global Changes for Interestsxe "Global Changes:Interests"
Select Add to check an Interest in each contact record.  Highlight the appropriate Interest in the New Value list box.  Select Replace to substitute a new Interest for a specified existing Interest.  The New value is checked only when the Old value has been checked.  Select Delete to uncheck the Interest you highlight in the Old Value list box.

Global Changesxe "Global Changes:Histories" for Activitiesxe "Global Changes:Activities" and Histories

Use this dialog to enter the information for Global Changes when adding an Activity or History to a group of contacts.  In the case shown below, a group of contacts will be assigned a new year call on January 11, 2003.
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Figure 66 - Global Change - Add Activity

Global Changesxe "Global Changes:Histories" for Plan (Sales Planner)

The Sales Planner is used to create sales and marketing campaigns for individual contacts or a group of contacts.  You can create many different sales plans and have them readily available for future selling opportunities.

Applying a Sales Plan to a List:

Once you have created your Campaign List, click on File, Database Operations, Global Change.  

1. Choose a Sales Ally data source in which your list exists.

2. Check List and choose the List Type. 

3. Click on the Plan button in the Add section of the Global Change dialog.

4. Select the start date of your plan.

5. Highlight the plan you wish to Apply, and press OK

6. At the Global Changes Dialog, press Start

7. Sales Ally will display your lists that have been created.  Highlight the list you would like the Sales Plan to be applied and press View List.

Press the Global Changes button and you plan will be applied to your selected group of contacts.

Global Assign/Delete for Listsxe "Lists:Global Changes"
Use the List button to assign a List to a new owner. Thus, you can assign a List without an owner to a particular user.  Furthermore, you can re-assign a List belonging to one user to a new owner.  For example, you can assign a prospect list to another representative using this function.
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Figure 67 - Global Assign/Delete Lists

1. Use Select by Owner to display the Lists belonging to a particular user (or no user).  Select a user from the combo box pull down list, or enter a User ID and click on a different edit control.  Select <No Owner> to view Lists belonging to nobody.

2. The Lists belonging to the selected owner appear under Lists.  Click on the List you wish to re-assign and click on the new owner under Owner.  The master table will be updated.  When you select a List, BA displays the data source on which it is based.
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Please Note:  You must have the User ID Edit right to reach this dialog.  The contents of the Select by Owner and Owner controls may not include all valid users unless you have access to all users.

Global Assign/Delete for Activities and Histories

Use the Activities or Histories button to assign Activities or Histories belonging to one user to another user, or you can delete them for a specified user.  The following explanation for Activities applies equally to Histories.

To assign Activities or Histories:

1. Select the Assign or Histories button.

2. Select the user who currently owns the Activities or Histories in the from User list box.

3. Select the user to whom you wish to assign the Activities or Histories in the To User list box.

4. To move all types of Activities or Histories, make no selection in the Activity Types list box.  Otherwise select one or more activity types. 

5. To move all Activities or Histories regardless of the due date, make no entries for the Date Range.  If you enter a From date, Activities from this date forward will be moved.  If you enter a To date, Activities up to and including this date will be moved.  Enter both From and To dates to specify the first and last dates to be included in the move.  For Histories, the date range applies to completion date rather than due date.

6. Push the Start button to begin the transfer of selected Activities or Histories from one user to another.

To delete Activities:

1. Select the Delete button.

2. Select the user who currently owns the Activities or Histories in the From User list box.

3. To erase all types of Activities or Histories, make no selection in the Activity Types list box.  Otherwise select one or more activity types. 

4. To erase all Activities or Histories regardless of the due date, make no entries for the Date Range.  If you enter a From date, Activities from this date forward will be erased.  If you enter a To date, Activities up to and including this date will be erased.  Enter both From and To dates to specify the first and last dates to be included in the delete operation.  For Histories, the date range applies to completion date rather than due date.

5. Push the Start button to begin the deletion of selected Activities or Histories.
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Figure 68 – Global Assign/Delete Activities

Delete Data Sourcexe "Delete Data Source"

xe "Data Source:Delete" 

Delete Data Source removes data source names from the list of data sources and erases their associated unique files from the hard disk.  It does not delete data in the common data files such as the posting book or activity files unless you are erasing the last available data source.  To delete a Sales Ally data source, select Delete Data Source from the Database Operations menu.  Sales Ally will display the Delete Data Source dialog.  Click on the name of the data source to be deleted and then click on the Delete button.  Sales Ally will ask you to confirm your decision since the deletion is permanent and cannot be reversed.  

You are advised to backup your data files before you delete them in case your decision proves hasty.
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Figure 69 - Delete Data Source Dialog
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Figure 70 - Deletion Confirmation Dialog 

Maintenancexe "Maintenance"

xe "File:Maintenance" 

You may use the Maintenance function in Error! Reference source not found. for re-indexingxe "Files:re-indexing" of dBASE filesxe "dBASE files"

xe "Files:dBASE".  The most common cause of a malfunctioning data file is a corrupted index file.  If file searches or updates fail or take much longer than expected, you should re-index the file.

If you have checked Direct File Access in User Preferences, Maintenance will also pack dBASE data files, i.e., remove deleted records.  Maintenance does not remove orphaned records, nor can it recover corrupted files.xe "Orphaned records"  An orphaned record is one whose parent contact no longer exists because you have deleted a data source.

[image: image87.png]Maintenance

Files/Tables: Data Source:

Rebuid All

[ |
==

Cancel





Figure 71 - Maintenance Options

No other users may use Sales Ally during the repair process since it requires exclusive use of the files.  If a file is in use by another user, the Maintenance option will place “(locked)” next to the file name. 

Select a Sales Ally data source, and then choose one or more files belonging to the data source to rebuild.  A file in use by you or other users will be marked as “(locked)” indicating that you cannot re-index it.  Close all open windows to unlock the files.  Sales Ally cannot lock the files to prevent other users from intruding on the maintenance process.  Thus it is imperative that no one be using the files while Maintenance is in progress.

You may click on Rebuild All to re-index all unlocked files for a selected data source.

If Direct File Access is enabled, every time you create a new list, such as a Calls List, the list file, GLIST.DBF, is packed and re-indexed.

1. This process will remove “orphaned” recordsxe "Orphaned records" from the common files.  An orphaned record is one whose parent contact no longer exists because you have deleted a data source.

1. It will create new index files, to improve performance.

1. It will compress data files by physically removing deleted records.  For your understanding, when you delete a record it is only marked as being deleted while it still occupies space in the file, until the file is recompressed.
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Warning:
The index repair feature of Sales Ally does not eliminate the need for frequent and regular backups.  Many factors beyond the control of Sales Ally can cause data contamination or damage (e.g. power failures, inappropriate imports or deletions, and accidental erasures of critical files).  We strongly recommend that you establish a routine backup policy and follow it rigorously.  

At the very minimum, you should maintain three sets of complete system backups.  Rotate among them, overwriting the oldest tape or disk set with the new backup.  This is called a three generation or grandfather backup scheme.  In most cases, you will want to keep even more generations in your backup scheme.  Many companies keep a two tiered backup system, recycling daily or weekly backup tapes or disk sets frequently, while maintaining monthly copies for longer periods, often years.  With any system, it is imperative that you keep some or all of your backups off site - either in a bank safety deposit box or other secure site to ensure its availability in the case a fire or other disaster that destroys your office.

5.3  ODBCxe "ODBC:Settings" Settings

An Open Database Connectivity (ODBC) data source is basically a database management system driver for your Sales Ally data sources.  An ODBC data source must be registered and configured for Sales Ally, and you may use this option to view and change any ODBC settings.  Use the Help button in ODBC Data Source dialog for specific instructions.

dBASE IV

When using the default dBASE IV driver for Sales Ally, the directory information is unimportant since it will be overridden by Sales Ally.  Do not select any indexes as Sales Ally does this for you.  If you are running a single user installation of Sales Ally, check the Exclusive option for better performance.  

5.4  TAPIxe "TAPI:Settings" Settings

Use the TAPI Settings (Telephony Application Program Interface) command to setup your modem for automatic dialing.  You need to: 

1. Identify the Communications Port for your modem.

2. Set the Speed to 2400.

3. Enter your Phone Number.
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Figure 72 - TAPI Setting

Furthermore, you should use the Options button in the Dialer dialog to setup dialing prefixes and suffixes for local, long distance, special long distance, and international phone calls.  Choose Phone Dialer from the Tools menu, and press the Options button.

Dialing Options

The Dialer dialog has an Options button where you set up dialing procedures for various types of calls.
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Figure 73 - Dialer Options

It allows you to enter your local area code so that all calls to your area code will be dialed as local numbers.  It allows you to enter dialing prefixes and suffixes that will be combined with phone numbers “grabbed” from the contact window.  A prefix is what you need to dial to connect to an outside line whereas a suffix is an optional accounting code your firm may require.  Sales Ally allows you to enter a prefix and a suffix for each type of call: local, long distance, international, and special long distance.

A dial prefix string can be a combination of modem commands and dialing codes that precede a phone number, Figure 73 - Dialer Options and here is an illustration of typical prefix strings:


Local Calls Prefix:

“9,”


Long Distance Calls Prefix:
“9,1”

The Local Calls Prefix will dial “9” and pause two seconds to allow for connecting to an outside line.  The Long Distance Calls Prefix will dial “9”, pause two seconds, and dial “1”.  For more information, see Options under Dialer in the Tools chapter.

General Settings

Select the No Modem option if you do not have a modem but would like to track your calls, successful contacts, and update Last Contact in a record.  Select No Modem and proceed as if you were dialing the phone automatically.  Although the Dial button will be inactive, the Contacted button will register the information.

Select the Contact History option to update the Last Contact field in a record and add an entry to the history file documenting your phone call. The entry is added to the history file only when you click on Contacted and Hang Up button when using the dial feature.

5.5   Page Setup

This menu item is only active when you are using the letter writer.  Page Setup allows you to change the default Tab positions and Margins.  The Height and Width are determined by the printer you have selected. You cannot change these settings.

5.3
Faxxe "Fax"
Sales Ally for Windows has the ability to transmit any printed output to any level III fax device if you have installed a compatible fax modem.  When you select the fax output option, Sales Ally for Windows creates the selected document or documents as a print file on disk.  It then passes a request to the CAS fax manager to transmit the selected file.  You will be prompted to enter a destination or destinations for the fax and it will be scheduled for transmission.  The Fax manager maintains a log of transmissions and their status.  See the next section.

5.4
Fax Logxe "Fax:Log"
The Fax Log Dialog in Figure 3 shows all past fax events.  You can select to display Errors or Completed faxes or both by checking the appropriate boxes.  You can resubmit a fax (either completed or in error) by highlighting the log entry and clicking on the Resubmit button.  You can delete an entry and remove its associated file from disk by highlighting its entry and clicking on the Delete option.  You can print a selected fax to your printer by clicking on the Print button.  If you want to perform a selected function on all the entries, you can click on the Select All button.  

[image: image91]
Figure 3 - Fax Log Dialog

5.6  Print

Use the Print option on the File menu to send the current letter displayed in an active Letter Writer window to your Printer.  When you select Print from the File menu, you will be presented with a dialog with print options.  You can select specific pages and number of copies to be printed, or you can select a different printer.  On the other hand, to print a report you will use the Print XE "Print"  button in the Reports dialog.

5.7  Print Previewxe "Print:Preview"
While using the Letter Writer, the Print Preview option opens a special window and displays the current letter as it will appear in the final printed form.  It has buttons that allow you to page forward or backward and print the current letter.  This is a handy feature that allows you to see things before you print them in order to save you from wasting paper and time.  The Reports function has a separate Print Preview facility.

5.8  Print Setupxe "Print:Setup"
The Print Setup option displays the standard Windows Printer Setup dialog.  This allows you to specify the Printer to use with the Letter Writer.  In Windows, you must highlight your desired printer, click on the File Menu, and select Properties for the printer options. 

The Setup button brings up a secondary printer setup dialog specific to the currently selected printer, allowing you to select page orientation, paper size, paper source, etc.  See your Windows and/or printer user's manual for detailed instruction for setting up your particular printer.  There is a separate printer setup for Reports that allows you to temporarily change the printer settings for a particular report.

[image: image92.png]| Fie Ndt View Go Favertes Help

« > @] % @ X
v s Up | Cm  Coy  Pate | Unio | Dol Pupeties
[Addtess & Piers

(A Piter B Canon (BP AT 3 Compag PageMarq 15

ERion S BIDESC/PS §EpsonSusCOLORESC/P2 (g Epson Stjus Pro ESC/P 2

HE Besklet G HP Desklet 400 G HP Desklet 500
|G HP Laseret 4L S§1BM 4023 LaserPinter S§1BM 4033 LaserPiinter

Lexmak 4038 LasePite Plus gLtk 4038 Plus PS

GLematk Color 4079 pus PS




Figure 74 - Print Setup dialog for Windows

5.9  Exitxe "Exit"
Use the Exit option to exit Sales Ally.  The Exit option closes the current session (terminates the application) and returns to the Program Manager or the last application you started.

CHAPTER 6    Edit Menu
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Figure 75 - Edit Menu

The Edit menu contains options for cutting, copying and pasting text within and between data screens in Sales Ally.  They also allow you to move snippets of text between Sales Ally and other Windows programs.  You can use the Undo option to reverse changes made to the current document or data screen.

The Securities dialog allows you to view and edit information about the securities master file used to price and characterize transactions and holdings.  Finally, the User ID and User Preferences options can be used to customize your Sales Ally installation.

6.1  Undoxe "Undo"
You can select the Undo option for two types of screens: text editing screens, such as the Letter Writer, Notepad and Script editor, or data entry screens such as the Contact view. When you are working with a text-editing screen, the Undo option will reverse the last editing action. For example, if you had just changed the font for selected text, clicking on the Undo option will cause the text to revert to its former font.  When you are entering or editing data in a data entry field, the Undo option will restore the previous entry.  When Sales Ally is unable to Undo the current operation, the Undo option will not be available, signified by its dimmed appearance.  

To remove all changes to a contact's note since you last saved it, select Undo on the Edit menu.  If you have marked a note or changed its date, Sales Ally also resets these changes.

6.2  Cutxe "Cut"
The Cut, Copy and Paste options work in concert with the Windows Clipboard.  As such, it is capable of operating within and between Sales Ally and other programs.  The Cut option removes the selected data from the current screen or document and places it in the clipboard.  From there, it can be inserted into the current document in another location or placed in another window or even in another program.  If you do not wish to remove the data from the current document or data entry screen, you should use the Copy option instead.

6.3  Copyxe "Copy"
The Copy option operates exactly as the Cut option, except that it leaves the selected data in position and places a copy of it in the clipboard.

6.4  Pastexe "Paste"
The Paste option completes the Cut & Paste or Copy & Paste operation.  It inserts any data located in the clipboard into the current document or data entry screen at the insertion point.  If there is no data in the clipboard, the Paste option will not be available and the menu choice will be dimmed.  If you wish to move data between Sales Ally and another Windows program, use the Cut or Copy options from the source program and the Paste option from the target program.

6.6  User IDxe "User ID"

[image: image94.wmf]
The User ID option sets up the user entry security scheme for the entire Sales Ally application. Use this option to Add, Delete and Configure the access rights of users in a multi-user installation.  Sales Ally can restrict users from entering certain areas of the program, limit access to data, and control which fields in contact records a user can change.  In a single user installation, the User ID system controls password access to important areas of Sales Ally.

The User ID dialog serves two purposes: 

1. Select a User ID in order to loginxe "Login" to Sales Ally.  When you begin a session with Sales Ally, you must select a User ID.  In single user installations, you should enable the User Preference Automatic login as MGR to avoid this step.  Furthermore, you may have to enter a password to continue.  In the network version of Sales Ally you may at any time login as another user by choosing a different User ID on the Edit menu.

2. Create User ID's, assign passwords, Account rep. Numbers, and assign Rights.  In a network installation, the system administrator will want to control each user's access to information and various features of the program.

User IDs and Passwordsxe "Passwords"
A User ID is used to identify the person using the software.  Each marked note, marked letter and scheduled activity is associated with a particular user.  A User ID has an associated user name and optional password.  A User ID also has associated rights, which determine the scope of operations the user can perform.  Single user installations of Sales Ally assume a User ID of "MGR" with all rights enabled.  In network installations, the system administrator will create a User ID for each user and assign rights as required.

Conflicts can occur if you share a User ID with another person.  Individual user preferences, data sources, marked notes, marked letters, scheduled activities, tallies, and histories are associated with each User ID.


[image: image95.wmf]
The network administrator will assign a User ID to each user, which is a code of up to 5 characters such as the initials of the user or the user's account rep. number.  Every User ID has an associated name, the person's name.  If the network administrator has selected Enable Passwords in User Preferences and entered a password for a user, the person must type in the password to complete the login process.  Use the Add button to create a new User ID or the Edit button to change a person's name or password.
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Figure 76 - User ID Dialog

Adding Usersxe "Add:Users"

xe "User:Add"
If you have sufficient access rights, you can Add a User ID.  To add a User ID, click on the Add button.  You can enter the new user’s ID, name, and password. Click on OK to add the User ID to the system.
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Figure 77 - Edit User dialog

Editing Usersxe "Edit:Users"

xe "User:Edit"
If you have sufficient access rights, you can edit the Name or Password associated with a User ID.  You cannot change the User ID.

Deleting Usersxe "Delete:Users"

xe "User:Delete"
If you have deletion rights, you can delete users from the system.  To delete a user, highlight the user’s name and click on the Delete button in the User ID dialog.  You will be asked to confirm the deletion.  If you confirm the deletion, the User ID will be removed from the system.  You cannot delete user MGR.

Configuring Usersxe "Configuring Users"

xe "User:Configure"
The Configure dialog is accessed via the Configure button.  You must have the Configure right requires to enter this sensitive area.  The Configure User dialog is used to assign Account rep. Numbers and a Privilege Level to each user.  

Account rep. Numbersxe "Rep Numbers:Configuring Users"
You can assign one or more Account rep. Numbersxe "Rep Numbers" or User IDs to each user, and thereby control access to contact records.  A user can only access a contact record that has one of these Account rep. Numbers in the Owner field of the contact record.  However, any user can view a contact record with a blank Owner field.

Access to Infoxe "Access to Info:Configuring Users"
System administrators can allow users access to Lists, Activities, History, and Marked Letters associated with other users.  If you do not want the user to see this type of information belonging to others, make sure All Users is not checked and no items are selected in the Users list box.  To permit the user access to others' information, explicitly select their user ids in the Users list box or check All Users.  If you do not check All Users, you can select at least five users.
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Figure 78 - Configure User Dialog

Assigning Account rep. Numbersxe "Assigning Rep Numbers"

xe "Rep Numbers:Assigning"
Sales Ally supports multiple account rep. numbers for each user and allows more than one user to share an account rep. number.  By assigning more than one account rep. number to a given User ID, you provide access to the contact and activity records associated with each of the account rep. numbers.  Assigning multiple account rep. numbers allows you to setup a User ID for a sales assistant that supports multiple account reps or a manager that supervises multiple account reps. This permits the user to see the records and activities for all account reps. they support or supervise.  

Before you can assign an account rep. number, you must first create it by clicking on the Add Account rep. button.  You can then enter an account rep. number.  As you add account rep. numbers, they appear in the list of available account rep. numbers in the Configure User dialog and will be selected (highlighted) for the current user.  To assign account rep. number(s) to another user, click OK to return to the User ID dialog.  Select a different User ID, click on the Configure User button to bring up the Configure User dialog.  While holding down the Ctrl key, click on as many of the account rep. numbers in the scroll box as are applicable to the selected user.  You may also add additional account rep. numbers.

Note:  The list box in the Configure dialog supports multiple selections.  Hold down the CTRL key while selecting entries with the mouse.  You can also drag the mouse (while depressing the CTRL key) to select a group of adjacent entries.

Privilege Levelsxe "Privilege Level"

xe "Level:Priviledge"
You should assign each user a Privilege Levelxe "Privilege Level:Rights", which is a set of rights to enter specified areas of the program and perform selected operations.  For example, you can control who can change User ID information, who can change certain fields in contact records, who can view the posting book, etc.  Initially there is one Privilege Level, Level 3, which has all rights permanently enabled and is always associated with user MGR.  You may define other Levels with any combination of rights, and you give each new Level any name you wish (e.g., Account rep., Sales Assistant, System Administrator).  To assign or change the rights comprising a Level, choose the Edit Levels button in the Configure dialog.  You can assign a given Privilege Level to many users.

[image: image99.png]Secuty Level

Cancel

&

Help

AddLevel

=
L |
[
[





Figure 79 - Edit Security Level Dialog


[image: image100.wmf]
To enable a right you must highlight it (see the note below).  The manager of a network installation will want to ensure that normal users cannot change sensitive information or perform system level operations.  For example, the manager may create a Privilege Level called "Assistant" with all rights enabled except the following.

· Delete Data Source

· Maintenance

· User ID operations (Add, Edit, Delete, and Configure operations)

· User Preferences (Interests, User Fields, and Login settings)

The easiest way to do this is to hold down the Ctrl key on the keyboard and drag down across all rights to highlight every one.  Use the scroll bar to locate each item you wish to disable.  Then, while holding down the Ctrl key, click on the item to deselect it.

Note: The list box in the Edit Security Levels dialog supports multiple selections.  Hold down the CTRL key while selecting entries with the mouse.  You can also drag the mouse (while depressing the CTRL key) to select a group of adjacent entries.

Contact Edit rights affect which fields a user can change in an existing contact record.  While adding a new contact, a user can enter information into any field, including notes and transactions, regardless of whatever edit rights have been assigned.  In some cases a single right controls a group of fields:

· Name controls all parts of the contact name, 2nd Name, and NickName.

· Address controls Company, Address, City, State, Zip, Country, and Carrier Route.

· Phone controls all phone and phone extension fields.

· Comments controls Comments, Flags, Interests, and Secondary Record.

History and Schedule rights pertain to the Calls Actions Calendar.  View other users allows the operator to examine another user's history or schedule of pending activities.  

Entries in the rights list preceding a colon ":" are simply headings for the indented topics listed underneath.  These headings, such as Securities:, User ID:, and User Preferences: are not valid rights.  Thus, selecting them has no effect on the behavior of Sales Ally.

Once you have created the desired Privilege Levels, their names will appear in the scroll box at the bottom of the Configure User dialog.  To assign a particular user a specific Privilege Level, simply click on the Level’s descriptive name.

6.7  User Preferencesxe "User Preferences"

xe "Preferences:User"

xe "Setup:User Preferences"
The User Preference dialog is accessed from the Edit menu.  With it, you can select or configure many of the features of Sales Ally to your liking.
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Figure 80 - User Preferences Dialog

Most user preferences are stored with their associated User ID; therefore it is possible for each user to specify a unique configuration.  However, all users share only one set of definitions for Interests, User Fields, and Login settings.  Each configuration option has a default value or setting established when you installed Sales Ally.  In most cases, you will not need to change these defaults.  However, there are no default settings for the User Fields and Interests, thus you must define the conceptual meanings and descriptive titles for them.

Contact Preferences

If you check Enable Exact Findxe "Enable Exact Find", You will be activating the Sales Ally Rapid find mechanism. If you enter an exact value in the Last Name, Account, or Owner fields, you will find a contact or contacts much more rapidly.  You will only find those names that exactly match your search criteria.  For example, if you are searching for everyone in your data base with the last name of Green, the search will not return contacts with the last name of Greenly.  

If you check Automatic Savexe "Automatic Save", Sales Ally will save the contact records automatically when you leave the contact screen.  If this is unchecked, you will be asked if you would like to save the contact.xe "Database Preferences"

xe "User Preferences:Database"
When checking Display find Contact List, a list of all contacts meeting the search criteria will be displayed adjacent to the Contact window.
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Figure 81 - Contact Record with Contact List

If you check Allow Account # changes, an existing Account number can be changed.  If this is disabled (unchecked), you cannot edit account numbers in the contact records.  Even when disabled, an Account number can be inserted if no account number exists in the record.  You must have the Login right to change this setting and it affects all users.

Envelopes/Labels Preferencesxe "Envelopes/Labels:Preferences"

xe "User Preferences:Envelopes/Labels"
When printing envelops or mailing labels, you can control the content of the address information.  Check Include Second Name to include the 2nd Name field on the contact record.  Check Include Company to include the Company name on the contact record. Check Include Comma after City to insert a comma (,) after the City and before the State on the last address line.

Directory Preferencesxe "Directory Preferences"

xe "User Preferences:Directories"
Specify the Data directory where you normally create new data sources and the Letters directory where you normally store letters for the Letter Writer.  Click on Data or Letters to select a directory.

Login Preferences 


[image: image103.wmf]
If you have installed single user Sales Ally, you probably do not wish to bother logging in as MGR every time you begin a session with Sales Ally.  By default, the Automatic login as MGR option is enabled.  Network administrators will want to turn off this option and not give other users the Login right to turn it on. 

The other Login option, Enable passwordsxe "Enable passwords"

xe "Passwords:Enable", turns on the password system when checked.  You should enter passwords through the User ID dialog. You must have the Login right to change this setting.

These settings affect all workstations on a network.

View Preferencesxe "User Preferences:View"
You can control several features of the Sales Ally display.  The Status Barxe "Status Bar" lists your total number of Contacts and Calls for the day, the current date and time, and your User ID.  The left portion of the status bar displays help messages about highlighted menu choices, buttons or other options.  You can hide the Status bar by un-checking this option in the User Preference dialog.  This will provide one additional line for the main Sales Ally display area. Un-checking the Toolbarxe "Toolbar" check box removes the toolbar from the Sales Ally display, freeing up an additional line in the main window.  Please note that removing the toolbar from the display does not alter its contents.  The toolbar layout is controlled by the Toolbar setup button.

You can choose between Normal or Large toolbar buttons. The large icons [image: image104.png]


 are twice the size of the normal icons 
[image: image105.png]


 (actual sizes) shown here.

Please Note:

· When creating a Normal toolbar you can choose from 62 available icons, whereas you are limited to 31 available icons for the large icon toolbar.  The large toolbar icons are a subset of the normal icons, not different.

· If you select the Large toolbar option in User Preferences before creating a toolbar, you can later select the Normal toolbar without changing the toolbar contents.  However, if you create a normal toolbar and switch to large format, you may see some blank buttons.  This is because you only have half of the toolbar selections when choosing the large toolbar selection.

Toolbar Setupxe "Toolbar:Setup"
The Toolbar button activates the Toolbar setup dialog. With this dialog, you can create your own toolbar of selected icons.  The dialog consists of three scroll boxes. The top scroll box contains your current selection of buttons. The bottom two boxes contain the inventory of available button icons and list of actions.  You can associate an action with an icon by first clicking on the icon on the Available Buttons list and then click on the action you wish to assign to it.  To add the new icon to your toolbar, click and hold the left mouse button on the icon in the Available Button list, drag it to the Your Toolbar list, and release the mouse button.   You may add as many icon buttons as you wish up to 64 or limited by your ability to remember their meaning.  To remove a button from your list, click on it.  To reset the default meaning associated with each icon, click on the Reset button.  The toolbar appears as a single line under the main Sales Ally menu.
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Figure 82 - Toolbar Setup Dialog

Alert Preferencesxe "Alert Preferences"

xe "User Preferences:Alert"
You have two options relating to the alert system.  Periodically, BA checks the database to see if you have any current alert events.  You can set the elapsed time between checks by changing Cycle Minutesxe "Cycle Minutes".  An interval of 5 minutes or more will prevent too many notifications from intruding on your work.  Check Multimedia Soundxe "Multimedia Sound" if you have a multimedia sound board and want to hear something more interesting than a beep when the alert notification dialog appears. 

Database Preferences

If you check Direct File Accessxe "Direct File Access", BA builds a list must faster by circumventing ODBC.  Furthermore, Maintenance will compress files in addition to rebuilding index files.  This option only applies to dBASE data sources.  In a network environment, only one user at a time can create a list when Direct File Access is selected.  

Check Ignore No Mailxe "Ignore No Mail"

xe "No Mail:Ignore" to include all records when printing labels or mail merge letters.  The No Mail check box is ignored in contact records.

Check Docking Station to allow you to download from the Main data source on the file server to your PC.  You can then work with your data when disconnected from the network.  Later, you can upload changes to the file server.  See Docking Transfer page 62.

Check All Data Source/Export/Import Rights if all users in a network situation are able to use all data source types when creating new data sources, exporting, and importing. This function will override the New Data Source/Import/Export privilege level restrictions found in User ID, Configure User, but does not change New Data Source, Import, or Export rights.  The default for this option is always on, or checked.  You must have the Login right to change this setting.

Activity Calendar Preferences

The Resolution selection will change the time slot size for the Activities Calendar and Contact's Agenda.  You can choose between 10, 15, 20, 30, 60, 120 minutes.  This selection will show you more or less information in the Daily and Weekly views of the Activities Calendar.

Startup Preferences

When you run Sales Ally, you can choose one of the following initial views in which Sales Ally will startup:

· Choose Find Contact to display the Find Contact window automatically when you first enter Sales Ally.
· Choose Show last contact to display the last contact you were working on during the previous session.  For example, if you exited Sales Ally yesterday with the record of John Smith open, when you start the Sales Ally program today, you will again be presented with the contact record of John Smith.

· Choose Activities Calendar to display the Activities Calendar window automatically when you first enter Sales Ally.  The Activities Calendar will be presented using the same format selected in the previous session. For example, if you last used the Activities Calendar in the Summary view, when you start the Sales Ally program today, you will be presented with the Activities Calendar open in the Summary view.

Quick Add Preferencesxe "Quick Add Preferences"

xe "User Preferences:Quick Add"
Quick Add setup allows you to specify some of the contact fields you want Sales Ally to insert for you every time you create a new contact using Quick Add Contact or ASCII Import.

If you check Use Defaults for Add Contact, the default data applies to the  Add Contact function as well as Quick Add Contact.  You can modify the information as you wish before saving the contact.
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Figure 83 - Quick Add Preference

When performing an ASCII import, each default data field is copied to the contact record after the record is created.  A default data field is not copied if the target field already contains information.  However, Interests, Flags, and Comments will be merged with existing information.

Calculator Preferencexe "Calculator Preference"

xe "Calculator:Setup"

xe "User Preferences:Calculator"
The Calculator button brings up the Calculator program selector. The selected program will run each time you select the Calculator option from the Tools menu, press Ctrl-L, or click on an assigned button on your toolbar.  The calculator selection option allows you to select a program other than the Windows calculator, such as your favorite bond calculator.  You can even use the Calculator program selector to start any appropriate Windows program via the Calculator option.  For example, you could select CHARMAP.EXE to bring up the character map insertion program.  
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Figure 84 - Calculator Selection Dialog

E-mailxe "E-mail"

xe "E-mail:User Preferences" Preference

Enter the full path name for the e-mail application of your choice.  You may click the Browse button to look up the application or select one of the suggestions in the combo box.

Please Note: When the directory path contains a "long name" allowed in Windows 95 and Windows NT, you should click the Browse button to convert it to a DOS directory path.  Press OK to accept the DOS representation.  Before saving an entry containing long directory names, BA will automatically pop up the Browse dialog.

Interests Setupxe "Interests:Setup"

[image: image109.wmf]
The Interests button brings up the Interests dialog. This dialog allows you to assign the conceptual meaning and text description to each of the 28 Interest check boxes associated with a contact.  The descriptions that you assign will appear on the Interests page of the Contact view.  These settings apply to all Sales Ally data sources and all users of Sales Ally.
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Figure 85 - Interests Dialog

In network installations, each Interest label applies to all users unless you check the Local Definition box.  A local definition is used only on your PC.  The system administrator can restrict access to some or all Interest labels in the setup dialog by selectively assigning Interest setup rights.

User Fields Setupxe "User Fields:Setup"

[image: image111.wmf]
The User Fields button brings up the User Fields setup dialog.  This dialog allows you to specify the name and type of each of the 3 pages of sixteen, for a total of 48, user definable fields.  The name will appear on the User Fields page of the Contact view.  The type will be used to validate any data entered by insuring that it conforms to the specified data type, i.e., date fields must contain valid dates and numeric fields must contain only numbers.  Furthermore, each User Field has a Remembered Response check box.  If you choose to save the history of responses for a field, check the Remem Resp check box.  Remembered Responses allow you to choose a previous entry rather than manually enter one for a given field.  These settings apply to all Sales Ally data sources and all users of Sales Ally.
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Figure 86 - User Fields Dialog

In network installations, each User Field definition applies to all users unless you check the Local Definition box.  A local definition will be used only on your PC.  The system administrator can restrict access to some or all User Fields in the setup dialog by selectively assigning User Field setup rights.

User Infoxe "User Info:User Preferences" Setup

This dialog allows you to setup information to be automatically inserted into a letter created by the Letter Writer.  You can use these fields for any personal information you wish.  The following User merge fields in the Letter Writer utilize these data:

	Merge Field
	Description

	Name
	Your Name, Title, or Assistance’s Name

	Company
	Your Company

	Address1
	Your Address 1

	Address2
	Your Address 2

	Address3
	Your Address 3

	Phone
	Your Phone Numbers

	e-mail
	Your e-mail address

	FI Name
	Name of your financial institution

	FI Branch
	Name of the branch of your financial institution

	FI Type
	Financial institution type - Bank, Credit Union, etc.

	FI Officer
	Name of branch manager

	Customer Type
	Target market (“Valued Customer”, “Valued Client”)

	Misc1
	(unspecified)

	Misc2
	(unspecified)

	Information
	Personal statement or corporate objectives

	Disclaimer
	Disclaimer message (variable length)


These merge fields are called 'ghost' fields because they will vanish if no data are available when the letter is printed from the Letter Writer.  A ghost field and, more importantly, the line it occupies will disappear in the absence of data to fill it.  However, if any other text or merge fields share a line with a ghost field, an empty space will replace the field and the line will remain in the letter.

Information and Disclaimer


You may enter a line, paragraph, or several paragraphs.  There is no practical limit to the amount of text you may insert into this multi-line edit box.  When either merge field is printed, it will be formatted exactly as you see it here and will always appear left justified in the letter. 

Weekly History Reportxe "Standard Reports:Weekly History Report" Goals

The Weekly History Report displays the number of scheduled and completed activities for the previous week.  It also displays goals that you enter in this dialog.  To enter goals for an activity type, highlight the type in the list box and enter the values in the Goal edit boxes. These Goals are utilized when printing the Weekly History Report. 
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Figure 87 - User Info setup dialog

Before you first use your modem to dial a telephone number you must perform a few simple steps.  Exit Sales Ally and select the Control Panel from the Main group in the Windows Program Manager.  Double click on the Telephony icon and click on the Driver Setup button.  Make sure the ‘AT Command Set...’ is highlighted and click on Setup.  Choose the correct Communications Port for your modem.  A Speed (DTE Rate) of 2400 is satisfactory for dialing phone numbers.  Ignore the other setup entry fields.  Click on OK to exit this dialog and click on Close to exit the other dialogs.

The Modem buttons allow you to access the Telephone Dialer control system (also accessible via the Telephony icon on the Control Panel).  You can access either the Location dialog, used to define the access numbers and area code prefixes for different calling locations, or the Calling Card dialog, used to select a preferred calling card and specify your account number.  These options give you great flexibility and control over how your phone dialer operates.  

Location Dialog

The location dialog (Figure 4) allows you to define dialing prefixes for local and long distance calls for a number of different calling locations.  If you are using a portable computer or operate over a wide area network, you will want to establish location setups for each calling location.  The Local and Long Distance access prefixes are used to make local and long distance calls as determined by comparing the area code of the number to be called with the area code of the current location.  You can fine tune the prefixes for toll calling within your area code via the Toll List option.  If you make international calls, you can also set the Country code.  

[image: image114]
Figure 4 - Modem Location Dialog

Calling Cardxe "Calling Card" Dialog

You can use the Calling Card dialog (Figure 5) to select your calling card from amongst the common calling cards or to add a new one.  The Calling Card name determines how Sales Ally for Windows accesses the specified calling card service.  For example, the AT&T Direct Dial is accessed by dialing 1-0-ATT-1.  You must also enter your specific calling card account number in the Card Number field.  If you edit an existing account code, it is displayed as a series of ####### to prevent unauthorized users from determining your account code.  See Figure 5.  

[image: image115]
Figure 5 - Calling Card Dialog

When using a calling card to make a long distance call, Sales Ally for Windows inserts the calling card access number followed by your account number between the Long Distance access number and the area code of the number to be dialed.  For example suppose that you have specified that to make a long distance call your company’s switch board requires that you dial a 9.  You want to use the AT&T direct dial calling card and your account number is 123-456-7890-4321.  Finally, the number you wish to call is 617-555-1212.  Sales Ally for Windows will assemble all these numbers as follows:


9-1-0-ATT-1-123-456-7890-4321-617-555-1212
Chapter 7    View Menu
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Figure 88 - View Menu XE "Figure 88 - View Menu" 
This Chapter describes the View menuxe "View:Menu"

xe "Menu:View"; the core of the program which enables you to find or add new lead XE "Lead" s, prospects or clients. Here you also view the Activities Calendar, or any of the Campaign lists to manage your sales activities.  Your core Activities appointment calendar provides you with detailed daily, weekly and monthly views, or a chronological summary of events to which you must attend. To view specialized campaign Call Lists, Action Lists, Group Lists, and Maturity Lists you select Campaigns. You can also view and print Reports from the View menu.

For campaign purposes, when you wish to contact a group of people with a similar profile, you should create a Group list.  In this process you will specify the characteristics of the contacts that you want to include in a group and Sales Ally will create a list of these contacts.  You might use the Group list to create and follow up a mailing to people holding a specific security within a specific state.  When you want to create a campaign to contact people holding securities that will mature within a certain range of dates, you should use the Maturity List.

Managing activities comprises a great portion of an investment advisor’s workday.  Effectively handling calls, actions, group and maturity related activities with Sales Ally would vastly increase your production.

7.1  Find Contact xe "Find:Contact"

xe "View:Find Contact"
In keeping with the user manual organizational scheme of discussing each menu option as it appears in the View menu, we will discuss finding a contact before we discuss adding a contact.  However, you can’t find a contact before you have added one.  Furthermore, we have reserved the detailed discussion of each of the contact pages and fields for the next user manual section.  You may wish to read the Add Contact section below if you are not already familiar with the Contact window and sub-pages of data.
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Figure 89 - Find Contact Window

The Find Contact window is used to locate specific contact records and contains the same pages and field layout as the Add Contact window.  Once you have found a single contact or group of contacts that match your search criteria, you can view or edit these contact records.  The basic strategy for using the Find Contact option is to first open the Find Contact window then enter whatever criteria you wish to use to find a particular contact into the specific field. To find a contact or group of contacts, enter profile information in one or more fields and press the Find button.  Sales Ally retrieves the "set" of records fitting the profile, which may only be one record, and then you may use the browse arrow buttons to move back and forth from one contact to the next if the set is greater than one.  For example, to view all contacts having a last name starting with A, enter A in the Last Name field.  This is called Query By Example (QBE).  If you know only the last name of an individual, you would enter it into the Last Name field of the Address page.  Click on Find and the system will find all contacts with that last name.  If you want to further refine the Find operation, you could enter more details.  For example, if you knew the individual’s first name or company name or even his city or state, you could reduce the list of matching records.  You can use any field in Sales Ally to search the database.  If you know of a phone number of an individual, you can type the phone number into the Work, Home, Alt Phone or Fax field and press the Find button.  This will return the contact record that matches the Phone number. 
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Figure 90 - Find Contact by Phone Number

You can also use Flags, Interests, and User Fields to pull up contacts from the database.  Each of these is found on its associated page, accessed by clicking on the button at the bottom of the Find Contact window.  For example, if you defined one of the User Fields as ‘Spouse’s First Name’ and you remembered only your prospect’s first name and that of his wife, you could specify the first name field on the Address page and the Spouse field on the User Fields page, finding all couples with the matching first names.  Likewise, you could specify a particular Flag or Interest to select contacts.  

When entering data into Find Contact fields, you need to know how Sales Ally uses this information to search the database.  By default, Sales Ally assumes that you want to match the text of each field you have entered.  This is called pattern matchingxe "Pattern Matching".  An important feature of pattern matching is that you do not have to enter the complete text to get a match.  Sales Ally will match as many characters as you enter.  For example, if you enter ‘Sm’ in the last name field, Sales Ally will return all contacts with a last name starting with ‘Sm’.  This obviously would include Smith and Smyth as well as Small.  It would not include anyone with the last name of Protoplasm.  Note that Sales Ally is not case sensitive when matching patterns.

Once you have found one or more records, Sales Ally displays the results in a contact view window described below.  In general, you will use the Find Contact window frequently to find a particular client or prospect, or to create a list of clients or prospects having common features.  Once you have found your desired contacts, you can view, edit, and browse among them.  Next to the contact window you will see a Contact List displaying all the contact names meeting your search criteria.  You can use this contact list to scroll through and zoom to another contact that appears on your list. 
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Figure 91 - Contact record with Contact List to the Right

Rapid Findxe "Rapid Find"

xe "Find:Contact:Rapid Find"
If you enter an exact value in the Last Name, Account, or Owner fields, you will find a contact or contacts much more rapidly.  For example, if you are looking for contacts named Smith, enter ‘Smith’ (not ‘SMITH’) in the Last Name field of the find contact window.  You must enter the name exactly as it appears in the database (same characters and same case) in order to take advantage of the rapid find technology, then press the Enter key or click on find.  Sales Ally automatically capitalizes the first character for you.  The Account and Owner fields also support rapid find if you enter an exact account number or exact Account rep. Number.  These three fields use a database index, but the rapid find process only works when your entry exactly matches the information in the database. 

7.2  Add Contactxe "Add:Contact" xe "Contact:Add"

xe "View:Add Contact"
Sales Ally displays the New Contact view when you select View, Add Contact from the menu. The New Contact view consists of five separate pages accessed by clicking the left mouse button on the associated button at the bottom of the view.  The left most button (and initially foremost screen) is called the Address Page and is displayed above.  As the name implies, this screen contains the basic client information including address.  Additional information such as account number, telephone numbers, status, rating, and comments are entered here as well.  The other pages include Notes, Flags & Interests, User Fields, and Book pages.  You cannot use the Notes and Book pages until you have entered the basic contact information in the other three pages and clicked on Add.

Data Source

On the far right of each page is a list box showing available Sales Ally Data Sources, and the one that is highlighted is the currently selected database.  You can change the selection of data source simply by clicking on and highlighting your choice.  

Note:  You must select a Data Source before you click on the Add button.  The first data source is selected by default.  Advanced users might create other data sources.

Below the Data Source box are several control buttons.  Click on Add to save a new record or click on Cancel to abandon it.

Address Pagexe "Contact View:Address Page"

xe "Address Page:Contact View"
To enter a new contact, select View Add Contact, and enter the contact’s data into the fields of the empty Address page.  At a minimum, you should probably enter a Last Name, although Sales Ally will accept a record if you enter something in only one field.  The Address page of the contact view displays its data in two logical areas - the address on the left and description data on the right with the name running across the top.  While you are looking at the name field, note that it is broken into six separate sub-fields corresponding to two Salutations (e.g., Mr. & Mrs.), First Name, Middle Initial, Last Name and Suffix (e.g., Jr.).  You can enter a second name or title on the next line followed by a company name and two lines of street address.  City, State, and Zip code are broken out into individual fields.  This allows the program to sort and select data based on any one of these fields.  For this to work, you must not enter the city, state and Zip code on the second line of the street address.  If you only need one line for the street address, place it on the first of the two lines and leave the second line blank.  A blank line will be ignored when printing labels and envelopes.  You can also enter a country for an international address and a carrier route code for bulk rate mailing.  While most individuals don’t know their own carrier route code let alone the codes of their clients, it is possible to have the U.S. Postal Servicexe "Postal Service, U.S." update your addresses at no cost, adding the specific carrier route codexe "Carrier Route" to each address.  Finally, the Address page accepts up to four telephone numbers - a work number, a home number, an alternate number, and a fax number.  
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Figure 92 - Add Contact

Account Number

You can enter several fields of descriptive information on the Address page.  The first and most logical is the Account numberxe "Account:Number".  This field can be used to link the Contact record to other parts of the Sales Ally system such as the Sales and download systems.  The Account number is a free form alphanumeric field that will accept virtually any form of identifier up to 16 characters in length.

Owner


[image: image121.wmf]
The Ownerxe "Owner" field, designed for tracking what advisor is assigned to specific clients, is used in network installations to restrict a user’s access to certain contact records.  If you put a account rep. number or User ID into this field, only the users who are assigned this account rep. number can access this record.  The system administrator assigns Account rep. Numbers to each user via the User ID dialog on the Edit menu.

Last Contact

The Last Contactxe "Last Contact" field contains the date when you last contacted this individual.  Sales Ally will update it automatically each time you contact an individual using the Dialer.  You can use this date to select individuals for follow up.

Rating

You can use the Rating fieldxe "Rating " to specify a quantitative (i.e., 1-10) or a qualitative (e.g., cold, warm, hot) sales pipeline rating or funnel position for each prospect and client.  The key is to establish a rating system that is meaningful to your business before you enter large quantities of data, and then rigorously stick to your rating system.  Your ability to select individuals for a specific letter or other activity will be dependent on the consistency of your ratings.  The Rating field will remember and store previously used responses thus helping you to use a consistent rating scale.  See Remembered Responses on page 92.

Status

The status field defines where this person fits within your database management system. Typically, you will use entries such as ‘Lead’, ‘Prospect XE "Prospect" ’, or ‘Client’ to characterize the status of the person in the traditional 3-step customer relationship hierarchy.  A lead is a person about which you may only have a name and phone number, while a prospect is a qualified, profiled lead and you have entered a large quantity of specificity about their investment objectives and risk tolerance. Then, a prospect that opens and account becomes a client. Your ability to select individuals to receive a specific letter or to be the correct target of a campaign activity will be dependent on the consistency of your status assignments.  The Statusxe "Status" field will remember and display previous responses you’ve used in this field in order to help you use consistent names.  See Remembered Responses on page 92. You might consider creating a status called “Other” to list friends, vendors, and such.

Comments

Use the Commentsxe "Comments" area to store brief and relatively static information about the contact, e.g., small talk topics, name recognition aids, family history and so on.  In contrast to the Comments field, you will use Notes pages to save a summary of each conversation with the contact with a date and time stamp, and you will use Interests field, not the Comments field, to detail their investment objectives.

No Mail

One of the last fields on the Contact page is a check box for No Mailxe "No Mail".  You can use this field to specify which clients or prospects should not receive mail.  You may want to use it simply to designate those clients who have requested that they not receive prospecting mail or to prevent multiple mailing to clients with multiple recipients such as a husband and wife with separate accounts.  As a check box, it works as a simple yes or no toggle - either the account gets mail or it does not.  You can, of course, ignore the setting for a particular mailing by selecting Ignore No Mail in User Preferences.

Specifically, if you check No Mail, it will prevent letters from being printed for the designated contacts when you do a merge print operation with the Letter Writer.  It will prevent mailing labels from being printed for designated contacts when you print the Address Labels report.  It has no effect on Marked Letters, Marked Notes, or any other report.

No Call

Due to some recent telephone laws, we have added a new field in the contact records titled No Call. You can use this field to specify which clients or prospects should not receive phone calls.  You may want to use it simply to designate those clients who have requested that they not receive prospecting calls.  As a check box, it works as a simple yes or no toggle - either the account receives calls or it does not.

Remembered Responsesxe "Remembered Responses"
The remembered responses function acts as a memory of data entry, stores it, and presents it to you later if you wish to use it again. Fields such as Salutation, State, Status and Rating are able to remember previous responses and allow you to select an item from an attached list rather than enter it manually.  The remembered response list appears when you double click in the field edit box. Simply double click on a field, right mouse click or press Ctrl-R.  When the remembered response list appears, double click on the desired entry in the remembered response list to place the entry into the field.  

To add an item to the remembered response list, type the entry while the response list is visible.  When you move the cursor to another field, the entry will be added to the list before the list window closes.  Or you can type an entry, open the list window, and move to another field.
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Figure 93 - Remembered Responses

Remembered responses for Comments, Flags and Notes work differently.  Responses are not saved automatically and the pick list does not appear until you double click in the edit box.  After you call up the response window, you may use the Add button to enter a response into the list.  To copy a response from the list, highlight an entry and click on the Paste button.  Paste inserts the chosen response at the cursor location in the edit box and does not replace existing information. 

Notes Pagexe "Notes Page:Contact View"

xe "Contact View:Notes Page"
The Notes page is where you enter dynamic text information about the contact, typically notes of conversations.  Each note is time and date stamped with the current system time and date, and the sequence of notes for a particular client or prospect shows the history of your dealings with that individual.  The time and date stamp is automatic when pressing the New button. You can use the Notes page to enter summaries of phone calls or meetings with your client or prospect.  You can even create and print a short business letter called a Quick Letter that is stored along with your other notes.

Unlike the Comments field, the text for which remains constant, Notes for a contact generally accumulate over time unless you delete a note that is no longer relevant.  The Notes page uses a simple text editor and provides automatic word wrapping.  You can use the Cut and Paste commands from the Edit menu or Drag and Drop, but you do not have access to the word processing features of the Letter Writer. 

When entering a new contact you cannot go to the Notes page until you click the New button.  You can then click the Notes button to enter notes.
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Figure 94 - Notes page for capturing conversations and information

You can accumulate an unlimited number of notes for each contact.  Each note is automatically stamped with the date and time it was created, and it is labeled with your User ID as originator of the note.  To segregate one note from all the rest, and to enable you to quickly print a fulfillment mailing label, you can “mark” a note for printing using either the Marked Notes report or the Marked Notes labels report.  When the Notes page is opened, you will see the most recent note (if one exists), otherwise the notepad is ready to accept a new note.  Use the scroll bar on the right to browse among the notes.

To remove all changes to a note since you last saved it, select Undo on the Edit menu.  If you have marked a note or changed its date, Sales Ally also resets these changes.  
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A note is automatically saved when you leave the Notes page or browse to another note.  You do not need to click the Save button.

Buttons

New

Click the Add button to clear the note display area and prepare to enter a new note.

Quick Ltr
Click on the Quick Ltr button to select a Quick Letter template for creating a brief letter that is saved in the notepad for future reference.  After editing the letter, you can print it by selecting Print Quick Letter on the Contact menu.  See Quick Letter below.

Mark/Unmark

Click the Mark button to mark a note (see Marked Notes below).  You can print Notes that are marked with your User ID via reports.  The Mark Note dialog also allows you to mark the note for another user.  When the current note is already marked this button is labeled ‘Unmark’.  To remove a mark on a note simply click the Unmark button.

Review

Click on Review to display all notes for the contact simultaneously.  This is a read-only presentation, meaning you cannot make any changes.  Click on Review again to return to the normal view/edit mode for individual notes. 

Delete

Click the Delete button to erase a note.

Change Date

Click the Change Date button to modify the date/time stamp for the note.

Spell Check

Click the Spell Check button to check the spelling for your note or quick letter.

Notes Categorization
Added ability to organize the notes based on their content in categories such as: contact, compliance, personal, investment, operation, and others in order to improve understanding.

Notes Access Control

Added ability to set control of access to notes such as private, semi-private, public access.

Notes Expiration and Printing Dates

Allows the user to set a date that a note and action expires or is printed.
Marked Notes

Marked Notesxe "Marked Notes" can be used to send additional information to customers with little effort by printing the marked notes report on dual label mailing label paper.  To create this fulfillment mailing label, simply type into the note a description of the material to be sent, then mark it for printing at a later time.  Then use the Mark button to bring up the Mark dialog.  Your User ID appears by default.  Click OK to mark the note. This action separates this note from all the others and makes it ready for printing the name and address label in correct format. To unmark a previously marked note, click Unmark.
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Figure 95 - Marked Notes

You can print the marked notes on label stock to produce a mailing label as well as a copy of the note.  See Marked Notes under Reports.  One label will contain the address while the adjacent label will contain as much of the note as will fit.  Once the labels have been printed, you can read the note to remind yourself about what needs to be mailed and then use the address label to address the envelope.  


[image: image126.wmf]
In network installations, you can even mark notes for other users.  This feature enables you to place the marked note in someone else’s marked note printing queue.

A marked note displays "Marked XXX" in the header, where XXX is the User ID of the person for whom the note is marked.  In network installations of Sales Ally, the User ID ensures that the note appears only in the Marked Notes report for the indicated user.  

Quick Letterxe "Quick Letter"
You can create a template (a formatted letter containing merge codes and text) for every situation where you want to send a simple, short business letter.   A template is merged with data on the Address Page to create the letter that is placed in the notes database.  You can edit the letter, then print it using Print Quick Letter on the Contact menu.  Quick Letters are stored with other notes allowing you to review them quickly.  However, you should use the Letter Writer for a longer or more polished appearing letter.

Select a template and click on Use (or double click on a template) to merge the template with the contact information and insert a Quick Letter into the notepad.  Click on New to create a new template or click on Edit to change a selected template.

Templates normally have a BAQ extension and are stored in the letters directory, which is specified in User Preferences.

Quick Letter Setup

In the Quick Letter dialog, click on New or Edit to go to Quick Letterxe "Quick Letter:Setup" Setup.  The large window on the left is a scrollable notepad where you enter the text and merge codes for the Quick Letter template.  You can compose a simple, generic letter.  Utilize merge codes wherever you want to insert specific contact information such as contact name, address, current date, and your name. 
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Figure 96 - Quick Letter setup dialog

A merge code can be entered manually or selected from the list box on the right.  Position the cursor in the template, double click on a merge code in the list box, and the merge code will be dropped into the template at the insertion point.  

You will select a template in the Quick Letter dialog to create a Quick Letterxe "Quick Letter:Merge Codes" for a specific contact.  If the contact record has no data corresponding to a merge code that stands alone on a line, the line will be deleted.

Merge Codes
{AC} - Account number.

{AD} - Address block.  This merge code will compose a multi-line address block composed of Address1, Address2, City, State, Zip, and Country.  It will create no empty lines and it should always be left justified.

{AP} - Alternate Phone number.

{AX} - Alternate phone Extension.

{CN} - Company Name.

{DT} - Current Date.

{FN} - Formal Name, such as "Mr. Jones".

{FP} - Fax Phone number.

{HP} - Home Phone number.

{LN} - Long Name, such as "Mr. and Mrs. John J. Jones, Jr."

{NN} - Nick Name.  If there is no entry for Nick Name in the contact record, {FN} will be used.

{SN} - Second Name.

{UN} - User's Name.  Your name; the name belonging to your login ID.  See Setup User IDs.  

{WP} - Work Phone number.

{WX} - Work phone Extension.
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When you change a template and click on Save As, you can save it under the same or new name.  To create a new template similar to an existing one, edit an existing template and enter a new name in the Save As dialog.
Printing a Quick Letter

The Printxe "Print:Quick Letter" Quick Letterxe "Quick Letter:Print" command is available on the Contact menu when you are viewing the notes page for a contact.  Use this command to send the currently displayed Quick Letter or note to the default Windows printer.   Sales Ally will reformat the Quick Letter to fit the dimensions of the print area on the page (which is normally much wider than the note edit box).

Before printing, you can select a different printer by clicking on the Printer button.  You may also select a different font or change the margins.  Since laser printers do not use the full width or height of the paper, a 1 inch margin setting produces an effective margin of about 1.25".

Flags and Interests Pagexe "Flags and Interests Page:Contact View"

xe "Contact View:Flags and Interests Page"
Flags and Interests are two types of data fields that can be used to characterize your client or prospect.  The key difference between them is that Interest fields must be pre-defined before they can be used while Flags are dynamic, allowing you to create new flags on the fly.

Interests

Interestsxe "Interests" are general search criteria used to specify a person's investment interests.  For example, interests might be defined as Tax Free, Blue Chip, or High Growth.  You might also define interests as the types of product your contacts have expressed an interest in, such as Oil, Computer, Utility.  

Up to 28 interests can be assigned to each contact record.  To apply an interest to the current contact's record, simply click on the check box beside the appropriate interest.  If the interest no longer applies, simply click on the check box again and the check mark will disappear.  

To define your interest classifications, you need to use the User Preferences option from the Edit Menu and select the Interests button.  You can assign a name describing the meaning of each of the 28 interest classifications. 
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Figure 97 - Flags / Interest page
In network installations, each Interest label applies to all users unless you check the Local Definition box.  The system administrator can restrict access to some or all Interest labels in the setup dialog by not assigning Interest setup rights to other users.  The Interest definitions apply to all data sources, but every user can have a different set of definitions for those Interests that are defined locally.
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Figure 98 - Interests Setup dialog

The major benefit of the Interest system of classification is that they are easy to check on and off for a given client and they are very fast in selecting contacts for a list view or report.  Their limitation is that you can define only 28 interests and they must remain fixed to be consistent.

Warning:
If you re-define the meaning of an interest classification, all contacts assigned to the prior meaning will be assigned to the new meaning.  You must manually remove the check mark for an interest from all contacts assigned that interest to avoid assigning them to the new interest.

Flags

Flagsxe "Flags" are used to further characterize and profile a contact.  For example, a contact may have expressed an interest in particular products, and you might give them the following flags: TEXACO, INTEL, or PECO.  Using this flag or “handle” you could then select all contacts with an interest in Intel for a mailing a letter.

The number of flags you may enter per contact depends upon how many can fit in the 98 character storage string.  Each flag is stored with a separator character.  For example, 14 flags with an average length of 6 characters can be entered ((6 + 1) X 14 = 98).  You can store an unlimited number of flags per database.  Each flag should be placed on a separate line in the Flags edit scroll box.  If you have entered more flags than the Flags box can initially display, use the scroll bar to view the others.  

Please Note:  Wildcards are power tools in searching! When finding contacts or building lists, you can use “wildcardsxe "Wildcards"

xe "Campaign Lists:Wildcards"

xe "Find Contact:Wildcards"” in the search expression for Flags.  Underscore (_) is the single character wildcard while percent (%) is the string wildcard.  For example, to find all records containing the Flags IRA, IRB, IRC etc., but not the Flags containing IRAQ, IRAN, IRATE, etc., use the search expression “IR_”.  Sales Ally will look for all 3-character Flags beginning with IR.  If you use the search expression “IR%” you will find all Flags of which start with “IR”.

Unlike the Interests fields that must be pre-defined to be meaningful, Flags are dynamic and can be created on the fly.  However, to be useful, you must be consistent when entering them into your database.  Therefore, if you enter IBM for one client, you shouldn’t enter I.B.M. for another.  The system cannot see through the haze of periods to associate these individuals as having a common interest in IBM.  Use the remembered response capability of Flags to ensure uniformity.

Call Intervalxe "Call Interval"
The call interval is used to suggest a date for a new call activity after completing a call using the dialer.  For example, assume you have entered 30 into the Call Interval field.  After you use the dialing feature in Sales Ally and press the Contacted button, Sales Ally will open the scheduler for a new activity with a suggested date of 30 days from now.  You must use the Dialer and Contacted button to enable the Call Interval feature.  Of course, you can override the suggested date.

NickNamexe "NickName"
There is a NickName merge field in the Letter Writer and Quick Letter that uses whatever you type into this field.  

Sourcexe "Source"
The Source Typexe "Source Type" and Source fields allow you to save information about how the contact came to your attention.  You might use entries such as ”referral”, ”seminar”, or ”previously with” as your Source Type.  Since Source Type is a remembered response field, it makes it easy for you to be consistent with the names you use.  Type specific information into the Source field such as the name of the person who referred the contact, the particular seminar where you met the contact, or the name of the account rep. that previously handled this account.

Secondary Recordxe "Secondary Record"
If this record is a subsidiary account for the contact, you may wish to check the Secondary Record check box.

User Definable Fieldsxe "User Fields Page:Contact View"

xe "Contact View:User Fields Page"
The User Fields page contains 3 frame pages of 16 fields (a total of 48) that you can set up for your own special use.  Each field can contain up to 15 characters of text, a number, or a date.  You could create a field for spouse’s first name, secretary’s name, income, occupation, net worth, or number of children.  Once you create a User Field and use it for data entry, you should not change its definition.  

xe "Suitability"

xe "Client Suitability"Categorizing your clients and prospects involves defining their characteristics in such a way as to, at a later date, present them with products that are best suited to their needs.  Creating User Field definitions with labels such as Income, Net Worth, Objective, etc., will help you track and manage your clients so they receive the products most suitable to their specific needs.

To define one of the User Fields, select the User Fields button from the User Preferencesxe "User Preferences:User Fields" dialog.  Specify the descriptive name of the field, it’s type (text string, number, or date), and only check Remem Resp if you want all data entries to be remembered.  After you have defined a field, you can enter data into the field for new or existing contacts. 
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Figure 99 - User Field Setup dialog

In network installations, each User Field definition applies to all users unless you check the Local Definition box.  The system administrator can restrict access to some or all User Fields in the setup dialog by not assigning User Field setup rights to other users.  The definitions apply to all data sources, but every user can have a different set of definitions for those User Fields that are defined locally.  If you decide to change the meaning of a particular field, you must aware that changing the name only changes the label of the field, not its contents for each contact.  To really change its meaning, you will need to erase the prior contents of the field from each record before entering the new data.  

7.3  Quick Add Contactxe "Quick Add Contact"

xe "View:Quick Add Contact"
The Quick Add Contact function differs from the Add Contact function as follows:

1. You can pre-define the default entry for one or more of the contact fields.  This allows you to speed up data entry when you enter contacts with common features such as company, city, and state.

2. After you click the Add button, a new Add Contact window appears.  You proceed immediately to enter the next contact.  However, this means you cannot add notes or transactions for a contact before proceeding to add the next contact.

[image: image132.png]Default Contact Data

Intrests Flags |
[Arvutes = =
St E| = =
Bonds
oD Help
Fa | 2| T Use Defaulls for Add Contact
Comments:

Pt nomaton i these lields which you would e (o appear Qg
[sach te you add a record using the batch "quick add” pocess

Salutaton & N Stgtus:
Company: Rating

Ci:[Phiadelphia Lse [FA zef

1 F]

e Source Ty | Souce: |





Figure 100 - Quick Add defaults

When you obtain a list of prospects, they generally have one or more common features.  If you have defined a Flag or Interest representing this feature, you can preset it for Quick Add.  To set a particular value, you must first define it via the User Preferencesxe "User Preferences:Quick Add Defaults" Quick Add option on the Edit menu.  Once you have specified the defaults, you need only select the Quick Add Contact option from the View menu.  The new contact data will be pre-filled with the specified defaults.  You can change the default values for a particular entry if they don’t apply, or you can skip the defaults entirely by selecting Add Contact instead of Quick Add Contact.  This allows you to create a standard set of defaults and use or skip them at will.  If you want to alter the defaults for the Quick Add option, you must change them via User Preferences on the Edit menu.

7.4  Contact Menuxe "Contact Menu"

xe "Menu:Contact"
Once you have either added or found a contact record, the Contact option is added to the menu.  This menu offers options for Copying, Moving, Deleting, Dialing, Marking, Linking and Printing.  It is important to understand that the Contact menu options act on the currently displayed record and not the entire list of found or added records.  The specific options are as follows:
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Figure 101 - Contact Menu

Deletexe "Delete:Contact"

xe "Contact Menu:Delete"
The Delete command removes the displayed record from the current data source.  It removes all contact information, notes, transactions, activities, history, list entries, and marked letters.  This is a permanent deletion and there is no way to ‘undelete’ the contact.

Copyxe "Copy:Contact"

xe "Contact Menu:Copy"
Use the Copy option to create a new record utilizing most of the data in the current record as a starting point.  Sales Ally will insert the new record into the current database and copies over all visible information except for Open Date, Last Contact date, notes, transactions, scheduled activities, history, and marked letters.  The new record appears in a separate window and is linked to the current record because it is assumed they are associated with each other. 

Movexe "Move:Contact"

xe "Contact Menu:Move"
The Move command copies the current record to another data source and then deletes it from the current data source.  It copies all relevant data including notes, transactions, scheduled activities, history, and marked letters.  You might use this command to move a contact from a prospecting data source to your main data source or move a contact from your main data source to a data source of inactive contacts.
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Figure 102 - Move contact dialog

Sales Ally asks you to identify the target data source, which must be different from the current data source, as in Test data source shown in the Figure above.

Dialxe "Dial:Contact"

xe "Contact Menu:Dial"
The dial option prompts you to select the Work, Home or Alternate phone number and then dials the number via the computer’s modem.  You may also use one of the accelerator keys to bypass the menu.  When viewing a contact, type Ctrl-W to dial the Work number, Ctrl-H to dial the Home number, or Ctrl-A to dial the Alternate number.  Furthermore, there are buttons on the Address Page for dialing each of these phone numbers.

Mark a Letterxe "Mark a Letter:Contact"

xe "Contact Menu:Mark a Letter"

xe "Marked Letters:Mark a Letter"
There are two ways to send a letter to a particular contact.  You can choose to create and send a Quick Letter, discussed above, which allows you to quickly write and send a single letter to the currently displayed individual.  Alternatively, you can mark the current record to receive one or more existing letters (usually form letters) associated with the Letter Writer.  You can generate these letters in bulk, which greatly facilitates mass mailings.  To mark the current record to receive a particular letter, you must have already created and saved the letter with the Letter Writer option on the Mail menu.  You select specific letters by their file names.  To mark the current record, select the Mark a Letter option that opens the Marked Letters dialog box.
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Figure 103 - Marked Letters Dialog for an Individual


[image: image136.wmf]
This dialog box lists all letters that have been marked for the current record and waiting for you to print.  On a network, these are letters you have assigned or letters another user has assigned for you.  If another user has marked a letter for this contact, you will not see the letter in your list.  Each user has an independent list of letters.  You can Add or Delete letters which are queued up to be printed for this contact.

Add

When you click on the Add button, the system displays the Add Marked Letter dialog.  This enables you to select a letter to be added to the list for the current record.  When you add a letter for a contact, it joins your list of marked letters.  However, you can transfer it to another user via the Mark For button.

Delete

The Delete button erases the highlighted entry in the marked letters list box.

Delete All

To erase all entries in the list box, click the Delete All button.  The content of the list box depends on what you choose in the Select scroll box discussed below.

Mark For


[image: image137.wmf]
If you wish to transfer a marked letter to another user, i.e., move it from your list to another user's list, click the Mark For button and choose a User ID from the dialog.

Select

Initially the Select scroll box shows "(all)" and the list box displays all of your marked letters for this contact.  You can choose a particular letter in the scroll box in order to display only occurrences of this letter.

When you are ready to print the letters you have assigned to contacts, choose the Marked Letters option from the Mail menu.  This option presents you with a dialog with four additional buttons, allowing you to print Letters, Labels, Envelopes, or a Report. This dialog now shows the contact name and corresponding letter for all assignments you have made in all data sources.  We discuss this further in the Mail Menu chapter.

In summary, suppose you had a letter called PROSPECT.BAL that you had created with the Letter Writer.  You have identified a prospect that you want to receive this letter and have found and displayed his record on screen.  Select Mark a Letter from the Contact menu.  Click on Add and select the file PROSPECT.BAL from the Add Marked Letter dialog.  The letter will be added to your list for the displayed individual.  After you have marked all the letters for every individual you want to receive letters, select the Marked Letters option from the Mail menu.  Choose Print Letters to print all letters and then choose Print Labels or Print Envelopes to print corresponding mailing labels or envelopes.  That’s all there is to it.

Note: It is possible to mail a letter to a selected group of contacts by using the Group Letter option from the Mail menu.  See Group Letter in the Mail Menu chapter.
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Figure 104 - Marked Letter Dialog for Mailing

Linksxe "Links:Contact"

xe "Contact Menu:Links"
Sales Ally allows you to create Associate or Household links between individual records in a data source.  By linking records, you can rapidly move among related records in the same data source.  You can use the Make Link command to create a connection to another contact record or records.  You can display linked records, jump to one of the linked records, and destroy links between records.
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Figure 105 - Linked Contacts

Associate Linksxe "Associate Links:Links"
Associate links are used to reference other professional contacts that are associated with this person, such as accountants or lawyers representing a client or people who have been referred by the same individual.  As a convenience, when you copy a record, the new record is automatically linked to the original contact using an associate link.  When the [image: image140.png]


 button appears in the contact window, found under the data source dialog window, you have an Associate Link to other contacts.  Press this button to view your Associate Links.

Household Linksxe "Household Links:Links"
Household links are used to reference other contacts records belonging to the same person or other members of the same financial household unit, such as a spouse, children or extended family.  When the [image: image141.png]


 button appears in the contact window, found under the data source dialog window, you have a Household Link to other contacts.  Press this button to view your Household  Links.
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Figure 106 - Contact Screen showing Linked Records

Make Linkxe "Make Link"

xe "Link:Make"
To create a link, you must display a record to which you want to attach a second record.  From the Contact menu select Links, Make Link.  The system allows you to find another contact and click the Link button to connect them together.  

Break Linkxe "Break Link"

xe "Link:Break"
To break a link, you simply find the record you want to free from the connection to another record or other records.  From the Contact menu select Links, Break Link to destroy the connection.

Find Linkxe "Find Link"

xe "Link:Find"
To find an individual or individuals linked to the current contact, select Links, Find Link from the Contact menu.  The system will generate a list of all contacts linked to the current contact.  You can browse the list, highlight a contact, and click Zoomxe "Zoom:Find Link" to view the contact’s record.

Printxe "Print:Contact"

xe "Contact Menu:Print"
There are four options on the popup menu under Print: Envelope, Label, Quick Letter, and Report.  Each option refers to the current contact.

Envelopexe "Print:Envelope"

xe "Contact Menu:Print Envelope"
The Print Envelope dialog allows you to set up Sales Ally to print an envelope for the current contact.  You can choose the envelope feed method for your printer, enter the dimensions of the envelope, and select the font you wish to use.  Preview illustrates the size, alignment and rotation of the envelope you have chosen.  You need to know how envelopes should be fed into your printer.
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Figure 107 - Envelopes Settings

1. Check Envelope is fed with flap up if an envelope should be placed face down when fed into your printer.  Preview displays your selection.

2. In the Dimension area, choose an envelope Type or enter the dimensions of the envelope.  If you manually enter the Width and Height, the envelope type will be called 'Custom'.

3. Under Alignment, choose Left if the envelope is to be fed left aligned.  Other choices are Center and Right alignment.  Preview displays your selection.

4. Under Rotation, experiment with the selections until the envelope in Preview is displayed in the correct orientation for your printer.

5. Click the Font button and select the desired printer font.

6. Click the Print button to print the envelope.

Label

Choose Label to go to Reports and print a mailing label for the current contact.

Quick Letter

You must be viewing the Notes Page of a contact in order to select Quick Letter.  Click on Quick Letter to choose or create a Quick Letter template.  To insert a Quick Letter into the Notes Page, highlight a template and click on Use or simply double click on a template.  See Quick Letter on page 95.

Report

Choose Report to print a specific report for the current contact.

Contact’s Agendaxe "Contact’s Agenda"

xe "Agenda:Contact's"

xe "Contact Menu:Agenda"
The Contact’s Agenda shows all activities you have scheduled for the current contact.  It works just like the Activities Calendar described below except that it is a calendar of events for the current contact rather than all contacts.  There is also an Agenda button in the contact window that activates the Contact’s Agenda dialog without having to select this option from the menu.

7.5  Activities Calendarxe "Activities Calendar"

xe "Calendar:Activities"

xe "View:Activities Calendar"
The Activities Calendar displays the activities (Calls, Actions, and possibly other types) that you have scheduled for all contacts.  You can display the calendar in one of four views - Daily, Weekly, Monthly and Summary.  You can access each page by clicking on the corresponding button.  Use the Summary view to see all activities in ascending chronological order.

In addition to the various views, you can switch between pending activities and completed activities by clicking on the History check box.  The Show Type list box allows you to limit the type of activity displayed.  By checking one or more specific activity types, the calendar display will filter out all other activities.  If you do not select any activity type(s), the calendar will display all activity types.  

When you click on the Zoomxe "Zoom:Activities Calendar" button, you will see the contact record associated with the currently highlighted activity.  You can also double click on an activity to Zoom to the contact window.


[image: image144.wmf]
The Activities For scroll box initially shows your User ID.  When running Sales Ally on a network, you can select another user’s User ID from this scroll box to view his/her Calendar.  Your network administrator must grant you the right to view another user’s Calendar in order to take advantage of this feature.

The four views contain the following information:

Daily

The format is a daily appointment calendar with the time of day on the left followed by the contact name and activity description.  The calendar shows all time slots. You can change the view resolution of your Activities Calendar from 30 minutes to a variety of different views.  If several activities are scheduled for the same time slot, you will see only one activity. However, Sales Ally will display a number in parentheses equaling the amount of activities scheduled for that time.  By clicking on the time slot, a window will appear where you can view all of the activities scheduled for that time slot.  You can view activities that do not have an associated time in the No Time field.  To examine a different day, select the Calendar Icon located at the bottom of the Activity Calendar window, double click on a different day, and the selected day will be presented.  You can quickly print your Activities Calendar by pressing the Printer Icon located at the bottom of the Activities Calendar window.

[image: image145.png]Nov 2, 2001

Mo Tine: | i
B.00AM B S
o i =
S:00AM | I:l
£ | |
& [FCTON
11:00AM | CaLL
30 |
12:00PM |
el [z I oy
o ot ol oot 22"
& Dty skly oty su| (18] S| = e





Figure 108 - Activities Calendar - Daily View

Weekly

Click the Weekly button to see the activities for the current week, Monday through Friday. This is an expanded daily view showing 5 days at a time.  If several activities are scheduled for the same time slot, you will see only one activity.  However, Sales Ally shows the number of activities for the time slot in parentheses. You can view activities that do not have an associated time in the No Time field. To examine a different day, select the Calendar Icon located at the bottom of the Activity Calendar window, double click on a different day, and the selected week will be presented.  You can quickly print your Activities Calendar by pressing the Printer Icon located at the bottom of the Activities Calendar window.
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Figure 109 - Activities Calendar - Weekly View

Monthly  

Click the Monthly button to see the number of activities scheduled for each day of the current month. The red number in the lower right hand corner of the date shows the amount of activities scheduled for that day.  Each day is a button and the current day is active (button depressed).  Space limitations prevent showing more than the number of events for each day.  If you double click on a different day on the Monthly view, you will go back to the Daily view to see the actual activities for the selected day.  Use the controls below the calendar to move to a different month or year. Also to examine a different day, select the Calendar Icon located at the bottom of the Activity Calendar window, double click on a different day, and the selected day will be presented.  You can quickly print your Activities Calendar by pressing the Printer Icon located at the bottom of the Activities Calendar window.
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Figure 110 - Activities Calendar, monthly view

Summary  

An overall summary listing of activities is shown under this view. Click on the Summary button to see all of your activities listed in chronological order.  If you highlight an activity and go to one of the other views, you will see the same activity in a different context.  If you double click on an activity you will display that contact’s record.  To move to a specific day, select the Calendar Icon located at the bottom of the Activity Calendar window, double click on a different day, and the selected day will be presented.  You can quickly print your Activities Calendar by pressing the Printer Icon located at the bottom of the Activities Calendar window.  As an added convenience, you can also get a summary of historical information by clicking the History check box on the screen.
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Figure 111 - Activities Calendar Summary view

Using the Activities Calendarxe "Activities Calendar:Using"
You can access and use the Activities Calendar in different ways.  For example, you could call it up from the View menu and view all the calls and actions to be performed today.  Click on a particular activity to select it and click on Zoomxe "Zoom:Activities Calendar" to call up the contact view for that individual.  Then you can dial a telephone number or perform any other function appropriate to a found record.

Alternatively, you could select an individual contact via the Find Contact option on the View menu and click on the Agenda button.  The system will show only your activities associated with that individual.  

By clicking on the History check box, you can view completed activities.  You could farther limit the calendar display to merely Calls by selecting Calls from the Activity Type scroll box.  If you want to see if your associate Ellen had ever called this individual and you have been given access to her data, you could click on her User ID in the Activities For scroll box and look at the history of her calls to this contact.  

In addition to viewing Calls or Actions, you can Add, Edit, Delete, or Accomplish them.  When you select Add or Edit, the system displays the Schedule Activity window.  If you select Delete, the system deletes the highlighted call or action.  To enter the activity into the history file and delete it from your list of activities, click on Accomplishxe "Accomplish:Activities Calendar".

7.6  Schedule Activityxe "Schedule Activity"

xe "Activities Calendar:Schedule Activity" xe "View:Schedule Activity"
An activity is a scheduled CALL, ACTION, or some other created type such as a MEETING. The Schedule Activity dialog box shown is the primary data entry screen for the calendar system.  You can display it from the Activities Calendar window by clicking on either Add or Edit.  You can also call it directly from the View menu.  If you select it from the View menu or Contact’s Agenda when a contact window is active, the activity is assumed to be for that contact and his name is automatically entered into the Contact field.  If you call up the Schedule Activity dialog while you are displaying a Calendar (or Agenda) view, Sales Ally assumes the call or action to be for the Calendar view’s selected date.  If you call up the Schedule Activity dialog when no contact window is active, the activity will be called a REMINDER and is not associated with a particular contact.
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Figure 112 - Schedule Activity Dialog

The activity will be assigned to you by default, which means that it will appear exclusively in your Activities Calendar.  You must assign a time to the activity to have it appear in the Alert database (see Alarm below).

Activity For


[image: image150.wmf]
You can assign the activity to another Sales Ally user by selecting a User ID from the Activity For scroll box.  By default, the activity will be assigned to you.

Entered By


[image: image151.wmf]
Indicate which Sales Ally user originated the activity by selecting a User ID from the Entered By scroll box.  By default, you are the creator of the activity.

Description

Enter a statement describing the purpose of the activity.  The Activities Calendar, Contact’s Agenda, Alert Ally alarm system, and history will be much more useful if you take the time to enter a description.

Contact

You cannot edit this field.  It shows the contact associated with the activity if you schedule an activity while a contact window is active.  When you call up the scheduler while no contact window is active, REMINDER appears in this field.  A reminder activity is not associated with a contact.

Type

Initially, Sales Ally recognizes two kinds of activities: CALL and ACTION.  You can select one of these from the scroll box or enter a new activity type, such as MEETING, at your discretion.  Further, Sales Ally remembers your previous entries for Type of activity and allows you to quickly select one of them.  By default, Sales Ally inserts CALL into the Type field.

Date and Time

You must assign every activity a date, and, in most cases, you should assign a time.  You must assign a time to the activity to have it appear in the Alert Ally database.  If the activity is associated with a contact and the contact's record has a value for Call Interval, Sales Ally automatically fills in the Date field with the value of today's date plus the number of days specified in Call Interval.  Otherwise, Sales Ally usually puts tomorrow's date into the Date field and the current time in the time field.
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Sales Ally offers a shortcut when entering a date or time.  Instead of entering a full date you can simply enter the number of days hence.  Enter a number and Sales Ally will add this number to today's date in order to construct a proper date expression.  For example, to enter tomorrow's date, enter 1 (for one day hence).  Similarly, if you enter a number in a time field, Sales Ally adds this number of minutes to the current time to produce a proper time statement.

Double click on a date field to pick a date from a popup calendar.  Double click on a day in the calendar to enter the date into the date field.

Double click on a time field to pick a time from a popup Edit Time dialog.  Click on AM or PM, and then double click on a time in the Edit Time dialog to enter the time into the time field.

Duration

To schedule a block of time for an activity, enter the length of time in minutes.  Duration is useful only when you have specified a time for the activity.  The Daily and Weekly Calendar will show the same activity more than once if the Duration is greater than the time slot size.  Also see the next paragraph.

Check your other activities for a conflict

If you mark this option, the scheduler looks for conflicts with your other activities when adding or updating an activity.  When a Duration is entered, the conflict analyzer looks for overlapping time blocks.  If your activities do not have duration’s, the conflict analyzer only reports when you have another activity scheduled on the same day at the same time.

Alarm

You may set an alarm to notify you when the activity comes due.  Simply click on the check box labeled Activate alarm when activity comes due.  You may also set an Alarm Lead in order to notify you a specified number of minutes in advance of the scheduled time.
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Figure 113 - Sales Ally Alert System

7.7  Sales Plannerxe "Sales Planner"
A multi-step sales planner is incorporated in Sales Ally and can be found under the View menu.  The Sales Planner is used to create sales and marketing campaigns for individual contacts or a group of contacts.  You can create many different sales plans and have them readily available for future selling opportunities.  The Sales Planner is available in the Sales Ally Gold level and above.
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Figure 114 - View Your Sales Plans

After you choose Sales Planner on the View menu, you can either View your available Sales Plans or Apply an existing Sales Plan to an individual or a group.  To create your own Sales Plan fxe "Add/Create a Sales Plan:Sales Planner"rom the View Menu, choose View Sales Plan, Add, then enter a unique description into the Plan Name field. While viewing this dialog, select Add then enter the Activity information.  For more information on the Schedule Activity dialog, see Schedule Activity section in this user manual.
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Figure 115 - Steps in a Multi-step Sales Plan

Activity For

You can assign the activity to another Sales Ally user by selecting a User ID from the Activity For scroll box.  By default, the activity will be assigned to you.

Contact

Shows the Sales Plan associated with the Activity. You cannot edit this field.

Description

Enter a statement describing the purpose of the activity.  The Activities Calendar, Contact’s Agenda, Alert Ally alarm system, and history will be much more useful if you take the time to enter a description.

Type

Initially, Sales Ally recognizes two kinds of activities: CALL and ACTION.  You can select one of these from the scroll box or enter a new activity type, such as MEETING, at your discretion.  Further, Sales Ally remembers your previous entries for Type of activity and allows you to quickly select one of them.  By default, Sales Ally inserts CALL into the Type field.

Days From Start
Indicates the number of days from the date on which you applied the plan. Please Note: This dated is taken from the computer clock.  If the planner does not enter in the correct information, check you computer clock for accessory. 

Time

You must assign a time to the activity to have it appear in the Alert Ally database.  You can double click in this field to select a time from the time dialog.

Duration

To allocate a block of time for an activity, enter the length of time in minutes.  Duration is useful only when you have specified a time for the activity.  The Daily and Weekly Calendar will show the same activity more than once if the Duration is greater than the time slot size. 

Alarm

You may set an alarm to notify you when the activity comes due.  Simply click on the check box labeled Activate alarm when activity comes due.  You may also set an Alarm Lead in order to notify you a specified number of minutes in advance of the scheduled time.

Once all information has been added to this dialog press the Add button.  Press the Add button again to describe and schedule the next step in your plan.  The date from start number defaults to one day after the previous activity.  This field can be edited.  For example, you may delay 5 days after sending out a letter to a prospect.  In this case you would put a 6 in the Days From Start dialog.  Continue to add steps until your plan is complete.

You may edit any previously added Activity, by highlighting the activity, and pressing EditIf the activity is associated with a contact and the contact's record has a value for Call Interval, Sales Ally automatically fills in the Date field with the value of today's date plus the number of days specified in Call Interval.  Otherwise, .  Edit the activity and press Update. To delete an activity from your Sales Plan, highlight the activity and press Delete.  Once you have created you Sales Plan, press Save. 

Copy

 Sales Plans can be copied and use it as a building block for additional sales plans.  Press Copy, and your sales plan will by copied to another file.  The Sales Ally will automatically give the plan a name of “copy of XYZ Plan”.  Click on the Edit button to redefine the plan and modify it for a new purpose.

Apply Sales Plan to a Contactxe "Apply Sales Plan to a Contact:Sales Planner"
1. Once you have found the contact to whom you wish to apply a sales plan, select View, Sales Planner, Apply Sales Plan.  Sales Ally will display the sales plans that you have created. 

2. Select the start date of your plan.

3. Highlight the plan you wish to Apply, and press OK
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Your plan has been applied to that contact.

Figure 116 - Select Sales Plan to Apply to Group of Contact Records

Apply Sales Plan to a Group Listxe "Apply Sales Plan to a List:Sales Planner"
Once you have created your Campaign List, click on File, Database Operations, Global Change.  

8. Choose a Sales Ally data source in which your list exists.

9. Check List and choose the List Type. 

10. Click on the Plan button in the Add section of the Global Change dialog.

11. Select the start date of your plan.

12. Highlight the plan you wish to Apply, and press OK

13. At the Global Changes Dialog, press Start

14. Sales Ally will display your lists that have been created.  Highlight the list you would like the Sales Plan to be applied and press View List.

15. Press the Global Changes button and you plan will be applied to your selected group of contacts.

For More information on the Global Changes functionality, please see Global Changes section found in the File Chapter.

7.8  Campaignsxe "Campaigns"

xe "View:Campaigns"
You may wish to create a list of contacts you would like to call in order to offer a new product.  Or you may wish to send a letter to a group of people who have expressed interest in a certain type of security. Campaigns allows you to create a list of contacts you want to use for calling, mailing, printing a report, exporting to another application, etc.  Since we allow you to create an unlimited number of lists, to provide some organization for all these lists, and to enable you to find them again quickly, we have created list categories XE "List categories"  for Calls, Actions, Maturing securities, and other miscellaneous Groups.  The mechanism for creating a list is identical for Calls, Actions, and Groups whereas a Maturity list XE "List"  is based solely on the securities your clients own.

Call Listsxe "Call Lists" xe "View:Call Lists"
As a busy advisor, you know that your time is valuable.  Using a Call List campaign is one way to optimize your calling campaigns.  You want to spend the most time on those people that currently or potentially will bring you the most business.  The Call Lists option allows you to do this by creating a campaign list by some criteria and then sorting them based on one or more common criteria.  You can identify those records by such things as income, net worth, Activity Date, Activity Type, Status, City, Rating or other contact and activity fields.  In addition, you can sort the list using any field or combination of fields, such as Activity Date, Last Name, and Rating.  Now you have a readily accessible group of records that is a subset of your selected data source prioritized in such a way that you are calling your best clients and prospects first.

The Call Lists option allows you to create a series of selected lists of individual contacts based on one or more common features.  Sales Ally doesn’t actually extract the data into a separate database for each list.  Rather it maintains a set of identifiers that reference individual records in your data source.  This means that if you edit an individual’s address, the change will be reflected in every list in which the individual appears.

When you select Call Lists from Campaigns on the View menu, the system displays the Call Lists dialog.  It contains two list boxes on the left called Available Lists and Data Sources.  You will have a different set of saved lists for each Sales Ally data source.  To create a new list, select a data source and click the New List button.
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Figure 117 - Call List Dialog
Creating a Call Listxe "Call List:Sample"
Your normal calling activities are conducted from the Activities Calendar. However, this Campaign Calling List option is a powerful supplement to the Activities Calendar specifically for managing a calling campaign. To begin the creation of a Calling Campaign List, select New List to go to the Edit Listxe "Edit List" dialog.  Sales Ally supplies you with list templates but also give you the ability to create a list on any specific criteria you wish.  Because we provide extraordinary flexibility in choosing selection and sort criteria for lists, this dialog seems a little complex when you first encounter it.  However, you build all expressions using plain English phrases.  You define Search Properties to select contact records and Sort Properties to establish how to order these records.  Then, when you Close the dialog, Sales Ally creates the list.

Search Properties

Click the Add button adjacent to the Search Properties list box to bring up the Search Logicxe "Search Logic" window.  You will build a logic expression utilizing one or more database fields to construct the filter for selecting contact records.  You can use the fields in one or two of the following files: contacts, activities, histories, or postings
.  For example, suppose you want to build a Call list for everyone having a scheduled CALL activity dated April 1, 2009 or before.  You will select contacts based solely on activities information.

1.
Select Activities - Type from the Field combo box,

2.
Select Equal to: (=) from the Operator combo box, 

3.
Enter CALL in the Value field,

4.
and click OK.

On returning to Edit List dialog the Search Properties Criteria displays:

"Activities - Type Equal to: (=) CALL".
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Figure 118 - Edit List

Once again click the Add button adjacent to the Search Properties list box to bring up the Search Logic window.

5.
Select AND in the Continue Previous Statement With group,

6.
Select Activities - Activity Date from the Field combo box,

7.
Select Less than or equal to: (<=) from the Operator combo box,

8.
Enter 4/1/19 in the Value field,

9.
and click OK.

On returning to Edit List dialog the Search Properties Criteria displays:

"Activities - Type Equal to: (=) CALL"

"AND Activities - Activity Date Less than or equal to: (<=) 4/1/2019" 

Notice that the first clause is connected to the second clause with AND, meaning that both clauses must be true in order to select a contact.

Please Note:  A Short Cut for creating calls list:

Select Activities - Activity Date from the Field combo box, Select Is Past Date or Today; (<=Today) from the Operator combo box, Press the Refresh button every day. 

The operator will automatically take today’s date from your computer clock and place it into the Date criteria.

Network Users


[image: image158.wmf]
If you are running Sales Ally on a network, you will want to create a Call list containing only your calls.  You must therefore select activities assigned to you alone.  Once again click the Add button adjacent to the Search Properties list box to bring up the Search Logic window.

10.
Select AND in the Continue Previous Statement With group,

11.
Select Activities - Activity For User from the Field combo box,

12.
Select Equal to: (=) from the Operator combo box,

13.
Enter your User ID (assume XYZ for this example) in the Value field,

14. and click OK.

On returning to Edit List dialog the Search Properties Criteria displays:

"Activities - Type Equal to: (=) CALL"

"AND Activities - Activity Date Less than or equal to: (<=) 4/1/2019"

"AND Activities - Activity For User Equal to: (=) XYZ" .

Sort Properties

Click the Add button adjacent to the Sort Properties list box to bring up the Search Logic window.  You now build a logic expression utilizing contact and activity fields to construct the sort statement.  For example, suppose you want to sort the Call list mentioned above by Last Name.  Simply select Contacts - Last Name from the Field combo box and click OK.

On returning to the Edit List dialog the Sort Properties Criteria displays:

"Contacts - Last Name"

If you construct a sort statement with several clauses, the clauses will always be ANDed.  Now click the Close button to create the list.

Changing a Call Listxe "Call List:Revise"
After you create a list, its members never change.  If you add new contacts to your database or schedule new calls, an existing Call List will not change.  However, because Sales Ally saves the list criteria as well as the members of the list, you can use the existing criteria to recreate the list, i.e., update the contacts comprising the list.  Click the Refresh List button in the Call List dialog.

If you want to change or add criteria before regenerating the list, click the Edit List button to go to the Edit List dialog.  You can select a line in Search Properties or Sort Properties and click the Edit button to change the logic statement.  For example, you might want to revise the statement "AND Activities - Activity Date Less than or equal to: (<=) 4/1/2009" to reflect a new value for the date.  To add new logic statements, click the Add button.  When you Close the Edit List dialog, Sales Ally will refresh the list.

Remember that you can create as many lists as you want.  Therefore, before revising or deleting an existing list, be sure you have no use for the current list before refreshing it. 

Using a Call Listxe "Call List:Using"
After creating a specialized list, click View List in the Call List dialog.  The List viewxe "List View" displays the names of all selected individuals and is the gateway to doing something with the list.  You can scroll through the list by clicking on the up or down arrows.  The List view has buttons for Zoom, Reports, and Mail Merge.  An entry can be checked (marked as completed), and checked entries can be functionally removed from the list if you select the Skip Checks option.
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Figure 119 - List View

Zoom

To see and work with the full contact record for someone in the list, highlight a member of the list and click the Zoomxe "Zoom:List View" button.  When the contact window appears you can dial a phone number, change contact information, add notes, enter transactions, and so on.  You can move to the contact window for the next individual in the list using the browse buttons.  Otherwise, click Update or Cancel as appropriate to return to the List Viewxe "List View:Zoom".  

Reports

Since most reports are based on a list, you can launch a report from the List Viewxe "List View:Reports".  In this case you have already selected the list you will use.  When you click the Reportsxe "Reports:List View" button to go to the Reports dialog, you will choose a particular report.  Alternatively, you could start with Reports from the View menu, choose the report, and then pick the list.

If you want to print mailing labels for everyone in the list choose an appropriate report.

Mail Merge

You can use any list to print letters.  Click Mail Mergexe "Mail Merge:List View" from the List View to call the Letter Writer, select an appropriate form letter, and proceed to print a merged letter for everyone in the list.  You can print envelopes by clicking the Envelopes button.xe "List View:Mail Merge"
Check Item

Click on Check Item to mark the selected contact as completed.  The contact will appear with the strike-thru attribute and your User ID will appear to the left of the name.  Checking an item has no effect on any operations performed with the list unless you select the Skip Checks option.

Reset Item

Click on Reset Item to undo the Checked Item.

Skip Checks

Select the Skip Checksxe "Skip Checks:List View"

xe "List View:Skip Checks" option to cause any operation using the list to ignore checked entries.  When you Zoom to a contact window and use the browse buttons, you will see only unchecked contacts.  When you create a report, print mail merge letters, or export data, only unchecked contacts are processed.

Actionsxe "Actions List"

xe "Group List"

xe "Maturity List", Group & Maturity Lists

The Action Lists and Group Lists are identical in behavior to the Call Lists.  You use the same methods in creating a Call List to build a list for Action and Group Campaigns.  We provide these alternative list folders simply to help you categorize your many lists and be able to come back to them over and over again to manage your multiple campaigns.

On the other hand, the Maturity List category allows you to generate one of more lists based on the maturity date range of securities owned by contacts; most commonly a product coming due or product with a maturity date.   

7.9  Reportsxe "Reports"
The Reports dialog allows you to print or preview a report or mailing labels.

1. Select the report Type (Standard, Labels or Posting Book) by clicking one of the radio buttons located at the right of the Reports dialog.  If you choose Labels, you should also select a Label Form (Sheet or Continuous).  Choose Sheet for Laser and other page printers, or choose Continuous for sprocket feed impact printers.

2. Select a specific report from the Available Reports box.  Although you will probably never need to do so, you can change the directory where the report files are found by clicking on the Browse button.  The Browse dialog will appear allowing you to specify a new directory for the RPT files. 

3. Select a List or Data Source to use for the report.  Most reports use a List that you have created (or will create) in order to determine which contacts are to be included in the report.  The report records will appear in List order.  Because Marked Notes and Security reports use special Lists, you will not choose a List for these reports.  If you do not check Use a List, the report will use all contacts in the data source you choose.

4. Select Print or Preview.  Print sends the report to your printer, whereas Preview sends the report to temporary files and then displays the report on your computer screen.

If you choose a report that requires a list, Sales Ally will send you to the List dialog.  At this time select a specific existing list or create a new one, then choose View List.  In the View List dialog you can choose Print or Preview to proceed with the report.

If you want to create a new custom report, click on the Report Editor button and the system will display the Custom Report window allowing you to create a custom report.  When you save the report, the system will list it amongst the other custom reports.  To print a selected report for the current list, click on Print.  To view the selected report on screen, click on View.  To cancel the print request, click on Cancel.
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Figure 120 - Reports Dialog
Sales Ally comes with many pre-defined reports parceled out into three categories - Standard, Labels, and Sales reports.  You can produce the Marked Letters report only from the Marked Letters dialog on the Mail menu.  The specific reports are as follows:

Standard Reports

Sales Ally comes complete with several pre-designed report formats.xe "Standard Reports"
Account/Company xe "Standard Reports:Account/Company"

xe "Account:Report"- Shows Name, Company, and Account number for all records in the list.

Activities xe "Standard Reports:Activities"

xe "Activities:Report"- This report is the same as the Summary page of the Activities Calendar and shows all of your scheduled activities.  You can select activities falling within a range of dates and can produce a report for activities belonging to other users.

Activities/Phone Report xe "Standard Reports:Activities"

xe "Activities:Report"- This landscape orientation report will show all of your activities for each day selected.  Each row includes the name of the contact, three phone numbers, the scheduled activity time, and the activity description.

Address/Phonexe "Address:Report"

xe "Standard Reports:Address/Phone Card" - Shows all important name, address, and phone number information formatted as if they were to appear on a large index card.

Company/Status xe "Standard Reports:Company/Status"

xe "Company:Report"- Shows Name, Company, and Status for all records in the list.

Contact/Notesxe "Standard Reports:Contact/Notes"

xe "Contact:Report" - Shows all contact fields and as many notes (starting with the most recent) that will fit on a single page for each record in the list.

Contact Work Sheetxe "Contact Work Sheet:Standard Reports" - This portrait orientation report is similar to the Contact/Notes report.  It displays all information for the contact, as many of the most recent notes that will fit in the middle of the page, and allows space at the bottom of the page for the users to write specific information on this contact.  If differs from the Contact/Notes report by not showing Quick Letters in the notes area of the report and providing space for hand written “Notes From Today”.

Date Status xe "Standard Reports:Last Contacted"

xe "Last Contact:Report"- This report shows the contact Name, Status, Open Date, Last Contact date, and Birth Date for all records in the list.  When you phone someone using the dialer and click on Contacted, the Last Contact field in the contact record is updated.

History xe "Standard Reports:History"

xe "History:Report"- This report is the same as the Summary page of the Activities Calendar (when you check History) and shows all of your completed activities.  You can select histories falling within a range of dates and produce a report for histories belonging to other users.

Marked Notesxe "Standard Reports:Marked Notes"

xe "Marked Notes:Report" - While the Notes page of a Contact view is displayed, a note can be "marked" for printing at a later time, typically the end of the day.  These marked notes are printed using this report, providing the contact Name together with the Note.  Unlike the Marked Note Labels report, which is designed to print on label stock, this report prints the full text of the note.  After the report is displayed or printed, you can unmark all marked notes to avoid printing the same notes the next time you run this report.  Do not unmark the notes until you print Marked Note Labels, unless you do not intend to print labels.  

Notes xe "Standard Reports:Notes"

xe "Notes:Report"- Shows all notes for each contact in the list.  You can select notes by a date range and/or a fragment of text.

Phone xe "Standard Reports: Phone"

xe "Phone:Report"- Shows Name, Work phone, Work Extension, Home phone, and Fax phone numbers for all records in the list.
Phone Tallies xe "Standard Reports: Phone Tallies"

xe "Phone Tallies:Report"- Shows a summary of the number of calls and phone contacts you have made during the past two weeks, months, and years. Includes graphs.

Rating/Status xe "Standard Reports:Rating/Status"

xe "Rating:Report"- Shows Name, Status, and Rating for all records in the list. Includes a graph.
Source xe "Standard Reports:Source"

xe "Source:Report"- Shows the Source Type and Source information for all contacts in the list.

State/Zip xe "Standard Reports:State/Zip"

xe "State:Report"

xe "Zip:Report"- Shows the Name, Status, Zip code, and State for all contacts in the list. Includes a graph.

Weekly History Report - Number of activities you scheduled and the number of activities you accomplished for each Activity Type, reporting on the previous week Sunday through Saturday.  Includes Goals you setup in User Preferences under User Info.  Includes graphs.

Labelxe "Labels"

xe "Print:Labels" Reportsxe "Label Reports"
When printing labels, you should select a Label Form (Sheet or Continuous) before selecting a label report.  Choose Sheet for Laser and other page printers or choose Continuous for sprocket feed impact printers.  You can print labels from many different places within Sales Ally.  For a specific contact, select Labels from the Contact, Print Menu. For selected contacts, you can use either a List or the entire data source.  If you would like to print labels for a list, you must first create the Campaign List.  Once the list is created, while viewing the list, click the Reports button and choose labels.  Sales Ally supports several label form layouts: 

· 1" x 4", two across

· 1" x 2.6", three across

· 1.33" x 4", two across (laser)

· 1.4" x 4", two across (dot matrix)

POSTNET Barcodes - When printing labels you may add 5 or 9 digit ZIP Code POSTNET barcodes below the address on each label by selecting the POSTNET Barcodes XE "POSTNET Barcodes" xe "POSTNET Barcodes" option.  In order to make room for the barcode, some address lines may be eliminated.  However, Sales Ally will retain all address information required by the USPS.

1. Address Labels xe "Label Reports:Address Labels"

xe "Address:Labels"- Prints mailing labels for the contact records in the list.  A contact record which has ‘No Mail’ checked will not appear in the report.

2. Marked Note Labels xe "Label Reports:Marked Note Labels"

xe "Marked Notes:Labels"- Prints a mailing label for each marked note, and prints on an accompanying label as much of the marked note as will fit on the label.

Chapter 8    Mail Menu XE “Mail Menu” 

 XE “Menu:Mail” 
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Figure 121 - Mail Menu

The Mail menu is the primary resource for creating and printing letters, labels and envelopes. In this section, we will discuss the integrated word processor called the Letter Writer as well as the process for printing Marked Letters, Marked Notes, and mass mailings to selected groups of people using the process of mail merge.

8.1  Letter Writer XE “Letter Writer” 

 XE “Word Processor” 

 XE “Reports:Custom” 
The Letter Writer in Sales Ally is a fully integrated, full function word processor.  You can open the Letter Writer at any time regardless of what you are doing.  It is not necessary to leave the Contact view to start up the Letter Writer.  When you start up the Letter Writer, it will occupy its own window positioned on top of the current contact window.  

Note:  You can also use the Letter Writer to create your own customized reports by utilizing the merge fields.

To start up the Letter Writer, simply select it from the Mail Menu.  The Letter Writer will expect you to open an existing letter or to create a new letter. 
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Figure 122 - Open Letter Writer Dialog

The Letter Writer can open files having the extension .SAL (Sales Ally Letters), XE “Files:BAL (Sales Ally Files)”  RTF (Rich Text Format files), XE “Files:RTF (Rich Text Format Files)”  or plain text files.  If you wish, you can also select another directory or drive by double clicking on the desired entry in the appropriate scroll box.  First, to select a letter, you can either highlight it and click on the Open button or you can double click on the file name.  Once you have selected an existing file or requested a new file, the Letter Writer displays its main window.
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Figure 123 - Letter Writer Window

The Letter Writer window lists the name of the current letter in the title bar.  If the Letter Writer contains a new document that has not yet been saved, the document will be assigned the temporary name ‘LetterX’, where X is a sequence number assigned by the system.  You can open as many letters as you desire up to the memory limit of your computer.  You can cut and paste between letters using the Edit menu, and you can switch between letters by clicking on the corresponding window or using the open window list on the Window menu. The main editing region is bordered by a horizontal ruler that displays inches, a vertical scroll bar, and a horizontal scroll bar. It has a tab bar that displays the left margin and tab settings, and a toolbar for controlling the text in the window. Sales Ally provides various sample letters with the Letter Writer.

Exit XE “Letter Writer:Exit” 

 XE “Exit:Letter Writer” 
To close a Letter Writer window, double click on the system box in the upper left corner of the Letter Writer window or select Exit from the Letter Writer menu.  

Letter Writer Menu

The Letter Writer has its own menu.  You will find the following options:

 XE “Letter Writer:Menu” 

 XE “Menu:Letter Writer” 
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Figure 124 - Letter Writer Menu

Save XE “Save:Letter Writer” 

 XE “Letter Writer:Save” 
You can save the current letter by selecting Save from the Letter Writer menu.  If the letter is a new document, Sales Ally will prompt you to enter a name or use the default name ‘LetterX’, where X is an assigned sequence number.  If you do not specify an extension, BAL is assumed.  If you enter an existing file name, the system will ask you if you wish to over-write the existing file.  You can select another Disk drive, directory or file format by clicking on your choice in the appropriate scroll box.  If you try to close a letter window and have not saved the changes to the letter, the Save Letter dialog is displayed automatically.  If you have changed an existing file, the letter will be saved under the same file name, location and file type without prompting you for these selections.

Save As XE “Letter Writer:Save As” 

 XE “Save As :Letter Writer “ 
The Save As option displays the same dialog as Save.  The subtle difference is that the Save option presumes that you want to save a previously saved file under the same name and location while the Save As option assumes you want to change the file name, type or location.

Document Info  XE “Letter Writer:Document Info” 

 XE “Document Info:Letter Writer “ 
The Document Information dialog in the Figure below helps you to store additional information about the letter.  You can fill in the Title, Subject, Author, Operator, Keywords, and Comments for the document.  Sales Ally saves the Last Saved, Last Printed, and the Creation dates for the document.  It only stores Document Information for letters saved with the Sales Ally Letter file format, i.e., with a BAL extension.
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Figure 125 - Document Information Dialog

Format  XE “Letter Writer:Format” 

 XE “Format:Letter Writer” 
The Format option controls the appearance of the text of your letter and presents a sub-menu containing the following options:

Text XE “Letter Writer: Format:Text “ 

 XE “Format:Letter Writer:Text” 
The Format Text option presents the dialog that sets all font attributes for the selected text.  To use these options it is necessary to first highlight the text that you want to alter by placing the insertion point at one end of the text, pressing and holding the left mouse button and dragging the highlighted cursor to the opposite end of the text.  After highlighting the text to be altered, select the Format Text option, and select the font, style and size of the type.  Further, you can add the Underline and Strikeout features if desired and you can set the color if you have a color printer.
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Figure 126 - Format Text dialog

Format Paragraph  XE “Letter Writer:Format:Paragraph “ 

 XE “Format:Letter Writer:Paragraph” 

 XE “Paragraph Format:Letter Writer” 
Sales Ally defines a paragraph as the text between two hard returns - locations where you have pressed the Enter key to start a new line.  The “paragraph” icon on the toolbar allows you to toggle on or off the display of hard returns.  The Format Paragraph dialog allows you to set the spacing before the current paragraph, the indentation, and the alignment of the current paragraph. You must select part of one or more paragraphs before selecting the Format Paragraph option.
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Figure 127 - Format Paragraph dialog

Format Page  XE “Letter Writer:Format:Page” 

 XE “Format:Letter Writer:Page” 

 XE “Page Format:Letter Writer” 
The Format Page dialog in allows you to format the page layout for all pages in a document.  These settings control the printer margins, and the width of the default tab.
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Figure 128 - Format Page dialog

Format Color  XE “Letter Writer:Format:Color” 

 XE “Format:Letter Writer:Color “ 

 XE “Color:Letter Writer” 
When you select Format Color from the Letter Writer menu, you can change the color of the selected text.  Unlike the Format Text option, you cannot change other font attributes.  The Color dialog shows the standard Windows colors.
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Figure 129 - Format Color Dialog

Format Bold  XE “Letter Writer:Format:Bold” 

 XE “Format:Letter Writer:Bold” 

 XE “Bold:Letter Writer” 
When you select Format Bold from the Letter Writer menu, you will change the bold attribute of the selected text.  Unlike the Format Text option, you cannot change other font attributes with the Format Bold option.  This is a shortcut method for bolding text.

Format Italic  XE “Letter Writer:Format:Italic” 

 XE “Format:Letter Writer:Italic” 

 XE “Italic:Letter Writer” 
The Format Italic option changes only the italic feature of the selected text.

Format Superscript XE “Letter Writer:Format:Superscript “ 

 XE “Format:Letter Writer:Superscript “ 

 XE “Superscript:Letter Writer” 
The Format Superscript option raises the vertical position of the selected text within the current line spacing.

Format Subscript XE “Letter Writer:Format:Subscript “ 

 XE “Format:Letter Writer:Subscript “ 

 XE “Subscript:Letter Writer” 
The Format Subscript option lowers the vertical position of the selected text within the current line spacing.

Search XE “Letter Writer:Search” 

 XE “Search:Letter Writer” 
The Search dialog enables you to find multiple occurrences of any combination of characters in a letter.  When you type text in the Search for field, the Search button becomes enabled permitting you to begin the search. If Sales Ally finds the entered text, it is highlighted within the letter.  You can click on the Search button to find the next occurrence or click on Cancel to stop the search.  You can fine tune your search by clicking on one or more of the check boxes found on the left side of the Search dialog.  The Whole Words option limits the search process to matching the entered text exactly.  If you enter search text such as able, it will find the text ‘usable’ as well as ‘able’ unless you specify Whole Words.  You can eliminate the distinction between upper and lower case characters by checking the Ignore Case option.  By unchecking the Start at cursor position option, you can tell Sales Ally to begin each search at the top of the document.  You can control the direction of search by clicking on the Forward or Backward radio button.
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Figure 130 - Search Dialog

Search and Replace XE “Letter Writer:Replace” 

 XE “Replace:Letter Writer “ 

 XE “Letter Writer:Search & Replace “ 

 XE “Search & Replace:Letter Writer “ 
The Search and Replace dialog works exactly like the Search dialog, with the added capability of the replacing the search text.  
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Figure 131 - Search and Replace

When you have entered the Search for text and the Replace with text, the Replace and Replace All buttons will be activated.  If you select Replace, the next occurrence of the Search text will be highlighted and a new dialog will appear with four buttons: Find Next, Replace, Replace All, and Cancel.  Click on Find Next to skip to the next occurrence of the search text, click on Replace to make this replacement, click on Replace All to replace all occurrences, or click on Cancel to abort Search and Replace.  If you select Replace All, all occurrences of the Search text will be replaced according to the setting of the search controls (from beginning or current cursor position, forward or backward, etc.).

Insert  XE “Letter Writer:Insert” 

 XE “Insert:Letter Writer” 
Use the Insert dialog to insert special data such as dates, merge fields XE “Merge:Fields” , page breaks, other documents, pictures, or even tables into the current document.  It consists of several option buttons to select the type of data to be inserted, and a list box that fills with the choices associated with the selected option.  When you select an item from the list box, and click on Insert, the item is inserted into the letter at the current insertion point.  The options are:
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Figure 132 - Insert Dialog

Contact XE “Letter Writer:Insert:Contact “ 

 XE “Insert:Contact:Letter Writer” 

 XE “Contact:Letter Writer” 
When you select the Contact option, the available items are merge fields for the contact record.  If you insert a merge field, the field name will be replaced by the corresponding data for each contact during the merge process.  Most contact fields are available as merge fields.  Furthermore, there is a special merge field for a contact’s full name called FULL NAME.  The NICKNAME merge field will substitute Salutation + Last Name, e.g., Mr. Jones, if the NickName field is empty in a contact record. 

The COMPANY, TITLE (2nd Name), ADDRESS1, and ADDRESS2 merge fields are called “ghost” fields because they will vanish if no data is available when the letter is printed.  A ghost field XE “Ghost field” 

 XE “Merge:Ghost fields”  and, more importantly, the line it occupies will disappear in the absence of data to fill it.  However, if any other text or merge fields share a line with a ghost field, an empty space will replace the field and the line will remain in the letter.

Date  XE “Letter Writer:Insert:Date” 

 XE “Insert:Date:Letter Writer” 

 XE “Date:Letter Writer”
When you select the Date option, the available items are: 

{MM/DD/YY}

{MM/DD/YYYY}

{NNNNNNNN DD, YYYY}

9/28/2014

9/28/14

September 28, 2014

Items 1 through 3 are three different styles of date merge fields.  When you print a letter containing one of these merge fields, the current date replaces the merge field.  For example, item 1 produces a result like item 5, item 2 produces a result like item 4, and item 3 produces a result like item 6 when you print the letter. Items 4 through 6 display the current date (whatever it happens to be when you pull up the Insert dialog) as static text strings.  They are not merge fields.  If you insert one of these items into your letter, it will appear exactly as you see it and it will never change.

Document XE “Letter Writer:Insert:Document” 

 XE “Insert:Document:Letter Writer” 

 XE “Document:Letter Writer” 
When you select the Document option, the Open Letter Writer dialog will appear with the New button disabled.  When you select a document, it will be inserted into the current letter at the insertion point.

Page  XE “Letter Writer:Insert:Page” 

 XE “Insert:Page:Letter Writer” 

 XE “Page:Letter Writer”
When you select the Page option, the available items are:

1. Page Break, which forces the beginning of a new page.

2. Page Number, a merge field that will be replaced with the page number when the document is printed.

User 
When you select the User option, the available item is merge field for the name of the current user of Sales Ally and default user information.  See User Preferences.

Picture

When you select the Picture option, you will be presented with an insert picture dialog window.  You have the ability to insert picture in the following formats.

· Windows Bitmap (*.BMP)

· Tag Image File Format (*. TIF)

· Graphics Interchange (*. GIF)

· Windows Paintbrush (*. PCX)

· TARGA (*. TFA)

· Windows Metafile (*.WMF)

Graphics can also be added via the Microsoft Windows Cut, Copy and Paste routine.  You can preview your selections by checking the Preview check box.
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Figure 133 - Insert dialog

Table

When you select the Table option, you will be presented with a dialog window which will ask the number of columns and rows you would like.

Merge XE “Letter Writer:Merge” 

 XE “Merge:Letter Writer” 
The Merge menu item on the Letter Writer menu brings up the Mailing List dialog.  After you select an existing list or create a new list, Sales Ally prints the current letter for each contact in the list, filling in the merge fields appropriately.

If No Mail XE “No Mail:Merge” 

 XE “Merge:No Mail”  is checked in a contact record, the contact is ignored during the merge print operation.  This feature allows you to avoid creating duplicate letters or labels for individuals with more than one contact record.  You can turn off this feature by selecting Ignore No Mail in User Preferences.

Spell Check XE “Letter Writer:Spell Check” 

 XE “Spell Check:Letter Writer” 
Select Spell Check from the Letter Writer menu to check the document for misspelled words.  If no misspelled words are found, Sales Ally displays the message “Spell Check complete”, otherwise the Spell Check dialog appears.  The Spell Check dialog provides suggested replacements for the misspelled word and a default Change To entry.  You can choose to Change the misspelled word, Ignore the suggestion, or, if it is a valid word, Add it to the dictionary.  The Ignore All option causes the spell checker to ignore the suspect word for the remainder of the document.  The Change All option causes the spell checker to automatically replace the suspect word with the suggestion for the remainder of the document.  You may edit the Change To replacement word if the spell checker does not provide an appropriate suggestion.
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Figure 134 - Spell Check Dialog

Note: Merge Field Protection: When the spell checker makes a revision on a line containing a merge field, it deletes the merge field.  You will have to re-enter the merge field.

Letter Writer Toolbar XE “Letter Writer:Toolbar” 

 XE “Toolbar:Letter Writer “ 
In addition to its pull down menu, the Letter Writer provides a Toolbar that provides instant access to many common functions.
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Figure 135 - Letter Writer Toolbar

Starting from the left end of the Toolbar, you can find the following features:

Text Font XE “Letter Writer:Toolbar:Text Font” 

 XE “Toolbar:Letter Writer:Text Font “ 
The Font scroll box presents all of the fonts installed with Windows.  You can select any font for the currently highlighted text simply by clicking on the font name.  You can quickly move to a font name by typing the first couple of letters of the font name into the input portion of the Font scroll box.  

Text Point Size XE “Letter Writer:Toolbar:Text Point Size” 

 XE “Toolbar:Letter Writer:Text Point Size “ 
You can quickly change the point size of selected text by clicking on the Point Size button.  You can either enter the exact point size desired or click on one of the preset point sizes.

Left , Center, Right & Justify Paragraph  XE “Letter Writer:Toolbar:Align Paragraph” 

 XE “Toolbar:Letter Writer:Align Paragraph “ 
The various paragraph alignment options will re-align the currently highlighted paragraph or paragraphs.  You can select portions of one or more paragraphs by clicking and dragging your mouse.  The entire paragraph (defined as any text lying between hard returns) or paragraphs will be reformatted with the selected alignment.

Bold, Italicize, Underline & Strikeout Text  XE “Letter Writer:Toolbar:Bold, Italicize, Underline & Strikeout” 

 XE “Toolbar:Letter Writer:Bold, Italicize, Underline & Strikeout “ 
The Bold, Italicize, Underline and Strikeout buttons toggle their respective features on and off for the highlighted text.  If the highlighted text contains a mixture of both states, e.g., both bolded and unbolded text, clicking on the associated button will first move the entire selected text to one state and then to the other.  Therefore, you may have to click the button twice to obtain your desired result.  

Single, One and a Half, or Double Line Spacing XE “Letter Writer:Toolbar:Line Spacing” 

 XE “Toolbar:Letter Writer:Line Spacing”
Select Single, One and a Half, or Double line spacing to set the amount of space between the lines of the selected text.

Superscript & Subscript

The Superscript and Subscript options move the selected text up and down a half line respectively.

Show Paragraphs

The Show Paragraphs button toggles the display of the paragraph marker at the end of each paragraph as well as other non-printing characters.  The Letter Writer inserts a paragraph marker each time you enter a hard return by pressing the Enter key.  

Text Color XE “Letter Writer:Toolbar:Text Color” 

 XE “Toolbar:Letter Writer:Text Color “ 
You can change the color of the selected text by clicking on the Color button.  Changing the color of text will have no affect unless you have a color printer.  

Letter Writer Ruler XE “Letter Writer:Ruler” 

 XE “Ruler:Letter Writer” 
Below the Letter Writer toolbar, there is a horizontal ruler and tab bar for showing and setting the left indent and fixed tab positions.
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Figure 136 - Letter Writer Ruler

The “wedge” on the left controls how far the selected text will be offset from the left margin.  You can drag it to any location you desire.  The Figure above shows two tab markers.  To insert a tab marker, click on the tab bar beneath the ruler at an appropriate location.  You can drag an existing tab marker anywhere on the tab bar or remove it by dragging it off the tab bar.

8.2  Marked Letters XE “Mail Menu:Marked Letters” 

 XE “Marked Letters:Mail Menu” 
The marked letter feature is a clever and convenient time-saving feature that allows you, during the course of the work day, to assign unique letters to single individuals one at a time, but batch print them all at once. The Marked Letters dialog shown in the Figure below presents a list of all letters that have been assigned to one or more individuals via the Marked a Letter option on the Contact menu.  You can Delete a marked letter or Delete All marked letters from the list by clicking on the appropriate button.  To Delete a marked letter, you must first select a letter from the list box.  
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Figure 137 - Marked Letter Dialog

The Print buttons located at the bottom of the dialog allow you to merge names into and print letters, labels, envelopes, or produce a report utilizing data in the contact records of every person displayed.  The Letters button will merge and print Marked Letters.  The Envelopes or Labels buttons will merge and print mailing labels or envelopes for each letter. The Report button will print data into a selected report format using the Marked Letters List of contacts.

You can delete individual entries with the Delete button or delete the list that is currently displayed with the Delete All button.  The Select scroll box allows you display the entire list or just the contacts for a particular letter.  Initially the Select scroll box shows “(all)” and the list box displays all of your marked letters for all contacts.  You can choose a particular letter in the scroll box in order to display only the contacts to whom you assigned this letter.  Some users like to print one kind of letter in a single batch, change stationary in their printer, and print another kind of letter as a second batch.  The print commands operate on the contents of the list box.

After you have printed the selected marked letters, you can click on Delete All to remove the people from the marked letters list.  Be sure that you have printed the necessary labels or envelopes before you delete marked letters list, because this group is not retrievable again.

8.3  Marked Notes  XE “Mail Menu:Marked Notes Report” 

 XE “Marked Notes:Report” 

 XE “Mail Menu:Marked Notes Labels” 

 XE “Marked Notes:Labels”
Marked Notes is a handy feature for creating a mailing label for fulfilling mailing requests. After typing a note, you can “mark it” for printing. To print out the label you select the Marked Notes feature from within this Mail Menu. When you select Marked Notes from the Mail menu, you can choose either Report or Labels.  The Marked Notes Report produces a report of all marked notes whereas the Marked Notes Labels command produces mailing labels for the marked notes.  You can also produce the report or labels from Reports under the View menu.  See Notes Page in Chapter 3 for instructions on marking a note.

You can use the Marked Notes Report to create a “To Do” list from your contact notes.  This feature is great for printing follow-up instructions and its associated mailing label, such as “Send information on Sun Microsystems stock”.  The Marked Notes Labels option produces a hybrid label and report.  The concept is that this feature will print both a mailing label for the marked contact record together with instructions about what to mail to that contact.  The instructions are formatted to fit on the label adjacent to the mailing label.  You read the instructions from the note about what to include in the mailing, and then peel the mailing label and affix it to the envelope.

8.4  Group Letter XE “Mail Menu:Group Letter” 

 XE “Group Letter:Mail Menu “ 
This is the mail merge feature of Sales Ally; the process of merging contact information into a single letter which is the same for all the contacts. The Group Letter option allows you to create a Mailing list, choose a form letter, and perform a merge print operation with the Letter Writer addressing the letters correctly using the names and addresses of contacts within the group list. The result is the same as choosing the Merge option from the Letter Writer menu (discussed on page 132).  You could also use a different list, such as a Calls list, from the View menu and select Mail Merge from the List view. The end result is the same whether you use a Call List, Action List, or Group List; all the selected names will merge into a single letter and print in a single batch.

When you select the Group Letter option, Sales Ally displays the Mailing List dialog.  Choose an existing list or create a new one.  Click on the View List button and click on Mail Merge to bring up the Letter Writer’s open file dialog.  After you select a letter and click on Open, Sales Ally will merge print a letter for every contact in the mailing list.

If No Mail XE “No Mail:Group Letter” 

 XE “Group Letter:No Mail”  is checked in a contact record, the contact is ignored during the merge print operation.  This feature allows you to avoid creating duplicate letters or labels for individuals with more than one contact record.  You can turn off this feature by selecting Ignore No Mail in User Preferences.

CHAPTER 9    Tools Menu
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Figure 138 - Tools Menu
The Tools menu provides access to several utility functions including the Phone Dialer, Stopwatch, Calculator, a simple date Calendar, Scratch Pad and the Sales Script viewer.  Sales Ally for Windows uses the standard Windows Calculator.  Please note that the Calendar tool is unrelated to the Activities Calendar.  

9.1  Phone Dialer XE "Phone Dialer"   

When you select the Phone Dialer from the Tools Menu, the Dialer dialog appears.  If you have highlighted a suitable phone number in the current window, the dialer will automatically dial that number for you (assuming you have a modem installed and properly configured).  For example, if you highlight a phone number in a contact record and select the Phone Dialer from the Tools menu (or press its hot key - F9), the number will appear in the Phone Number field of the Dialer, and you merely have to click on Dial to initiate the call.  For your convenience, we have also placed buttons next to the Work, Home, and Alternate phone numbers on the contact screen so you can quickly pull up the Dialer, fetch the number, and begin dialing.  If you have not highlighted a phone number prior to calling the dialer, Sales Ally will prompt you to enter a number in the Dialer dialog.  
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Figure 139 - Phone Dialer

After a phone number has been entered into the Dialer dialog:

1. Click on the Dial button to dial the phone number.  When using one of the contact window dialing procedures, the number is dialed automatically.

2. After the call is dialed, you must pick up the telephone XE "Telephone"  handset and click on the Talk button in the second dialog before beginning a conversation.  The second dialog disappears.

3. If you make contact with the party, click on Contacted.  This will update the number of contacts in the phone tallies on the status bar.  When using one of the contact window dialing procedures, it will also update the Last Contact date in the contact record.  

4. At the conclusion of your phone call, click on Hang Up.  This will hang up the phone and erase the dialog. 

The Dialer keeps track of the number of calls you make as well as the number of successful contacts (if you use the Contacted button).  The total number of Calls and Contacts for today are displayed on the status bar and recorded in the database.  Use the Phone Tallies report to display the history of calls and contacts.

You can enter a phone number into the Dialer by any of the following methods:

1. Click on the Work, Home, or Alt Phone button next to the corresponding phone number while in the Address page of the contact window.  

2. Click on Dial in the Contact menu and click on Work to dial the work phone number, Home to dial to the home phone number, or Alternate to dial the alternate phone number.  You can use this method while viewing any page of the contact window.  

3. Type Ctrl-W to dial the work phone number, Ctrl-H to dial to the home phone number, or Ctrl-A to dial the alternate phone number.  You can use this method while viewing any page of the contact window.

4. Highlight a phone number and click on Dial in the Tools menu (or type F9).  Use this method to dial a phone number in any field of any page of the contact window.  

5. Click on Dial in the Tools menu (or type F9) and type a phone number into the Phone Number field.

Dialing Options

The Dialer dialog has an Options button where you set up dialing procedures for various types of calls.  Whenever you fetch a phone number from a contact window, additional information can be added to the phone number to dial it properly.

The Dialer Options dialog allows you to enter your local area code so that all calls to your area code will be dialed as local numbers.  It allows you to enter dialing prefixes and suffixes that will be combined with phone numbers fetched from the contact window.  A prefix is what you need to dial in order to connect to an outside line whereas a suffix is an optional accounting code your firm may require you to dial following a phone number.  Sales Ally allows you to enter a prefix and a suffix for each type of call: local, long distance, international, and special long distance.
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Figure 140 - Dialer Options

A dial prefix string can be a combination of modem commands and dialing codes that precede a phone number. Illustrates typical prefix strings.


Local Calls Prefix:

“9,”


Long Distance Calls Prefix:
“9,1”

The Local Calls Prefix will dial “9” and pause two seconds to allow for connecting to an outside line.  The Long Distance Calls Prefix will dial “9”, pause two seconds, and dial “1”.

· Local Calls - Enter your local area code in Local Area Code.  If you fetch a number containing this area code, the area code is removed to make it a local call.  Enter in Prefix whatever you need to dial in order to connect to an outside line, e.g., “9,”.  Enter in Suffix whatever accounting code information you might need to dial following a local phone number.

· Long Distance Calls - Enter in Prefix whatever you need to dial in order to connect to an outside line and initiate a long distance call, e.g., “9,1”.  Enter in Suffix whatever accounting code information you might need to dial following a long distance phone number.

· International Calls - Enter in Access Code the code you need to dial to initiate an international telephone call, e.g., “011”.  Enter in Prefix whatever you need to dial in order to connect to an outside line for international calls, e.g., “9,”.  Enter in Suffix whatever accounting code information you might need to dial following an international phone number.

· Special Area Codes - Enter in Area Code the area code that requires a special prefix or suffix, different from the general Long Distance Calls settings.  Enter in Prefix whatever you need to dial in order to connect to an outside line for this particular area code.  Enter in Suffix whatever accounting code information you might need to dial following the phone number.  You may use up to 5 special area codes.  Note that when a special area code is found in the phone number you have fetched, the area code is removed.  If you wish to retain the area code in the dialing sequence, add it to the Prefix.

· No Modem - Unless you have a modem, BA cannot dial a phone number for you.  If you do not have a modem, you can track calls, successful contacts, and update Last Contact in a record.  Select No Modem and proceed as if you were dialing the phone automatically.  Although the Dial button will be inactive, the Contacted button will register the information.

· Contact History - Whenever the Last Contact field is updated in a record, you can also have BA add an entry to the history file documenting your phone call.  Select Contact History to enable this feature.  The entry is added to the history file only when you click on Contacted and Hang Up.

9.2  Stopwatch XE "Stopwatch"   XE "Billing Time" 

 XE "Time Billing" 
The Stopwatch tracks your time spent on phone calls or any other activity performed at your desk. When you first activate the Stopwatch from the Tools Menu, it resets itself to zero and starts to count.  You can reset the Stopwatch yourself by clicking on the Reset button.  You can also instruct the Stopwatch to convert time into dollars and cents via the Configure Button. You can set either an hourly or minute by minute rate as well as a minimum charge.  You can even set the increment by which the charges are calculated.  For example, rather than charge by the minute, you can charge only for full 15 minute blocks of time by setting the minute rate to your desired amount and the increment to 15.  Clicking on the Stop button pauses the watch and changes the button label to ‘Start’, which you may use to restart the clock.  To close the Stopwatch, click on the Close button.  By default, the Stopwatch is placed in the middle of the screen, although you can move it to another position or minimize it without affecting the time.  However, closing the Stopwatch will reset it to zero when you reopen it.  You can use the accelerator key Ctrl-T instead of the menu to activate the Stopwatch.

9.3  Calculator XE "Calculator" 
When you select the Calculator option (or use the accelerator key Ctrl-L), Sales Ally displays the full function calculator that comes standard with Windows.  You can select either the Standard Calculator or the Scientific Calculator XE "Scientific Calculator"  from the Calculator’s View menu.  You can even substitute another calculator program via the Edit, User Preferences menu.  If you have a special calculator that you use for a bond calculator, or another calculator program, you can setup Sales Ally to use that calculator program.  We will discuss the Standard Windows Calculator.  For more information about the Scientific Calculator, see your Windows manual or help messages within the calculator.  

The basic logic of the calculator is:  Enter the first number, enter an operator (+,-,*,/), enter a second number and select the equals sign (=).  The result will be shown in the display window.  For example, to multiply 152 by 3, you would enter the first value 152 either by clicking on the number buttons on the calculator or by typing the numbers on the keyboard.  Next, enter the multiplication operator (*) again by clicking or typing followed by the second number (3).  Finally, enter the equals sign by clicking or typing.  Note the Enter key is equivalent to the equal sign.  The result 456 will appear in the display window.  If you make a mistake entering a value, you can click on the Back button or press the BackSpace key on your keyboard to remove a single character.  To clear the entire entry, click on the CE (Clear Entry) button or press the Esc key.  You can string multiple operations together by simply entering the desired operator followed by the number.

Note: Be careful when mixing operators that you enter them in the proper order to achieve your desired results.  1+2*3 evaluates to 7 and is not equal to 3*3.  

[image: image181.png]=] Calculator M
Edit_View Help

0.

(e )(Tce )(Back)
(o) ew)
(0
() (D)0
()OI







         

Figure 141 - Standard Windows Calculator

You can use the Clipboard to move data to and from the Calculator via the Copy and Paste options from the Edit Menu (Ctrl-C and Ctrl-V).  If you need to store an intermediate value, use the memory functions:


MC
Clear the memory


MR
Retrieves the value in memory and enters it into the display


MS
Saves the value in the display to the memory


M+
Adds the value in the display to the value in the memory and stores the results in the memory

When a value is stored in the calculator memory, the letter M appears in the upper right under the display.
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Figure 142 - Scientific Calculator

9.4  Calendar XE "Calendar:Date" 
From the Tools menu, select Calendar to call up a simple monthly date calendarFigure .  You can use the accelerator key Ctrl-E instead of the menu to activate the Calendar.  The Calendar displays current month’s calendar with today’s date highlighted.  You can change the display to other months using various buttons provided.  Click on the Close button to remove the Calendar from view.
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Figure 143 - Calendar

9.5  Scratch Pad XE "Scratch Pad" 
The Scratch Pad is a special document window that allows you to enter and save text.  Each user on a network has their own Scratch Pad. This Scratch Pad is automatically presented for the user who is currently signed into Sales Ally.   Each time you open the scratch pad, you will see the same text that was last saved.  This allows you use the scratch pad to keep miscellaneous information close at hand.  While the Notepad is linked to each individual contact and displays only notes associated with that record, the Scratch Pad is universal and can be viewed from any screen.  You can use the Copy and Paste options from the Edit menu (Ctrl-C and Ctrl-V) to copy text to and from the Scratch Pad.  This means that you can use the Scratch Pad as a repository of standard data entries that you can easily paste into any of the data screens.  For example, you might want to enter a list of all your account rep. dealers in the Scratch Pad so that you can easily look them up or copy one of them into an individual contact’s record or note.
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Figure 144 - Scratch Pad

9.6  Sales Scripts XE "Sales Scripts"   

Sales Scripts are text files that you can customize to provide standard scripts for sales calls or any other scripted conversation.  You can build as many such scripts as desired and display one or more at any time.  This feature allows you to create whole libraries of scripts for specific campaigns or telemarketing efforts.  The script files are normally stored in the Letters Directory with the extension BAS (Sales Ally Scripts).  You can even develop and distribute standard scripts to multiple locations for coordinated marketing efforts.

To create a sales script, choose Sales Scripts from the Tools Menu, select New to create a new sales script
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Figure 145 - Script Editor

Here is a sample of a Sales Script.

WE'RE NOT INTERESTED
1. Why aren't you interested?

2. I am interested in knowing why you are NOT interested!

3. At first you may feel you are not interested.  But, if you give me 30 seconds to explain something, I just may be able to help you with one of your problems.  May I proceed?

4. You can't be interested until I do my job, which is to demonstrate how this investment opportunity can help you.  Specifically, this investment may help you by ___. Will you give me a moment to further clarify this?

5. You aren't interested?  We rarely hear that!

6. You are not interested?  I must have gotten your name from the wrong list.  Are you in the business of _______________?  Then, according to our research, you are a PERFECT candidate for our offering!

7. At first, others felt the same way.  Then, after a bit of discussion they felt differently.  Would you like to learn what you could gain from this investment?

8. You have made an incorrect assumption about this investment.  It is based on a set of ideas that you have gathered from previous experiences.  It is my job to show you how your current assumptions are in error in this case.  May I proceed?

9. Sometimes people tell me that because they are too busy to deal with this sort of thing right now.  Is this a bad time to call?  May I schedule an appointment tomorrow (AM or PM)?

10. Have I said something that upset or offended you? I didn't mean to!  Let's start this again. Hello, my name is ________________________.  I am here to talk to you about __________________________.  Do you have a moment to speak with me?

9.7  Palm Pilot Interface

Sales Ally has the ability to load Sales Ally information into the popular Palm Pilot product to enable users to review contact information on their portable Palm device. Connect your palm to the PC using directions for the Palm Pilot. This function will provide you with instructions and procedures to follow for moving data into your Palm Pilot. See Appendix L, for detailed installation instructions.
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Figure 146 - Palm Data synchronization with Sales Ally


Palm, Inc. manufacturers of the Pilot(
CHapter 10      WEB AND Window MenuS

10.1  Web Menu XE "Window:Cascade" 

 XE "Cascade:Window" 
The Web item on the Main menu provides you with Quick Web Connect- to launch your browser from within Sales Ally and access either of two sties: 1) our help site for the Sales Ally software and 2) the popular www.SalesAlly.com portal for productivity advice, tools and its web window to Wall Street and finance. The www.SalesAlly.com portal provides valuable information and you should check here often for resources you may need in your business practice.
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Figure 147 - Internet Access from Main Menu Extensions Quick connect to SalesAlly.com

SalesAlly.com Web Portal

The SalesAlly.com web portal provides you with valuable information, only a fraction of which is related to the Sales Ally software. This rich information site is a portal into various vendors and is a collection of information organized by categories such as Commentary, Practice Improvement, Account reps., Marketing Organizations, and others. You can also read information about the Sales Ally product line and obtain ordering information.

Sales Ally e-Support from the Internet

This is the site for help desk services and to read content online or use e-mail to reach a team of qualified help desk technicians. This area is called Sales Ally Software e-Support. Be sure to include your name and serial number when you request e-mail support services.

10.2  Window Menu XE "Window:Cascade" 

 XE "Cascade:Window" 
The Window menu offers a variety of controls for manipulating the window display on the screen.  Sales Ally allows you to open and leave open as many windows as your system’s hardware can support.  Sometimes these multi-window displays can become confusing with one window hiding another.  You can use the Window menu options to redraw the windows in a cascade or tile view.  You can move a selected window to the foreground by selecting it by name from the Open Windows list.

The Cascade option on the Window menu will arrange all open multiple display windows such as a Contact view, Letter Writer document, List view, Scratchpad, Sales Script, and Activities Calendar from top to bottom, left to right. The order of precedence is determined by the order you last accessed the windows, with the most recently accessed displayed on top.  Each window is displayed in standard size, overlapping the other windows as much as necessary.  The Cascade option is most useful for displaying a single window amongst a group of active windows at the same time, while allowing you to switch from one window to another window simply by clicking on a protruding edge of the underlying window. 
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Figure 148 - Window Menu XE "Window:Menu" 

 XE "Menu:Window" 
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Figure 149 - Cascaded View

10.3  Arrange Icons XE "Arrange Icons" 

 XE "Window:Arrange Icons" 
The Arrange Icons option on the Window menu, will arrange the Icons for all minimized windows in a row along the bottom of the main Sales Ally window. The Arrange Icon option is particularly useful for retrieving lost icons that have become overlaid by other windows. 
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Figure 150 - Arranged Icons

10.4  Close All XE "Window:Close All" 

 XE "Close All:Window" 
The Close All option on the Window menu, will close all open Sales Ally windows except the main window.  It is particularly useful for ‘clearing the desk’ before beginning a new process.

10.5  Open Window List XE "Window:Open Windows List" 

 XE "Open Windows List"  

The Open Window List is a section of the Window menu that grows every time a new Sales Ally window is opened.  Each open window is listed on the menu in the order that it was opened, until the window is closed. You can simultaneously move an open window to the front of a cascade display and activate it by clicking on its name in the Open Windows List.  This option is particularly useful for finding and displaying windows that have been lost behind other open windows.  
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Figure 151 - Open Windows List

CHapter 11     Help Menu
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Figure 152 - Help Menu XE "Help Menu" 

 XE "Menu:Help" 
The Sales Ally Help menu provides on-line assistance for all available features and functions.  You can access the Help system either by selecting one of the Help menu options or by pressing F1.  The Help Index and Search options, as their names imply, allow you to find your topic of interest by looking it up in an index of topics or by searching for it by a key word.  The Using Help option provides detailed instructions for using the help system.  The Financial Terms option provides a glossary of common financial terms.  About Sales Ally displays a screen detailing the copyright, version number, and serial number of your installed copy of Sales Ally. If you want specific help on the current window, press F1.  If you want to search for a topic use Index or Search on the Help menu.

11.1  Index XE "Help:Index" 

 XE "Index:Help" 
The Index option from the Help menu opens the help system in Index mode.  You can scan through the table of contents of help topics.  By clicking on a particular topic, you will move directly to that topic’s detailed description.  The Help system contains its own menus and toolbar.   XE "Help:Back" 

 XE "Help:History" 

 XE "Help:Contents" You can switch to search mode by clicking on the Search button.  You can move back to a previously viewed help screen by clicking on Back.  You can select from among previously displayed help screen by clicking on History.  The Contents button displays a Table of Contents for the Help system allowing you to search for a topic by branching from a general topic to a more precise topic.
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Figure 153 - Sales Ally Help menu

The Help system’s menu offers several additional options for displaying, editing, marking and printing help screens. XE "Help:Print"  
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Figure 154 - Help File Menu

Help File

The Help File menu allows you to switch to other help files via the open option or to print the current topic.

Help Edit XE "Help:Edit" 

 XE "Help:Annotate" 
The Help Edit menu allows you to copy selected text from the current help screen to the Clipboard.  You can then Paste the text into another document.  The Annotation option allows you to insert an annotation into the current help screen for future reference.
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Figure 155 - Help Edit Menu

The Bookmark  XE "Help:Bookmark" option on the Help menu allows you to define and insert bookmarks with titles of your own choosing.  The named bookmarks are listed in an expanding list at the bottom of the menu.  You can move immediately to a named bookmark by clicking on it or by pressing the associated number.  If you define more than 9 bookmarks, they will be listed in a subsidiary scrolling dialog.
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Figure 156 - Help Bookmark Menu

The final Help XE "Help:Help"  menu selection is its own Help menu.  The first Option describes how to use the Help system, while the second option allows you to maintain the Help window on top of Sales Ally.  You can then see both the Help window and the Sales Ally windows at the same time while you are working on Sales Ally.
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Figure 157 - The Help - Help Menu

11.2  Search

The Search XE "Help:Search"  option from the Help menu displays the Help window in Search mode.  You can enter any word or phrase, and Help will find the appropriate topics in the help file.  If the Help system cannot find an exact match, it will still present the closest match, allowing you to scroll to the topic that matches your entry most closely.
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Figure 158 - Help Search

11.3  Using Help

The Using Help  XE "Help:Using Help" menu option display detailed instruction for using the Help system.
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Figure 159 - Using Help

11.4  Sales and Marketing Terms Glossary

The Glossary XE "Financial Terms Glossary"  of Terms is a help file full of industry-specific topics. The file has an alphabetical layout to help you quickly find the topic of choice.  Using the Help system’s Edit Copy option, you can copy selected text from the Glossary to the Clipboard.  From there, you can paste the text into any other Windows application.  Specifically, you can paste the text into a Sales Ally letter, note or custom report.
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Figure 160 – Sales and Marketing Terms Glossary

Tip of the Day XE "Tip of the Day" 
Every time you run Sales Ally, you will be presented with a “Tip of the Day”.  These tips will give you specific information related to the software.  The tips are designed to help you learn shortcuts to your software.  You can view all the tips at once by clicking the Next Tip button or you can read the tips as the are presented to you.  Once you have read all of the tips, you can turn them off by unchecking the Show tips at startup box.  You can always turn the Tip of the Day back on from the Help Menu.
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Figure 161 - Tip of the Day

What’s New XE "What’s New" 
The What’s New menu will present you with installation instructions, an outline of the feature improvements, and information on obtaining technical support from Scherrer Resources. 
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Figure 162 - The “What's New” Read me File under Help Menu

About Sales Ally

The About Sales Ally XE "About Sales Ally"  dialog is the standard windows ‘about’ dialog that shows copyright information, the Sales Ally version number, your serial number, and the amount of free memory.
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Figure 163 - About Sales Ally dialog 

PART 3    APPENDIX 
Appendix a -    mail merge with  XE "Mail Merge:Microsoft Word" mS-word XE "Microsoft Word" 
The Sales Ally Mail Merge Wizard for Microsoft is found as a menu item in Microsoft Word.  The Wizard will assist you in performing mail merge tasks in Word using your Sales Ally contact information.  The Sales Ally Mail Merge Wizard is automatically installed into Microsoft Word when you install Sales Ally.  Microsoft Word needs to be installed on your computer prior to Sales Ally.  If the Sales Ally menu does not appear in Word, reinstall Sales Ally from the original distribution diskettes.
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Figure 164 - Microsoft Word menu

You may merge all contacts in a Sales Ally data source or merge the contacts in an existing list with a document you create in Word.  You can print letters, labels, or envelopes from Word with your merged information from Sales Ally.
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Figure 165 - Sales Ally Mail Merge Wizard
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Figure 166 - Mail Merge Wizard Password Information
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Figure 167 - Choose a Sales Ally data source or a List for Mail Merge

Run the Sales Ally Mail Merge Wizard found in the MS Word menu:

1. On the first screen of the Mail Merge Wizard, select Letter, Labels, or Envelope.  

2. On the second screen, select a Sales Ally Data Source and either The Whole Database or A List From Sales Ally
3. Choose your Login ID and enter your password for the Sales Ally system

4. If you chose a list, select a type of list and a particular list on the third screen.

5. Click on Finish to create an empty mail merge document.

To insert a Sales Ally merge field into your document, click on Insert Merge Field.

1. To insert a Word merge field into your document, click on Insert Word Field.  Other Word merge fields are found on the menu under Insert Field.

2. For a letter, type in the text of your letter.

3. Save the document.  The merge fields, text, and data source information are saved in the document.

4. To print the merged documents, click on [image: image209.png]


, the Merge to Printer tool bar button.

Letter Tutorial

Use the following example as a guide.  Before starting, we recommend that you select a Word option to help you distinguish merge fields from text when viewing your document.  Select Tools from the menu and click on Options View.  Select Always for Field Shading.  This will cause merge fields to be highlighted in your document.  

1. Select Sales Ally from the menu and click on Mail Merge Wizard.

2. On the first screen, select Letter and click on Next.

3. On the second screen, select a Sales Ally Data Source and either The Whole Database or A List From Sales Ally.  The Whole Database merges every contact in the Sales Ally data source with the document you will create.  They will be sorted in alphabetical order by last name.  A List From Sales Ally merges every contact in an existing Sales Ally list with the document you will create.  They will be printed in list order.

4. If you chose a list, select a type of list and a particular list on the third screen.

5. Click on Finish to create an empty mail merge letter document.  You will see the document in Page Layout view mode.  You may wish to select Normal mode from the View menu.

6. Insert a merge field for the current date near the top of the page.  Select Insert from the menu, click on Field, click on Date and Time, and click on Date.  In the Field Codes edit box, enter \@ "MMMM dd, yyyy" after DATE.
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Figure 168 - Sample letter showing merge codes

1. Click on Insert Merge Field on the tool bar and select SALTATION (the first salutation field) from the list.  Repeat for the other Sales Ally merge fields as shownFigure . 

2. Further down the letter you will add a greeting.  Type in "Dear " and follow with SALTATION and LASTNAME merge fields using Insert Merge Field.

3. Type in the body of your letter.  You can also use Copy and Paste (Edit menu) to copy parts of an existing Word document to your new document.

4. Save the document.  The merge fields, text, and data source information are saved in the document.

5. View the merged data by clicking on [image: image211.png]


, the View Merge Data tool bar button.  Click on [image: image212.png]


, the Next Record button, to show other examples of the resulting document. 

Note: The Previous Record button is very slow to respond because Word uses an early version of ODBC to fetch the data.
1. Print the merged documents by clicking on [image: image213.png]


, the Merge to Printer tool bar button.

Hints
1. Each time you create and save a mail merge document, the data source information is bound to the document.  To change the data source, you must create a new document using the Sales Ally Mail Merge Wizard.  However, you can save a lot of work in setting up merge fields by copying the name/address section of an existing document to your new document.

2. If you have any problems with the Mail Merge Wizard, please see the Mail Merge Wizard Help found under the Sales Ally Menu in Word. Sales Ally Mail Merge Wizard Help has tutorials for labels and envelopes as well as advanced techniques for more sophisticated use of merge codes.

Note: If you have difficulty with Word's mail merge, consult Word's help system, the Microsoft Word for Windows User's Guide, or call Microsoft. We built the Sales Ally Mail Merge Wizard using “Word Basic” from Microsoft, thus we utilize existing functionality of Word's mail merge system.  

Due to some limitations of Word's mail merge system, you should be aware of the following:

· After creating a document with Sales Ally Mail Merge Wizard do not select Mail Merge Helper or Edit Data Source from the tool bar.

· Ignore messages such as "Word could not parse your query options into a valid SQL string" and "The SQL string is too complex for Word to parse".  These are invalid messages.

· Some unnecessary additional documents may be created when the Sales Ally Mail Merge Wizard constructs your mail merge document.  Ignore them. 

· You must select the label form you wish to use before you run the Sales Ally Mail Merge Wizard to create a labels document.  See Labels Tutorial in the Help file.

· The Sales Ally technical support staff is not trained to answer questions about Microsoft Word.  We can only answer questions relating directly to the Sales Ally Mail Merge Wizard, not general issues concerning Word's mail merge.

Appendix B -    Supported Databases

Sales Ally and Web Ally Architecture

Sales Ally was engineered to operate within both a simple and/or a robust environment scaling from single PC to enterprise installations. One of the methods to accomplish this is that Sales Ally supports any dBase and Web Ally supports MS-SQL server. The normal “shrink wrapped” Sales Ally version 5 application creates dBase tables automatically upon installation and setup. Sales Ally version 6 uses MS-Access database structures. This installation is optimized for single PC and local area network (LAN) installations. However, should your firm and its operation require the use of more sophisticated and robust alternative databases, this can be accommodated. There is an additional fee for the drivers and the versions that run databases other than the dBase “shrink wrapped” installation for Sales Ally.

See www.WebAlly.com for SaaS CRM software for sales teams. Web Ally uses the MS-SQL server database.

Scherrer Resources, Inc. is able to incorporate the hosted or On-Demand Web Ally CRM in instances where you may need more robust, browser accessible databases for enterprise installations on wide area networks (WAN’s) or for Browser based access to Web Ally on an internet server.

Database Installation Support

1. Scherrer Resources, Inc. provides on-site installation support for database installation and configuration. Contact your account representative for a specific price and engineering quote for details on the specific versions of Sales Ally.
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Appendix C -    System Specifications

To run Sales Ally version 6 for Windows, you need as minimum requirements:

· Microsoft Windows 32-bit operating system (Windows 95) or higher to Vista
· Personal computer using Pentium II or higher microprocessor 

· Minimum 16MB of memory (64MB or more recommended)

· Hard disk with at least 100 MB free for the Sales Ally program and Data files. The Program requires 25 MB of free hard drive space to install.

· CD ROM Drive

· Mouse or compatible pointing device

Appendix D -    Commonly asked Questions 

Q:  When I delete a call, contact or groups list in Sales Ally, the information does not delete.  What’s wrong?  How do I correct this problem?

Your SAWIN6.INI file did not set up correctly because at time of installation there may have been another program running or file obstructing the installation.  To correct this problem click on the File menu and choose ODBC Settings. Click on Sales Ally Data.  Next, click on the Setup button.  When in the ODBC dBase setup window, click on the OK button.  Close the Data Source window, and exit Sales Ally. Exit Windows, and reboot your computer system.  When you enter back into Windows, the ODBC drivers will be reinitialized.  Restart Sales Ally.

Q: When I start up Sales Ally, I get a message on the screen “File locking not available”?  What does this mean?

Sales Ally needs a DOS program called Share to be running before you can work in the program.  Share should be loaded automatically in your autoexec.bat file.  Exit out of windows, and type SHARE.EXE at the C prompt.  This will load the DOS share program.  For more information on SHARE.EXE, consult your DOS manual.

Q: Do I need to back up my data?

YES!  Your business depends on it.  The Rebuild (Maintenance) function can fix the majority of problems that can occur, but it is possible that a database may become damaged beyond repair.  When maintenance is not possible, your only recourse is to restore data files from backup diskettes.  Always maintain several sets of backup diskettes which are used in rotation; backup diskettes are not immune to failure.  There are numerous backup software products available which are faster and more reliable than the BACKUP and RESTORE programs that accompany DOS.  Refer to the Backup in chapter 1

Q:  How do I set the date and time within Sales Ally?
Sales Ally gets the date and time from your computer.  There are two places where you can set your time and date.  First, you can type DATE to set the date and TIME to set the time at the C prompt.  The other is to double click on your Control Panel Icon, located in your main window group, then double click on the Icon titled Date/Time.  If your date and time become incorrect every time you turn off your computer, your CMOS battery may need to be replaced.  Consult a computer technician.

Q: I sometimes get a message “out of system resources, try closing some windows”.  What does this mean?

Every application you run on your computer takes up a certain amount of memory.  Sales Ally has a protection device built into it to minimize problems on your computer due to low system resources.  This protection will not allow you to open more contact records, letters etc., if your system resources, or memory is too low.  To resolve this error, close some of your contact windows or other applications that are running on your computer.
Q: How do I arrange for training for Sales Ally?

Training is conducted either on the phone or at your location by appointment in either case.  Contact your Sales Ally Sales Representative at 484-875-1710 for information and pricing.

Q: What is the Platinum Service and Support Plus program that I am hearing so much about?

The Sales Ally Platinum Service and Support Plus Packs are designed for your long-term support needs.  The popularity of Sales Ally requires full time staff to be made available to your needs. To relieve this backlog we have developed two special support programs for you. Platinum Service Pack is our highest-level support. Both this and the Support Plus Pack provides you with instant access to a Sales Ally support technician and a newsletter with tips and tricks for using Sales Ally to its fullest potential. First, the Support Plus Pack provides you with a toll free 800 number support hotline. This hotline will be your instant pipeline to a qualified support engineer every time you pick up the phone. Secondly, you will receive the “The Ally Newsletter” which is a detailed newsletter that is full of tips and techniques on how to make the most efficient use of Sales Ally. It will highlight the powerful (and often overlooked) features of the program.

The Support Plus Pack virtually eliminates costly down time due to problems with your Sales Ally Program or your computer system itself. Without the instant access to a qualified support engineer, you may lose a couple of hours of productive prospecting. Order the Support Plus Pack and you’ll get unlimited access to our quick response toll-free hotline. This means if you ever have any questions about Sales Ally, a friendly and knowledgeable support representative is never more than a free phone call away. Most users who sign up for this service find it absolutely invaluable! Sales Ally Support Plus Pack annual fees are dependent on the Sales Ally level in which you currently own.  See the Support Plus Pack sign up form for the annual subscription fees.

Appendix E -    Support plus pack sign up

Yes!   Sign me up!   I want the premier Support Plus Pack XE "Support Plus Pack"  annual subscription so I can get right through to a qualified support engineer every time I call!!

	Name
	

	Address
	

	City, State, Zip
	

	Phone #
	

	Fax #
	e-mail :

	Sales Ally Serial Number
	S

	Sales  Ally Level - Standard -  Network
	


· You can find out which level you have by looking on your Sales Ally distribution diskettes

Payment Method
( Check or Money Order
( Visa
( MasterCard
( Amex   ( Discover

	Card Number:
	

	Expiration Date:
	

	Signature:
	


Sales Ally Support Plus Pack annual fees are dependent on the Sales Ally level in which you currently own.  Support fees are non refundable after initial support service call.

Standard Level 

$150 

Added Network User

$+95

Support Plus Fees

To order, call 484-875-1705 or for fast service fax this order to: Client Services @ 484-875-1704.

Appendix F -    alliance partners & vendors

The contacts listed below can aid you in specific issues you may have with application software and hardware technology related to your use of Sales Ally or your PC workstation. These companies will help you, or your Information Systems Department, to obtain market data, securities information, or computer-based tools to use in your advisory business practice.

Name







Product                       .

MICROSOFT CORP.





Windows, Word,

One Microsoft Way

Redmond, WA 98052-6399

206-637-7098, 206-462-9673, 206-646-5102

SCHERRER RESOURCES, INC.



Broker’s Ally & Web Ally

CRM Workstation Software and Web Portal

140 Arrandale Blvd 





www.WebAlly.com
Exton, PA 19480 
484-875-1710 (phone) 484-875-1704 (fax)
Appendix G -    Telephone Training services

Productivity Improvement:
Personal computers can increase the productivity and organization of account representatives and their support staff. However, if users fail to adequately learn important software features, they can be left in a position of weakness... often resulting in a total rejection of the personal computer. 

Telephone Training For You:
In order to help avoid a rejection of your computerization plan, Scherrer Resources, Inc. has developed a Telephone Training Service whereby your advisors can receive software training at the comfort of their desk on their own telephone. By making an appointment with a knowledgeable training representative you and your support staff can learn the proper use of Sales Ally and how to run it on your hardware. 

Objectives:

The objective is to raise your productivity by increasing your level of knowledge and facility with Sales Ally software on your PC. Telephone Training will help you coordinate the process of selling and supporting accounts with your computer. By obtaining Telephone Training Services, you will be more proficient and comfortable with the technology. Consequently, you can achieve greater productivity and better customer support. 

Through a discussion with your Telephone Training Service representative, you can set up a one-hour, or more, appointment to be trained on the software. Then, you can spend that hour learning anything you wish, from database management, to word-processing, to application functionality. This special “custom” telephone training is very focused and efficient, resulting in quick learning and understanding. Whether you wish to learn about Windows functionality, or special software tools, or desktops, notebooks, or networks your Telephone Training Service- representative can help you. This service is designed to help you be more efficient, better organized, provide advanced account management, and result in greater business profitability. 

Telephone Training Topics
In discussion with your Sales Ally sales representative you can tailor a Telephone Training program to fit your needs. It could be one hour in duration, or more depending on your needs. Candidate topics include: 

1.
Software Installation

2.
Adding Records

3.
Writing Letters

4.
Entering Transactions

5.
Teaching Sales Assistants

6.
Network Features

7.
Importing and Exporting Data

8.
Advanced Training Topics

Obtaining Telephone Training
Simply contact your Sales Ally sales representative and discuss a plan that will fit your needs. You may want a single trainer for one hour, a half-day, a full 8-hour day, or you may want to train by conference call. This close, one-on-one training will be very valuable to you. Whatever your needs, simply call your Sales Ally sales representative at 484-875-1710 and ask for Telephone Training Services, or contact Sales@SalesAlly.com.

Appendix H -     DATA MIGRATION METHODS

This section describes the many ways to move data from other software programs into Sales Ally. Generally, the ASCII Loader utilities built into Sales Ally will enable you to map and import data from other lists and other software products. However, specialized, high performance utilities have also been built for some other software products.

ACT!

ACT! users can quickly move their data from ACT! into Sales Ally using the “ACT! to Ally” data conversion XE "Conversion"  tools utilized by our software developers. Simply ship your database to Scherrer Resources, Inc. and our development staff will convert the data for a one-time conversion and e-mail the packet back to you. The cost is based on number of records: $100 per 1000 of contacts. We transfer names, address, notes, phone/fax numbers, activity dates, user fields, letters and documents.

MS Outlook

Users of Outlook wishing the more powerful added functionality offered by Sales Ally can quickly migrate data using the ASCII import functions XE "ASCII import functions"  in Sales Ally. Simply export the Outlook database into ASCII format, then use the Sales Ally File, Database operations, ASCII Import function to load this data into Sales Ally. You can map fields to fill the database as you desire.

Appendix I -     creating maps 

Custom Maps for Your Business

Scherrer Resources, Inc. offers a special service to corporate users of Sales Ally who wish to have full-color geographic maps created for customer, prospect and sales demographic information. Account representatives create hundreds of transactions and events on a daily basis. This information forms the basis for rigorous mapping and analysis of opportunities. From this extensive firm-wide and nationwide database can come informed decisions regarding sales and marketing opportunities and trends.

Firm wide management maps of retail business activity on a city, county, state or national level.

Sales Map Examples

Client density

Transactions per account rep., per branch

New customer mapping

New accounts per month

Unserviced territories or regions

Sales Representative Ranking

Market Map Examples

New Product sales opportunities

Aggregate corporate client asset analysis

Company day and month totals

Territory Saturation

Corporate Mapping

Customer Turnover ratio

Reassignment of clients, lost clients

Legal and Human Resources reports

Telemarketing call constraints

Comparison or revenue per region

Database Sources

Back office servers

Middle Office servers

Desktop PC’s

Data marts

Software and Service Fees For Mapping

Scherrer Resources, Inc. personnel will come to your corporate headquarters and install the mapping software and configure it for your needs. There is a one-time cost of $15,000 for the mapping software and installation services and this includes a license for 2 users and 3 preformatted maps using your database. Additional maps are $1000 each, and each additional day on your site is $1200.

Appendix J -     benefits of Sales Ally 


Benefits of Using Sales Ally
Here are some benefits users have derived from implementing the Sales Ally sales management, sales control and CRM system for sales account reps., assistants and sales managers.

1. Longevity of Relationship

Capturing detailed client and prospect information will help secure a positive client relationship for a longer period of time.

2. Enhance other offerings and cross selling

Use of Sales Ally helps to increase penetration of all products being offered.

3. Legal Compliance Satisfaction

Supports consistent, targeted and measurable behavior of account representatives and their assistants with note taking and audit trail reporting protects from unwanted litigation.

4. Increase Productivity and Sales Revenue

Helps to support more productivity and efficiency in all daily operations.

5. Better Trained and controlled Teams
Helps to ensure all sales reps and assistants work in a well-defined path following their strategic plan.

6. Open More Accounts
Helps to increase sales pipeline conversions from status of lead, to a qualified prospect, then on through to the client status.

7. Do More Sales Transactions
Enables reps. to profile customers and target-marketing appropriate products to appropriate clients.

9. Increase Sales and Fees

Helps to increase sales revenue and fee billing opportunities.

10. Increase the Value of the Business Practice


Helps to increase the market value of the business itself buy increasing all the valuation measures of the business practice.


Appendix K -     Palm pilot connectivity 



Palm Pilot Data Synchronization Utility
Sales Ally contains a utility to support the data synchronization features built into the Palm Pilot to move data back and forth from Sales Ally and the Palm Pilot device. It is compatible with Palm Pilot III, V, and VII. To utilize this function, users must have the Hot Sync Manager (version 1.1, 2.0, 2.1, or 3.0 and above) that comes with the Palm Pilot Desktop software installed. Sales Ally utilizes the most current synchronization tools for the Palm Pilot. The way the Palm Pilot hot sync works is described in the User Manual that comes with the Palm Pilot.

To use the Palm synchronization utility, first install the Hot Sync Manager.  Then in Sales Ally, select Tools / Palm Pilot Sync Options and click on the button labeled "Install Palm Pilot Address Conduit" in Sales Ally. Select the data source you wish to synchronize.  Place the Palm Pilot in the hot sync cradle and press the sync button.  The Sales Ally sync utility will synchronize the data between the Palm Pilot address book and the Sales Ally contact records.

The normal Sales Ally installation copies the Palm .dll from the Sales Ally CD onto the hard drive in the directory specified.  However, the Palm .dll then has to be installed or "registered" with the Hot Sync manager in order to be used, and that's what the Install Palm Pilot Address Conduit button does.

Trouble shooting

After the synchronization process occurs, a log of this action is made and a file is created. This log file is presented to the user on the Palm Pilot, and in the log it will list "BA Address Book" or SA Address Book. If it does not show this file, then there was a problem with the original installation. Alternatively, if it does show this file in the log, then it will say whether the sync was okay or not. If it says it's okay, and no data is viewable, then the sync occurred but no data was transferred. In that case the user needs to check in the Hot Sync Manager to see what the Hot Sync Action was for the BA Address Book. If the log says it wasn't okay, then call our Help Desk for trouble-shooting support.
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For more information on Palm Pilot, search for www.Palm.com on the Internet.


Appendix L -     network installation


Installing Sales Ally V6 on Network Server and Single PCs

This document describes installation procedures XE "Installation procedures for Networks"  for version 6. The Sales Ally installation is automated, with screen prompts. We suggest you follow the questions one by one and accept the normal suggested installation configurations. So that your installation proceeds quickly, please have your user license information available at time of installation including your license number, name and address so that you may enter it at the screen prompts.
First Time Installation

For First PC

1. Install the Ally application.  Take note of the installation directory.  You will need that info for step 4.

2. Launch the application and create the main data source.

3. Exit the application.

4. Copy the allywin.mdb file from the installation directory to your desired network server location.  Take note of the network server location chosen.  You will need that info for step 7.

5. Launch the application.

6. Go to the main menu item entitled Edit, then to User Preferences, and then click on the Network button. This automatically opens the sawin6.ini file to allow you to edit this file and make the changes you desire.

7. Find the [DATA] section within this .ini file.

8. Modify the Name1 entry by changing the entry to contain the full drive and path to the database file at the designated server location; example = x:\SA6\allywin.mdb, where x is the name of the server drive (usually F:).  The updated section should look like this below if your created data source is named “Main Database” and the table name you gave it was “main”:

[DATA]
DataSource=1
dsN1=Main Database
dsF1=main
dsT1=0
Databases=1
Name1=F:\SA6\allywin.mdb

9. Select File | Save and close the .ini file window.

10. Exit the application.  You are now finished installing the application on the first PC.
All Other PCs

1. Install the Ally application.

2. Launch the application.

3. Go to the main menu item entitled Edit, then to User Preferences, and then click on the Network button to open the sawin6.ini file.

4. Find the [DATA] section within this .ini file.

5. Modify the Name1, dsN1, dsF1, and dsT1 entries to look exactly like the first PC’s .ini file entries.

6. Select File | Save and close the .ini file window.

7. Exit the application.  You are now finished installing the application on this PC.

Upgrade Existing Network Installation

Preparation Steps

1. Determine if your users have created multiple data sources.

2. If there is only one data source for all users, you can proceed to the Server PC steps.

3. If there are multiple data sources, merge all the data sources into the main data source.  Do this by importing all contacts from each secondary data source into the main data source.

Server PC

1. Install the Ally application.

2. Answer “Yes” when you are asked, “Do you wish to convert data from version 8 to 9?”

3. Launch the application.

4. Go to the main menu item entitled Edit, then to User Preferences, and then click on the Network button to open the sawin6.ini file.

5. Find the [DATA] section within this .ini file.

6. Make note of the Name1, dsN1, dsF1, and dsT1 entries.  You will use this info in the installation steps for All Other PCs.

All Other PCs

1. Install the Ally application.

2. Answer “No” when you are asked, “Do you wish to convert data from version 5 to 6?”

3. Launch the application.

4. Go to the main menu item entitled Edit, then to User Preferences, and then click on the Network button to open the sawin6.ini file.

5. Find the [DATA] section within this .ini file.

6. Modify the Name1, dsN1, dsF1, and dsT1 entries to look exactly like the server PC’s .ini file entries.

7. Select File | Save and close the .ini file window.

8. Exit the application.  You are now finished installing the application on this PC.


Network Installations XE "Network Installations" :
The Sales Ally network version will need to be installed on each workstation. You will need to set up a directory on the network server as a location for your Sales Ally data files. If you are on the server, create a directory by going into your file manager and creating a new directory. Once the directory is created on the server, you will need to install your new Sales Ally version 6 on the desktop workstation (called the client in a client/server installation).

Single PC Installations:
Please insert the CD in your CD drive and follow the directions that appear on the screen. During the Sales Ally installation you will be asked several questions pertaining to your specific computer setup: Personal information, the directory you wish to use (ideally C:\SA6), and other tips. The installation program is found as x:\setup, which you can "run" from the Windows Start menu if automated installation fails for some reason.

Support by Phone and e-Mail:
Should you have further questions, please contact the support group at: 800-950-0190 or 484-875-1705, support@SalesAlly.com or, Fax at 484-875-1704.



Appendix M -     PROGRAM FILE STRUCTURE 

This section describes the structure of files within the program, and is provided to assist you or your technical team with more advanced configuration and trouble-shooting tools. In addition, this table shows you the names of the data files XE "Data files"  that are the focus of your data backup and restore process. Presented are the file name, its extension and purpose. While not all files are listed, the most commonly used main program files are identified.

Category

Name


Purpose



.

Program File

Bawin.exe

Main Program executable file

Letters


Appntmnt.sal

Letter within the Sales Ally

     “


Birthday.sal

Happy Birthday letter (*.SAL)

     “


Anything.sal

All files ending with .bal are letters

Quick Letters

Thanks.saq

All files ending with .baq are quick letters

Scripts


Badtime.sas

All files ending with .bas are scripts

Setup Files

Bawin.ini

Initialization file for setting configurations

     “


Adata.ini

Data Initialization file for configurations

Definitions

Defs.dat

Definition files for User Fields, Interests, etc.

Data Files

AllyWin.mdb

The Main data file (must have .mdb)

Reports

Pxporval.rpt

Sales Value Report

Reports

Anything.rpt

All reports have .rpt exension

Error Messages
Imperr.txt

Text file listing error messages on data import

Readable Text

Readme.txt

File for you to read to tell you about new features
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Figure 168 - View of files within Sales Ally \SA6 shown from Windows Explorer

Appendix N -     Pricing 

Software and Services Pricing- 

Sales Ally Version 6

Pricing for Initial License: 


Standard Level- 
$395 includes all the basic features.

Networking- 

$300 per added user.

Upgrade Pricing to version 6 from Previous Versions

To Version 6


Standard 6


From V5 Standard to:

$175


From V5 Network:

$225/user

______________

From Previous version 1,2,3,4 to version 6; Add $200 per user to each of the above.

Telephone Support, fax back & e-mail support and Newsletter-

Platinum Support is our highest support level and includes all the features of the Support Plus pack plus software maintenance for Standard and Network software shipments twice yearly.

Option:



Platinum Support

   Support Plus Pack


Standard Level-

$305



   $150

Network Per Added User 
$295



   $95 



To Order…  Call 484-875-1710 or e-mail Sales@SalesAlly.com
For answers to any of your specific questions and to order, call your dedicated account representative at Sales Ally in their Philadelphia regional office at 484-875-1710, or e-mail to: Sales@SalesAlly.com. Credit cards, checks and COD accepted. Shipping extra.

Our Corporate Team is Ready to Support You!

Scherrer Resources, Inc. is a Pennsylvania corporation (www.ScherrerResources.com) and our team is led by CEO founder Jim Scherrer, and includes application software developers, web masters, help desk technicians, analysts, and account representatives assigned to each of our licensees. Help Desk Technician can be reached at 484-875-1705, or fax us at 484-875-1704, or contact Support@SalesAlly.com.
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� You can select contacts using contact and activity criteria or contact and posting book criteria but not activity and posting book criteria.


� You can select contacts using contact and activity criteria or contact and posting book criteria but not activity and posting book criteria.
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